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Day 1

Event

Introductions and Administration

Lecture: Overview of HEC-RAS and Basic Data
Requirements

Break

Workshop and Review: Developing a Hydraulic
Model

Workshop and Review: Adding Tributaries and
Junctions

Lunch

Lecture: Channel Geometry and Modeling
Techniques

Workshop and Review: Creating Plans

Break

Lecture: Optional Capabilities of HEC-RAS
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Time

8:00 AM - 8:15 AM

8:15 AM - 9:15 AM

9:15 AM - 9:30 AM

9:30 AM - 10:30 AM

10:30 AM - 11 :30 AM

11 :30 AM - 12:30 PM

12:30 PM - 1:30 PM

1:30 PM - 2:45PM

2:45PM - 3:00 PM

3:00 PM - 4:00 PM



Event

Day 2

Time

Lecture: Introduction to Unsteady Flow Modeling with
RAS 8:00 AM - 9:00 AM

Break 9:00 AM - 9: 15 AM

Lecture: Detailed Output and Results for Unsteady
Flow Modeling 9:15 AM - 10:15 AM

Workshop and Review: Introduction to Unsteady
Flow Modeling 10:15 AM - 11 :15 AM

Lunch 11:15AM - 12:15 PM

Lecture: Additional Geometric Data for RAS
Unsteady Flow Models 12:15 PM - 1:15 PM

Lecture: Boundary and Initial Conditions in the RAS
Unsteady Flow Data Editor 1:15 PM - 2:15 PM

Break 2:15 PM - 2:30 PM

Lecture: Model Stability, Accuracy, and Sensitivity 2:30 PM - 3: 15 PM

Workshop and Review: Trouble Shooting 3:15 PM - 4:00 PM
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Introduction
• Wha IS HE -RAS?

• An Integrated package of hydraulic analysis
programs

• Uses Graphical User Interface (GUI)

• What can HEC-RAS do?
• Steady flo\ water surface profiles
• Unsteady flow water surface profile
• Hydraulic design functions

~ Bridge scour
~ Uniform Flow
~ Stable channel deSign
~ Sediment Iransp:m capacity
~ Sediment Impact Assessment (SIAM)

• Sediment analysis
• Water quality (temperature) analysIs

WEST

corfsul' ... .,'~ 'NC
...."'...........e-s:cc"lsr..n:s ~c-

HEC-RAS is an integrated package of hydraulic analysis programs, in which the
user interacts with the system through the use of a Graphical User Interface (GUI).

The system is capable of performing Steady and Unsteady Flow water surface
profile calculations, and will include Sediment Transport, and several other
hydraulic design computations in the future.

Basic Overview (rev. 2/05) 2



• A set of data files associated with a particular river system

• The User can perform various types of analyses within the
HEC-RAS system

In HEC-RAS terminology, a Project is a set of data files associated with a particular
river system. The modeler can perform any or all of the various types of analyses
included in the HEC-RAS package as part of the project.

• What is an HEC-RAS "Project"?

WEST

c:.Ol'lSUlrA".ts,lHC
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Introduction

• A RAS project consists of:

• Geometric data

• Flow data (steady and/or unsteady)

• Plan data

• Hydraulic design data (optional)

WEST

CON"UlrA.~rl INC

W.WI wes;:c:.,s!J: ta:'t!S :~m

• Different "Plans" can be formulated in a RAS project

• Plans represent specific sets of geometric data and flow data

• Results from multiple plans are easily compared

The data files for a project are categorized as follows: plan data, geometric data,
steady flow data, unsteady flow data, and hydraulic design data.

During the course of a study, the modeler may want to formulate several different
Plans.

Each plan represents a specific set of geometric data and flow data. Once the basic
data are entered into HEC-RAS, the modeler can easily formulate new plans.

New plans are easily formulated once the basic data are entered.

After simulations are made for the various plans, the results can be compared
simultaneously in both tabular and graphical form.

Basic Overview (rev. 2/05) 4



RAS Project Schematic C:OI'tS"'~'AU':'INC
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Starting HEC-RAS
WEST

c or''l'u~ fA'l 1'- I Me

'(....~\"""eS:c~n3;_ tat:S-CC""'l

• A new program group and program Icon is created when yo Install the RAS
program

~• Double-click on the RAS icon from your Desktop to 5 art the program '"':,.;, I,
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When you run the HEC-RAS Setup program, you automatically get a new program
group and program icon for HEC-RAS in Windows.

To start HEC-RAS from Windows, double-click on the HEC-RAS Icon.

When you first start HEC-RAS, you will see the main window as shown below
(except you will not have any project files listed on your main window).

Basic Overview (rev. 2/05) 6



HEC-RAS Menu Bar
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HEC-RAS Menu Bar
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• Edit: Used for entering and
editing data
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• View: Provides for graphical
tabular displays of the model
output
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• Run: Used to perform
hydraulic calculations
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HEC-RAS Menu Bar

••••••••••••••••••••••••••'.•••••••••••••••••

• Options: Program options

Basic Overview (rev. 2/05) 9
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• Help: Access to the HEC­
RAS manuals and pertinent
information
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Button Bar
WEST
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• On the HEC-RAS main window is a Button bar. The
Button bar provides quick access to the most
frequently used options under the HEC-RAS menu
bar.

lU
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• There are five main steps in creating a hydraulic model with
HEC-RAS:

1. Starting a new project

2. Entering geometric data

3 Entering flow data

4. Performing the hydraulic calculations

5 Viewing and printing results

Steps in Developing a Hydraulic
Model with HEC-RAS

••••••••••••••••••••••••••••••••••••••••••••
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Starting a New Project

• To start a new project: Eile .. New Project
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• Select the drive and path

• Enter a project title, description, and file name ("*.prj" )

• Specify units: Options" Units System (US Customary/S.I.)

To start a new project, go to the Eile menu on the main HEC-RAS window and
select New Project, which brings up a New Project window.

You first select the drive and path that you want to work in (to actually select a path
you must double click the directory you want in H',3 directory box), then enter a
project title and file name.

The project filename must have the extension ".prj" - the user is not allowed to
change this.

After the OK button is pressed, a message box will appear with the title of the
project and the directory where the project will be placed.

Note: Before any Geometric data and Flow data are entered, the user should select
the Units System (English or Metric) that they would like to work in,

This is accomplished by selecting Unit System from the Options menu on the main
HEC-RAS window.

Basic Overview (rev. 2/05) 12



Geometric data are entered by selecting Geometric Data from the ,!;dit menu on the
main HEC-RAS window.

The next step is to enter the necessary geometric data, which consist of
connectivity information for the stream system (River System Schematic), cross­
section data, and hydraulic structure data (bridges, culverts, weirs, etc.).

eOrf.IJ~Y""af'S.I"'C
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• Cross-section data

• Hydraulic structure data
(bridges, culverts. weirs,

etc.)

• Enter the necessary geometric
data

• Reaches. junctions (River
System Schematic)

Geometric Data Editor

• Enter geometric data from the
£dit menu

Once this option is selected, the geometric data window will appear as show in the
Figure (except yours will be blank when you first bring this screen up for a new
project).

Basic Overview (rev. 2/05)
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Entering Geometric Data

• River Reach tab to draw a reach

• Drawn upstream to downstream

• Enter River System and Reach

• Junctions formed as reaches are
connected

• enter a identifier for each Junction

• Cross-section and hydraulic structure
data entered after reach defined

WEST
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The geometric data is developed by pressing the River Reach button and drawing in
a reach from upstream to downstream (positive flow direction).

After the reach is drawn, the user is prompted to enter a "River System" and a
"Reach" identifier.

As reaches are connected together, junctions are automatically formed by the
interface. The modeler is also prompted to enter an identifier for each junction.

After the river system schematic is drawn, the modeler can start entering cross­
section and hydraulic structure data. Pressing the Cross Section button causes the
cross section editor to pop up. This editor is shown in Figure 4.

Basic Overview (rev. 2/05) 14



Each cross section has a River name, Reach name, River Station, and a Description. These
identifiers are used to describe where the cross section is located in the river system and are input as
shown in Figure 4.

Cross-Section Data Editor eON.1J L rJ>,.~ r l.lr4C
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• Options" Add a New
Cross Section

• Each cross section has a River
name. Reach name, River
Station. and a Description

• Defines where the cross
section is located

• River stationing must be
specified before cross-section
data can be entered
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Entering Cross-Section Data

• The "River Station" must be a numeric value

• Suggestion: corresponds to actual river station location
(e.g .. miles, kilometers)
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• Cross sections ordered from highest river station upstream to
the lowest river station downstream.
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The "River Station" identifier does not have to be the actual river station (miles or
kilometers) at which the cross section is located on the stream, but it does have to
be a numeric value (e.g. 1.1,2,3.5, etc.).

The numeric value is used to place cross sections in the appropriate order within a
reach.

Cross sections are ordered within a reach from the highest river station upstream to
the lowest river station downstream.

Basic Overview (rev. 2/05) 16



Each cross section .has a River name, Reach name, River Station, and a Description. These
identifiers are used to describe where the cross section is located in the river system and are input as
shown in Figure 4.

Cross-Section Data Editor

• Required data for each cross­
section:

WEST
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• Main channel bank
stationing

• Manning's 'n' values

• Contraction and expansion
coefficients

• Station/Elevation data

• Reach length

Basic Overview (rev, 2/05)
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Cross-Section Data Options

• Additional cross section
features under Options
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• Edit features are available to cut.
copy, paste, insert. and delete data
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Additional cross section features are available under Options from the menu bar.
These options include:

adding, copying, renaming and deleting cross sections

adjusting cross section elevations, stations, and n or k-values

skewing cross section

ineffective flow areas; levees; blocked obstructions

adding a lid to a cross section

adding ice cover

adding rating curve

horizontal variation of n or k-values

vertical variation of n-values

Also available from the Cross Section Data editor is the ability to plot any cross
section or reach profile.

Edit features are available to cut, copy, paste, insert, and delete data from the Cross
. Section X-V Coordinates grid.

Basic Overview (rev. 2/05) 18
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• Select the "Save Geometric
Data As" option to save data.
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Entering Geo·metric Data

• The Junction Data editor is
available from the Geometric
Data window.

"",,--to'>J.i_ .1t ~

t~ fd .."""'~'''',_F.....Il. b] .~:~

• Hydraulic structures - bridges, culverts, weirs, and spillways

• added after cross-sections

Once the cross-section data are entered, the modeler can then add any hydraulic
structures such as bridges, culverts, weirs and spillways.

Data editors, similar to the cross section data editor, are available for the various
types of hydraulic structures.

If there are any stream junctions in the river system, additional data are required for
each junction. The Junction Data editor is available from the Geometric Data
window.

Once geometric data are entered, the data should be saved to a file on the hard
disk: This is accomplished by selecting the "Save Geometric Data As" option from
the File menu on the Geometric Data editor.

This option allows the user to enter a title for the geometric data. A filename is
automatically established for the geometric data, and then saved to the disk. Once
a title is established, geometric data can be saved periodically by selecting "Save
Geometric Data" from the File menu of the Geometric Data editor.

Basic Overview (rev. 2/05)
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Steady Flow Data Editor
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• Flow data should be entered
after the geometry has been
defined

• The Steady Flow Data Editor is
available under the Edit menu
bar option on the HEC-RAS
main window.

• The button bar can also be used
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Once the geometric data are entered, the modeler can then enter any flow data that
are required. The data entry form for flow data is available under the £dit menu bar
option on the HEC-RAS main window.

An example of the flow data entry form is shown in Figure 5, which is the Steady
Flow Data editor.

Basic Overview (rev. 2/05) 20
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Boundary conditions are required in order to perform the calculations.

The Steady Flow Data consist of: the number of profiles to be computed; the flow
data; and the river system boundary conditions.
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Entering Flow Data

• The Steady Flow Data consist of: ~~~.f!ID!!i:~~e!'m!!E!B:~

• the number of profiles to be
computed.

• the flow data.

• river system boundary
conditions.

• At least one flow mus be entered
for every reach within the system. ===.:::.=:....:= ---'

• flow can be changed at any
location within the river system.

• Flow values must be entered for all
profiles.

• Boundary conditions are required in
order to perform the calculations.

At least one flow must be entered for every reach withil'l the system. Additionally,
flow can be changed at any location within the river system. Flow values must be
entered for all profiles.

Basic Overview (rev. 2/05)
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Entering Flow Data
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Boundary Condition Requirements

• Subcritical flow analysis - downstream boundary conditions

• Supercritical flow analysis - upstream boundary conditions

• Mixed flow regime calculation - both required

f"'~""",
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If a subcritical flow analysis is going to be performed, then only the downstream boundary conditions
are required.

If a supercritical flow analysis is going to be performed, then only the upstream boundary conditions
are required.

If the modeler is going to perform a mixed flow regime calculation, then both upstream and
downstream boundary conditions are required.

The Boundary Conditions data entry form can be brought up by pressing the Reach Boundary
Conditions button on the Steady Flow Data entry form.

Once all of the steady flow data and boundary conditions are entered, the modeler should save the
data to the hard disk.

The user is only required to enter a title for the data, the filename is automatically assigned.

Basic Overview (rev. 2/05) 22
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• A plan is created with both a user specified geometry file and
flow file

• Once all of the geometric data and flow data are entered, the
modeler can begin to perform the hydraulic calculations

• Any of the available hydraulic design functions can be selected
from the Run menu bar option on the HEC-RAS main window
after a simulated has been run

COUSU1'A~'1 INC

W.W{.wts:cens~tl!lna~:"n

WEST

23

Performing the Hydraulic
Computations

An example of the simulation window is shown in Figure 6, which is the Steady Flow
Analysis window.

Once all of the geometric data and flow data are entered, the modeler can begin to
perform the hydraulic calculations.

The modeler can also select any of the available hydraulic design functions from the
Run menu bar option on the HEC-RAS main window.

Basic Overview (rev. 2/05)
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Steady Flow Analysis
Window
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• To access the Steady Flow Analysis window:

• Run It Steady Flow AnalysIs

• A Plan can be put together by selecting "New Plan" from the File menu
bar option of the Steady Flow Analysis window

• Enter a Plan Title and Short Identifier (Short 10) and then specify a
Geometry File and Steady Flow File

• The modeler can also select a Flow Regime:

• Subcritical. Supercritical. or Mixed

The modeler puts together a Plan by selecting a specific set of geometric data and
flow data.

A Plan can be put together by selecting "New Plan" from the Eile menu bar option of
the Steady Flow Analysis window.

Once a Plan Title and Short Identifier (Short 10) have been entered, the modeler
can select a Flow Regime for which the model will perform calculations.

Subcritical, Supercritical, or Mixed flow regime calculations are available.

Basic Overview (rev. 2/05) 24



The steady flow calculations can be performed by pressing the Compute button at
the bottom of the Steady Flow Analysis window.

Additional features are available under the Options menu to:
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• Additional features are available
under the Options menu to:

• Floodway Encroachment

• locations for flow dlstribulton

• conveyance calculation options

• fncllo slope methods

• calculation tolerances

• critical depth output options

• critical depth computatlO
method

• spilt flow optimization

• data cheCKing

• settmg log file OUlDlil levels

• viewing the log file OUtput

• Calculate steady flow analySIS

Performing the Hydraulic
Computations

perform a Floodway Encroachment Analysis

set locations for calculating flow distribution output

conveyance calculation options

friction slope methods

calculation tolerances

critical depth output options

critical depth computation method

split flow optimization

data checking

setting log file output levels

viewing the log file output

Basic Overview (rev. 2/05)
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Viewing and Printing
Results
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• Several output features are
available under the View option

from the main window, includingiF-:ma.llm2!~~'~!.r.m~rl!\~' [i§~...,,~.\~
• cross seclion plots Iii
• water sllrtace profile plots IFb "" "'" COlI '....,.". "",

~t=il s:;r (fO";~.~(lOl'~

• general profile plots El!!'j..:':>1 ...."'~ ;"" •.- "'''le.

I
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• rating curve plots r",,' .-"'-"""

• X-Y-Z perspective plots U~~) ~ ~:;f'~7::.~~~~
• st.age and flow hydrographs ~:::u~'UOJJ ~......"'-*' l-T00"'lr~"P'v •

• hydraulic property plots

• detailed output tables

• profile summary table

• summary oj errors warnings. and notes

• Viewing data lIl,ough DSS

• Unsteady. warel quality and Sediment
plots

Several output features are available under the View option from the main window.

These options include:

cross section plots

water surface profile plots

general profile plots

rating curve plots

X-Y-Z perspective plots

stage and flow hydrographs

hydraulic property plots

detailed output tables

profile summary table

summary of errors, warnings, and notes

DSS data

Basic Overview (rev. 2/05) 26



An example of a cross section plot is shown in Figure 7. The user can
plot any cross section by simply selecting the appropriate River, Reach
and River Station from the list boxes at the top of the plot.

The user can also step through the plots by using the up and down
arrow buttons. Several plotting features are available under the Options
menu of the Cross Section plot.

27

Viewing and Pri ting WEST

Results
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• Any cross-section can be i" "

.. " Ul(ooY t'"'lf'

viewed by selecting the River. ....... i,-"" '" ,- .oJ ~J!!J I

~~......~ • r, ~ IHI
Reach and River Station from
the list boxes.

• Cross sections can be viewed ~

by using the up and down ' - .... 1

arrow buttons or a drop-down
list

• Several plotting features are
r-;, ~ '-,, ,

available under the Options
menu.

• E.g .. zoom in/out, change
plans, modify line styles

~l[",

z-

Basic Overview (rev. 2/05)
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Viewing and Printing
Results
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• Hard copy output of the graphics can be accomplished in two
different ways:

• Plots can be sent directly from HEC-RAS to whichever
printer or plotter the user has defined under the Windows
Print Manager.

• Plots can also be sent to the Windows clipboard. Once the
plot is in the clipboard, it can then be pasted into other
programs, such as a word processor.

• Both of these options are available from the File menu on the
various plot windows. -

28

Hard copy output of the graphics can be accomplished in two different ways:

Plots can be sent directly from HEC-RAS to whichever printer or plotter the
user has defined under the Windows Print Manager.

Plots can also be sent to the Windows clipboard. Once the plot is in the
clipboard, it can then be pasted into other programs, such as a word
processor.

Both of these options are available from the Eile menu on the various plot windows.

Basic Overview (rev. 2/05) 28



An example of a profile plot is shown in Figure 8. All of the options
available in the cross section plot are also available in the profile plot.

Additionally, the user can select which specific reaches to plot when a
multiple-reach river system is being modeled.
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• All of the options available in the cross section plot are also
available in the profile plot.

• Additionally, the user can select which specific reaches to plot
when a multiple-reach river system is being modeled.

Viewing and Printing
Results

Basic Overview (rev, 2/05)
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x-Y-Z Perspective Plot
WEST
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• Plotting options:

• Specifying starting
and ending cross­
sections

• Rotation
• Vary the horizontal to

vertical ratio

• Multiple profiles can be
overlaid on the cross
section data.

• The graphic can be
printed or sent through
the Windows Clipboard
to other programs.

---.. -_.....

The user has the option of defining the starting and ending location for the extent of
the plot.

The plot can be rotated left or right, and up or down, in order to get different
perspectives of the river reach.

The computed water surface profiles can be overlaid on top of the cross section
data.

The graphic can be sent to the printer or plotter directly, or the plot can be sent
through the Windows Clipboard to other programs.

Basic Overview (rev. 2/05) 30



The first type of tabular output provides detailed hydraulic results at a specific cross
section location (cross section table).

An example of this type of tabular output is shown in Figure 10.

Detailed Tables

Tabular output is available in two different formats.
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• Tabular output is
available in two
different formats:

• "Detailed"

• "Summary"

• Detailed tabular
output provides

detailed hydraulic
results at a specific
cross section location.

Basic Overview (rev. 2/05)
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Summary Tables
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• "Summary Tables" show a limited number of hydraulic variables
for several cross sections and multiple profiles.
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The second type of tabular output shows a limited number of hydraulic variables for
several cross sections and multiple profiles. An example of this type of tabular
output is shown in Figure 11.

Basic Overview (rev. 2/05) 32



Users can also define their own tables by specifying what variables they would like
to have in a table.

There are several standard tables that are pre-defined and provided to the user
under the Tables menu from the profile output tables.

User specified table headings can be saved and then selected later as one of the
standard tables available to the project.
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Viewing and Printing
Results

Tabular outputcan be sent directly to the printer or passed through the clipboard in
the same manner as the graphical output described previously. This option is also
available under the Eile menu on each of the table forms.

Basic Overview (rev. 2/05)
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User-Defined Summary
Tables
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• Users can also define their own "summary" tables by specifying
what variables they would like to have in a table.

• User specified table headings can be saved and then selected
later as one of the standard tables available to the project.
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Objectives

.:. Limitations to HEC-RAS

.:. Study limit determinations

.:. Geometric data

',' Discharge data

.:. Roughness data

',' Calibration

.:. Consistency checks

2
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.:. All models are wrong, some are useful - Dr. George Box

3

The cost for developing 2-D and 3-D models are significantly higher than the cost
associated with developing a 1-0 model.

.;. HEC-RAS

• 1-0 model

• Gradually varied flow

• The channel has a "small" slope

.:. If these assumptions cannot be made, other modeling tools
may need to be considered

• 20 modeling

• 3D modeling

• Physical modeling

WEST
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Limitations to HEC-RAS

One-dimensional flow implies that depth 'and velocity vary only in the longitudinal
direction of the channel (i.e., the energy grade line elevation and water surface
elevation are constant across a given cross-section). Although the 1-0 assumption
is not theoretically correct, it is suitable for most open channel hydraulic work. The
gradually varied flow assumption implies that hydrostatic pressure prevails and that
vertical accelerations can be ignored. The exception to the gradually varied
assumption occurs at structures such as bridges, culverts, inline structures, and
lateral structures. At these locations, where the flow can be rapidly varied, the
momentum equation or other empirical equations are used. Typically, the channel
slope is considered "small" if it is less than 1: 1O. This is not a strict rule. For
example, small, isolated reaches greater than 10% may work just fine. This
breakpoint is simply where the depth measured parallel to gravity and the depth
measured normal to the bed slope begin to diverge significantly.
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Study Limit Determinations

.:. Need to determine study area boundaries

• Detailed topographic data

• Hydraulic computations

• Larger than project area

.:. Upstream boundary

• Project no longer impacts calculations

• Compare pre- and post-project profiles

• Empirical equation and nomograph

WEST
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Determining the study limits defines the area where detailed topographic data are
needed as well as where hydraulic computations are to be performed. The
boundaries usually extend further upstream and downstream of the area of interest.
The upstream boundary is usually a point where the impacts of the project (i.e.,
backwater effects) are no longer observed and hydraulic computations are no
longer needed. To determine this, a pre- and post-project profile can be
determined. Where these two profiles merge would be the appropriate location of
the upstream boundary condition. HEe's Accuracy of Computed Water Surface
Profiles (1986) presents an empirical equation and nomograph for locating the
upstream boundary under subcritical flow as a function of hydraulic depth, head loss
across the structure, and channel slope.

4
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.:. Downstream boundary

• Eliminate errors in downstream boundary condition

• Trial-and-error

• Empirical equations and nomographs

WEST
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Reach B

Davelopmenl 01 Base Profile

Reach A

Profiles Converge
in Reach A

Siart,ng
Normal Depth lOCClbon

Profile

Study Limit Determinations

The downstream boundary should be located sufficiently far enough downstream so
that any errors associated with the boundary condition are damped out before the
project area is reached. The location of the downstream boundary can be
determined by a trial-and-error procedure. Also, HEe's Accuracy of Computed
Water Surface Profiles (1986) presents empirical equations and nomographs for
locating the downstream boundary as a function of hydraulic depth and channel
slope.
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Geometric Data

-.- Aerial photographs and
site visits

.:. Flow visualization

.:. Bank station locations

.:. Reach lengths

.:. Ineffective flow areas

.:. Cross -secti 0 n
spacing/alignment

6
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.:. Sources

7

• Google Earth

• Government and local agencies/websites

• USGS quad sheets

Many websites have aerial photographs that can be viewed for free like the local
county's assessor site or flood control district site. Google Earth is also a
powerful tool for finding aerial photographs. Local universities may have
map/photo collections for the state that they are located in. Many government
agencies provide current and historical aerial photographs. A partial list of these
agencies includes:

cor41U1L IArJ fL INC
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WESTAerial Photographs and Site
Visits
-:. Useful first steps

.:- Assists in:

• Estimating roughness values

• Placing cross-sections

• Determining bank station locations

• Visualizing flow patterns through/around structures

1. US Geological Survey
http://edcsns17.cr.usgs.gov/finder/finder_main .pl?dataset_name=NAPP

2. Bureau of Land Management http://www.blm.gov/nstc/aeial/index.html

3. US Department of Agriculture (Farm Services Bureau)
http://www.fsa.usda.gov/FSAIapfoapp?area=apfohome&subject=1anding&topic=1
anding

••••••••••••••••••••••••••••••••••••••••••••



Flow Visualization

.:. Identifying flow lines helps in model development

.:. Flow lines help identify

• Ineffective flow areas

• Areas of storage

• Cross-section spacing and alignment

8
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• Do not cross flow lines

• Flow lines do not cross contour lines more than once

• Flow lines parallel contour lines and cross lower lines
as you draw them in the downstream direction
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.:. Sketched flow lines

• Bankfull discharge

• Largest event

Flow Visualization

Quad sheets should be overlaid with mylar or other transparent film and flow lines
sketched for bankfull and flood discharges (or largest event to be analyzed). If
there are radical changes in flow area between these two discharges, you may want
to add flow lines from an intermediate discharge.

Some general rules of thumb about drawing flow lines are as follows:

Remember to restrict the flow lines to a 1 to 1 contraction ratio and 4 or 3 to 1
expansion ratio.

Flow lines do not cross.

Flow lines do not generally cross contour lines more than once.

In a typical stream, flow lines generally parallel the contour lines and cross lower
lines as you draw them in the downstream direction

Draw flow lines starting from the upstream end unless here are significant
protruding land features - then see below.

Start drawing flow lines at the anticipated waters edge at protrusions into the water
flow. Then draw upstream at the 1 on 1 ratio and downstream at the 1 on 3 or 4
ratio. Continue reasonably drawing these lines upstream and downstream until they
hit the waters edge.
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Bank Station Locations
WEST
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.:. Difficulties

• Delineating channel from
overbanks

• Competing goals

.:. Tools
:l'

• Site visit

• Aerial photographs
. Criteria'.'

• Vegetation

• Soils

• Topography

10

At times, it can be difficult to determine the channel banks are located.
Sometimes, it may be difficult to delineate where the channel ends and
where the overbanks begin. Also, the entities involved in the project may
have competing goals that make it difficult to determine the bank station
locations. A developer may want to place the bank stations in towards the
channel so that there is more room to encroach. Local flood control
agencies may want to push the banks stations away from the channel to be
more conservative and provide better flood protection.

Site visits and aerial photographs are two important tools that the modeler
can use to determine the bank station locations. Vegetation, soils, and
topography are also valuable tools.

Vegetation - Bank stations are usually located at thepoint where vegetation
along the stream corridor changes from terrestrial to aquatic species, or the
point where permanent, terrestrial vegetation begins.

Soils - Banks stations are usually located at the point where soil
characteristics change from undifferentiated, poorly developed, layered,
fluvial deposits subject to scour and deposition to more well-developed soils
with distinct soil.

Topography - Bank stations are usually located at a break in slope or at the
point where the top of the channel bank transitions to the more planar
floodplain. 10
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The reach lengths can be determined automatically using HEC GeoRAS. However,
the engineer must still define a shape file that corresponds to the flow path for the
main channel, the left overbank, and the right overbank.

.:. Three reach lengths per cross-sections

• Main channel

• Left overbank

• Right overbank

.:. Main channel reach length measured along thalweg

.:. Overbank reach lengths measured using centroid of water
in the overbank areas

.:. Large flood events may have different reach lengths than
low flow events

COt'S"'~I"'NTI INC

W"N'.YYitl"':--:1.S_ !2"!",.lOC .....

WEST

Reach Lengths

Reach lengths are estimated by the engineer. Typically, they are measured on a
map using an engineer's scale along the estimated flow path between cross­
sections. For the main channel, the reach length is measured along the thalweg.
For the overbank areas, the reach lengths are measured along the centroid of the
water in the overbank areas. The location of the center of mass of the overbank
areas can be estimated based on the shape of the overbank areas. For example, if
the overbank areas have an approximate rectangular cross-sectional area, then the
centroid will be in the middle of the overbank area. If the overbank areas have an
approximate triangular cross-sectional area, then the centroid will be about 1/3 of
the distance from the bank station to the water's e·jge.

••••••••••••••••••••••••••••••••••••••••••••



Channel J{~aell
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Reach Lengths - Low Flows
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For large flows on meandering streams, the overbanks may be overtopped and the
channel flow may cut across the neck of the meander loop. In this case, the reach
lengths (and cross-section locations) will be different than they are for low flows
(see above figure). In this case, two geometry files are needed: one with the low
flow cross-sections and reach lengths and one for the high flow cross-sections and
reach lengths.

12
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For large flows on meandering stre ms, the overbanks may be overtopped and the
channel flow may cut across the neck of the meander loop. In this case, the reach
lengths (and cross-section locations) will be different than they are for low flows
(see above figure). In this case, two geometry files are needed: one with the low
flow cross-sections and reach lengths and one for the high flow cross-sections and
reach lengths.

••••••••••••••••••••••••••••••••••'.•••••••••

Reach Lengths - High Flows

, Channd Kl:<I h

I I 'nglh
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Ineffective Flow Areas
WEST
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.:. Flow lines will help in determining ineffective flow areas

.:. Obstructions to the flow (blocked obstruction feature)

• Add cross-sections if obstructions block significant
portion of the flow

~ Similar to cross-sections 2 and 3 for bridges

• May need additional cross-sections in influence zones

~ Similar to cross-sections 1 and 4 for bridges

• Remember to add ineffective flow as necessary

Inspection of the flow lines will help in determining ineffective flow areas. In
general, if the closest flow line to the boundary starts to significantly depart from the
actual boundary, the area between the flow line and the boundary may be
ineffective.

Identify those areas that contain obstructions to the flow. If these obstructions cover
a significant portion of the projected flow area (length perpendicular to the flow
lines), cross sections must be inserted at these locations.

If you place additional cross sections in these areas to represent an obstruction, you
should use the blocked obstruction option of HEC-RAS. Note that you should place
cross sections in the influence zones upstream and downstream of these
obstructions similar to cross sections 1 and 4 when modeling bridges. They should
be located, again, using the 1 to 1 contraction ratio and 4 or 3 to 1 expansion ratio
as rules of thumb.

Also, the blocked obstruction cross section should also have bounding cross
sections similar to cross sections 2 and 3 in modeling bridges. Remember to add
blocked ineffective flow areas at these cross sections.

You must also add cross sections upstream and downstream of the obstruction
corresponding to cross sections 4 and 1 used in modeling bridges and culverts.

14
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Ineffective Flow Areas

15
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Cross-Se~tion Spac;ng
WEST
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.:. Cross sections should be placed at representative
locations to describe the changes in geometry .

•:. Samuels (1989) and Fread (2003) have equations for
maximum spacing

.:. Other references (USGS, USACE)

.:. Additional cross sections should be added at locations
where changes occur in discharge, slope, velocity, and
roughness

.:. Cross sections must also be added at levees, bridges,
culverts, and other structures

16

Samuels, P.G. (1989). "Backwater lengths in rivers", Proceedings -­
Institution of Civil Engineers, Part 2, Research and Theory, 87, 571-582.

Other references that discuss cross-section spacing:

Davidian, J. (1984). "Computation of water-surface profiles in open
channels." USGS Techniques of Water-Resources Investigations, Book 3,
Chapter A15. http://water.usgs.gov/pubs/twri/twri3-a15/

Thompson, D.B., and Rogers, T.D. (1993). "Water surface profile
computations - how many sections do I need?" Proc., ASCE Conference on
Hydraulic Engineering, San Francisco, CA, July 25-30,791-796.

USACE. (1986). "Accuracy of computed water surface profiles." Hydrologic
Engineering Center, RD 26, Davis, CA.

16
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Where: 6X is the cross section spacing distance;

o is the bankfull depth (m); and
So is the bed slope

••••••••••••••••••••••••••••••••••••••••••.'•

Samuels' Equation for Cross­
Section Spacing

&<O.15D

So
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Cross-Section Spacing

.:. Major obstructions to flow (bridges, culverts, etc.)

.:. Stream gages/high water marks

.:. Embankments across the floodplain

.:. Significant changes in floodplain width

.:. Significant geometric changes in the channel

.:. Significant changes in roughness

.:. Significant changes in slope

.:. At or near levees

.:. Just upstream and downstream of tributaries

.:. At FEMA cross-section locations

WEST
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Bed slope plays an important role in cross section spacing. Steeper slopes
require more cross sections. Streams flowing at high velocities (i.e., streams
with large slopes) may require cross sections on the order of 100 feet or
less. Larger uniform rivers with flat slopes may only require cross sections
on the order of 1000 ft or more.

18
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Cross-Section Spacing

.:. How do you know if you have enough?

• Use the HEC-RAS cross section interpolation

• Make a new plan and run the model

• Compare the before and after

• If no significant difference, then OK!

19
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Cross-Section Spacing
WEST
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.:. Check data collected by survey team

.:. Field notes

• Check orientation

• Check location

• Compare elevations

• Verify cross-sections were surveyed from left to right

2.C

Once the survey team has collected the topographic data needed to define
the cross-sections, a check of the survey data should be performed. Using
the field notes, check that the location and orientation of each cross-section
is correct. Note contour elevations on the USGS quad sheets and compare
them to the elevations recorded by the survey team. Also, verify that the
cross-sections were survey from left to right looking downstream. If this is
not the case, the stationing can be easily reversed in HEC-RAS.

20
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If the overall cross section is skewed more than 18 degrees from the perpendicular
of the flow line (discussed later), either the cross section needs to be resurveyed or
reduced by an appropriate multiplier.

Copying cross sections in a meandering stream may require adjustments
(increasing or decreasing flow area) to the overbank areas but the channel size may
not change.
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Cross-Section Alignment

.:. Skewed cross-sections (greater than 18°)

• Resurvey cross-section

• Reduced flow area using skew routine in RAS

.:. Meandering streams

• Interpolation may require cross-section adjustments

• Channel size may not change

• Overbank areas may need to increase or decrease

.:. Dog-legged cross-sections

• Allows cross-sections to always be perpendicular to
flow lines

••••••••••••••••••••••••••••••••••••••••••••



Cross-Section Alignment
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23

Federal, state, and local agencies can be queried for previous reports and studies regarding your
project area.

USGS classifies good flow measurements from Price current meters to be within ±5% of the
true value. Some believe that this assumed error is optimistic. In any case, ±5%, on many
river systems, translates into a stage error of ±1 foot. Acoustic velocity meters provide a
continuous record (of velo ity), but the current USGS technique calibrates these meters to
reproduce measurements from Price current meters, so the AVM is as accurate as the
current meter. Boat measurements are always suspect. Newer techniques using acoustic
velocity meters with three beams mounted on boats are thought to be much better.
Published discharge records should also be scrutinized. Continuous discharge is
computed from discharge measurements, usually taken at bi-weekly or monthly intervals
and the continuous stage record. The measurements are compiled into a rating curve and
the departures of subsequent measurements from the rating curve are used to define shifts.
The shifts are temporary changes in the rating curve due to unsteady flow effects (looped
rating curve) and short term geomorphic changes. The quality of the record depends on
the frequency of discharge measurements and the skill of the hydrologist. The only way to
tell is to compare the discharge measurements to the flow record. Still, if the
measurements are infrequent, one can only apply the flow record to the model and see how
well the stage record is reproduced. Remember! Most published flow records are in mean
daily flow. The modeler must somehow assign time values to these records (HEC).

(USGS, 1992) Office of Surface Water Technical Memorandum No 93.07, Policy Statement
of Stage Accuracy, Dec. 4, 1992. http://water.usgs.gov/admin/memo/SW/sw93.07.html

••••••••••••••••••••••••••••••••••••••••••••

Discharge Data

.:. Previous studies

• Flood Insurance Studies (FIS)

• Flood Control District's studies

.:. Gage Data

• Single valued stage-discharge relation

• Current meter discharge measurements

• USGS rating system
~ Excellent rating is +/- 2%

~ Good rating is +/- 5%

~ Fair rating is +/- 8%

~ Poor rating is +/- 10%

WEST

CO"'~"'Lf"'Nl'",IHC

.,1'",....' v,u:coi1S_ ':8"t:J e:"'"

23



Discharge Data

.:. Statistical analysis

• Need at least 10 years worth of data

• HEC-FFA

WEST
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.:. Regional analysis

• Regression equations

• Specific to a given area

.:. Watershed modeling

• Develop design storm

• Calculate runoff hydrograph and peak discharge

• TR-20, HEC-1, HEC-HMS

24

Statistical analysis: statistical discharge-frequency estimates are generally
considered reasonably accurate only for frequencies that are similar to the length of
the actual record. A "rule of thumb" states that frequency estimates should extend to
less than twice the period of record. In addition, the data must be homogenous. The
HEC-FFA program can be used as a tool to perform a statistical analysis.

Regional analysis: If the study requires only peak discharges and floodplain or
reservoir storage ·s not a factor, then regional analysis is often used. Regression
equations are often considered the next most accurate estimate of peak-discharge
frequency, because the equations are derived from statistical analysis of actual
gage data. Regional analysis has been used by USGS to develop flood-peak
prediction equations for states, urban areas around the country as well as for
specific cities.

Watershed Modeling: Only watershed modeling gives full discharge hydrographs
and translates these hydrographs through the watershed, allowing the effects of
timing, tributary inflows, reservoirs, channel modifications, and other flood mitigation
components to be properly evaluated. Hydrologic modeling develops an actual or
synthetic design storm and calculate the runoff hydrograph and peak discharges for
the specified event. These models includes TR-20, HEC-1, and HEC-HMS.

24



Picture Comparison: If gage information for the site is not available, comparing
pictures of the study reach to similar reaches whose channel n values has been
determined can be a very accurate method for estimating n values.

Table Lookup: Through site visits, the study channel or floodplain can be described
and then compared to standard descriptions of channel or floodplain conditions
already defined in different hydraulic tables (e.g., Chow, 1959).

Judgment/Experience: Engineers with open channel hydraulic studies experiences
can develop an intuitive feel for the appropriate Manning's n values. However,one
should always evaluate n values with many different techniques before adopting a
value, instead of relying on his/her own experience or judgment.

Cowan's Equation: The Cowan Equation (1956) is a very useful method to deriving
an analytic estimate of channel n values for the study reach. Since Cowan
developed his procedure from studying 40 to 50 small- to moderate-size channels,
this equation is questionable for streams with a hydraulic radius larger than 15 ft
(4.6m).

n =overall roughness value

nO =base n-value for a smooth, straight reach

n1 = additional roughness due to surface irregularities

n2 = additional roughness due to variations of the shape and size of the channel
cross-sections

n3 =additional roughness due to obstru~§ns

25
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Roughness Data

.:. Judgment and/or experience

.:. Table lookup

.:. Picture comparison

.:. Cowan's equation

n = (no + 171 + 11:. + n3 + /14 )m:;
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Calibration

.:. Definition

.:. Gage data

.:. High water mark data

.:. Field interviews

.:. Newspaper records

',' Hydrologic comparisons

.:. Verification data

WEST
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Calibration Definition: The hydraulic model always requires calibration to give a
sense of confidence that the program output does properly repr~sent what would
occur on the prototype river. Calibration adjusts model parameters (within reason)
so that predicted system performance agrees with observed system performance
over a range of conditions.

Gage Data: Calibrating a model to only a single cross section has limited value.
Output from the floodplain modeling program should be calibrated to several actual
discharge and stage data pairs representing different runoff events. If multiple gage
sites or flood high water marks are available, they should be used to -:;alibrate the
model to several sites along the stream.

High water Mark Data: If one or more large floods have occurred, high water marks
records are often available to calibrate the model. The high water marks can contain
some error. High water marks obtained from field interviews depend on a person's
memory and whether the individual witnessed the flood level on the recession side
rather than at the peak.

Field Interviews: If no formal high water mark surveys were not available, the
engineer can perform a survey to local residents to obtain these estimates directly.

Newspaper Records: Because references to flood level on a local landmark are
often printed, so newspaper records are often a good source of high water mark
data.



If the model shows severe changes occurring from cross section to cross section,
there should be a physical reason for the changes; if not, the model must be
adjusted.

Look at the velocities and flow percentage of the main channel and overbank areas.
If the prototype is fairly uniform in the longitudinal direction, the velocities and flow
distribution of the channel and overbanks should be fairly consistent also.

••••••••••••••••••••••••••••••••••••••••••••

Consistency Checks

.:. Velocities and flow percentage

• Main channel

• Overbank areas.

.:. Should be fairly consistent

.:. If not consistent

• Is there a physical reason for the changes?

• If not, the model must be adjusted

27
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Consistency Checks
WEST
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+:. Example 1 - Consistency in velocity

• ross section 1: 2 mls

• Cross section 2: 0.5 mls

• Cross section 3: 3 mls

• Channel geometry and slope is relatively u iform

.:. Not a reasonable result!

.:. Need to find out why there is an inconsistency

28

For instance, if channel velocity goes alternately 2 m/s to 0.5 m/s to 3 m/s in the
downstream direction and the channel geometry and slope is relatively the same
throughout the reach, this is not a reasonable model result.

It may be that where the channel velocity was 0.5 mis, there was a large increase in
overbank flow area or conveyance, thus decreasing the channel discharge, resulting
is a lower channel velocity. One may then consider if all of the overbank area
should be available for conveyance in such a short distance.

28
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.:. Fixes

29

You must judge if the reach length between the cross sections was sufficiently long
to allow such a large transfer of water from one overbank, through the channel, and
to the other overbank.
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Co sistency Checks

.:. Example 2 - Consistency in flow

• Percentage of discharge in one overbank

• See figure on next slide

.:. Is reach length between the cross sections long enough?

• Use ineffective flow areas

• Adjust the overbank roughness values

.:. Remember to check the channel discharge and velocity in
adjacent cross sections

Another example would be if the percentagE: of discharge (say 60%) in one
overbank changed to 10% in the next downstream cross section and the
percentage in the channel stayed the same (say 20%). This means that the other
overbank changed from 20% to 70% in the downstream direction.

Appropriate adjustments would be to use the ineffective flow options or adjust the
overbank Un" values. Again, remember to check the channel discharge and velocity
in relation to the adjacent cross sections.

••••••••••••••••••••••••••••••••••••••••••••



Consistency Checks
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Analysis System
By WEST Consultants, Inc.

Optional Capabilities of HEC-RAS

m Note: This lecture was partially derived from Chapter This documem IS property of WEST

4 of the HEC-RAS Hydraulic Reference Manual Consulran 5 In: and 15 not 10 be
duplicated '.....tho prior consent
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Overview

• Cross-section interpolation

• Mixed flow

• Momentum equation for junctions

• Flow optimization

• Flow distribution

• Water quality analysis

Optional Capabilities (rev. 8/05)

WEST
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Cross Section interpolation is activated from the Tools menu of the Geometric Data
editor screen.

• Cross Section interpolation is activated from the Tools menu of
the Geometric Data editor screen.

• Need for interpolated Cross Sections

• Stnng Model Concepts

String Model Concepts

3
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Cross Section
Interpolation

Need for interpolated Cross Sections

Optional Capabilities (rev. 8/05)
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Need for Interpolated
Cross Sections

WEST
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• Geometric Requirements

• Occasionally it is necessary to supplement surveyed cross
section data by interpolating cross sections

"'" However. surveyed cross-sections are preferred over
interpolation.

• Cross sections should be located at significant breaks in
slope or- shape

"'" Interpolation of cross sections should not be used when these
IJreaks occur between the cross sections.

• Hydraulic Requirements

• Change in Velocity Head is too large

• Defaults to critical depth

Geometric Requirements

Occasionally it is necessary to supplement surveyed cross section d2ta by
interpolating cross sections in between two surveyed sections.

Cross sections should be located at significant breaks in slope or shape; therefore,
interpolation of cross sections should not be used when these breaks occur
between the cross sections.

Hydraulic Requirements

Interpolated cross sections are often required when the change in velocity head is
too large to accurately determine the change in the energy gradient.

When cross sections are spaced too far apart, the program may end up defaulting
to critical depth.

Optional Capabilities (rev. 8/05) 4



Optional Capabilities (rev. 8/05)

The HEC-RAS program has the ability to generate cross sections by interpolating
the geometry between two user-entered cross sections.

Upslrc.:sm ~CI ion
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• The HEC-RAS program has the ability to generate cross
sections by interpolating the geometry between two user­
entered cross sections.

String Model Concepts

General

••••••••••••••••••••••••••••••••••••••••••••
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• Concept of Master and Minor Cords

• Cords connect the coordinates of the upstream and
downstream cross sections .

• The cords are classified as "Master Cords" and "Minor
Cords'.

Concept of Master and Minor Cords

The string model in HEC-RAS consists of cords that connect the

coordinates of the upstream and downstream cross sections.

The cords are classified as "Master Cords" and "Minor Cords".

Master Cords

The master cords are defined explicitly as to the number and starting and

ending location of each cord.

The default number of master cords is five and are based on the

following location criteria:

First coordinate of the cross section (may be equal to left bank)

Left bank of main channel (required to be a master cord)

Minimum elevation point in the main channel

Right bank of main channel (required to be a master cord)

Last coordinate of the cross section (may be equal to right bank)

Optional Capabilities (rev. 8/05) 6



The cords are classified as "Master Cords" and "Minor Cords".

Master Cords

Concept of Master and Minor Cords

Optional Capabilities (rev. 8/05) 7
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Master Cords

• The master cords are defined explicitly as to the number and
starting and ending location of each cord.

• The default number of master cords is five and are based on the
following location criteria:

• First coordinate of the cross section (ma'! be equal to left
bank)

• Left bank of main channel (required to be a master cord)

• Minimum elevation point in the main channel

• Right bank of main channel (required to be a master cord)

• Last coordinate of the cross section (may be equal to right
bank)

First coordinate of the cross section (may be equal to left bank)

Left bank of main channel (required to be a master cord)

Minimum elevation point in the main channel

Right bank of main channel (required to be a master cord)

Last coordinate of the cross section (may be equal to right bank)

The string model in HEC-RAS consists of cords that connect the

coordinates of the upstream and downstream cross sections.

The master cords are defined explicitly as to the number and starting and

ending location of each cord.

The default number of master cords is five and are based on the

following location criteria:

••••••••••••••••••••••••••••••••••••••••••••



Master Cords
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• At a minimum there must be four master cords (only two if the
bank stations equal the end points).

• A Channel invert cord is included by default, but is not required.

• Additional master cords can be added by the user.

• Additional user specified master cords should be constructed
to assist HEC-RAS in properly interpolating cross section.

• Capture significant continuous land features

.'---.-..-' . "'-------

At a minimum there must be two master cords, but there is no maximum; therefore,
additional master cords can be added by the user.

Additional user specified master cords should be constructed to assist HEC-RAS in
properly interpolating cross section.

This is particularly important if there are important continuous land features from
one cross section to another that are not the same distance from the cross section
edge or channel from one cross section to another.

This is explained in Chapter 6 of the HEC-RAS User's Manual, under cross section
Interpolation.

Optional Capabilities (rev. 8/05) 8



Minor Cords

Interpolated points are generated at all of the minor and master cords.

Optional Capabilities (rev. 8/05)

Once all the minor cords are computed, the routines can then interpolate any
number of sections between the two known cross sections.

9
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Minor Cords

• Minor cords are automatically generated.

Determined by establishing coordinates between the upstream
and downstream cross-sections

The station values at the opposite cross section are determined
by proportioning.

• Station and Elevation at the new XS are then Interpolated.

• The number of minor cords will be equal to the sum of all the
coordinates in the upstream and downstream sections minus
the number of master cords.

The station values at the opposite cross section is determined by computing the
proportional distance that the known coordinate represents between master cords
and then applying the proportion to the distance between master cords of the
opposite section.

Interpolation is accomplished by linearly interpolating between the elevations at the
ends of a cord.

The number of minor cords will be equal to the sum of all the coordinates in the
upstream and downstream sections minus the number of master cords.

. The minor cords, automatically generated by the interpolation routines, are
determined by taking an existing coordinate in either the upstream or downstream
section and establishing a corresponding coordinate at the opposite cross section
by either matching an existing coordinate or interpolating one.

••••••••••••••••••••••••••••••••••••••••••••



String Model Concepts
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• Interpolation of Roughness Coefficient

• The interpolation routines will also interpolate Manning's n
values and is based on a string model similar to the one
used for geometry.

• Cords are used to connect the breaks in roughness
coefficients of the upstream and downstream sections.

;0

Interpolation of Roughness Coefficient

The interpolation routines will also interpolate roughness coefficients (Manning's n
values) and is based on a string model similar to the one used for geometry.

Cords are used to connect the breaks in roughness coefficients of the upstream and
downstream sections.

Optional Capabilities (rev. 8/05) 10
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The default number of master cords is four and are based on the following location
criteria:

When either of the two cross sections has more than three n values, additional
minor cords are added at all other n value break points.

11
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WESTInterpolation of Roughness
Coefficient
• The default number of master cords is four and are based on the

following location criteria:

• First coordinate of the cross section (may be equal to left
bank)

• Left bank of main channel

• Right bank of main channel

• Last coordinate of the cross section

• When either of the two cross sections has more than three n

values. additional minor cords are added at all other n value
break points.

• Interpolation of roughness coefficients is then accomplished in
the same manner as geometry interpolation.

First coordinate of the cross section (may be equal to left bank)

Left bank of main channel

Right bank of main chan,el

Last coordinate of the cross section

Interpolation of roughness coefficients is then accomplished in the same manner as
geometry interpolation.

••••••••••••••••••••••••••••••••••••••••••••



Mixed Flow Regime
Calculations

• General

• Calculation Scheme

General

Calculation Scheme

Optional Capabilities (rev. 8/05)
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The Specific Force equation is used in HEC-RAS to determine which flow regime is
controlling, as well as locating any hydraulic jumps.

Detailed information on the computations are presented in Chapter 4, pages 4-6 to
4-8 of the Hydraulic Reference Manual

The HEC-RAS software has the ability to perform subcritical, supercritical, or mixed
flow regime calculations.

13

13
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General

• The HEC-RAS software has the ability to perform subcritical,
supercritical. or mixed flow regime calculations.

• The Specific Force equation is used in HEC-RAS to determine
which flow regime is controlling. as well as locating any
hydraulic jumps.

• Detailed information on the computations are presented in
the Hydraulic Reference Manual.

Optional Capabilities (rev. 8/05)
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Calculation Scheme
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• The mixed flow regime calculations in HEC-RAS are performed
as follows:

1. A subcritlcal water surtace profile IS computed starting from a known
downstream ooundary condition.

2 During the subcritical calculations. all locations where the program defaults
to critical depth are flagged for further analysIs

3. A supercritical profile calculation is started from the upstream end with a
user specified upstream boundary condition.

4. If the boundary condition is supercritical and has a greater specific force
than the previously computed subcritlcal water surface. Ihen it IS assumed
to control. and the program will begin calculating a supercritlcal profile from
this section.

5. If the subcritical answer has a greater specific force. then the program
begins searching downstream to find a location where the program
defaulted to critical depth In the subcntlcal run. upon which the program
uses it as a boundary condition to begin a supercritical profile calculation.

••

The mixed flow regime calculations in HEC-RAS are performed as follows:

A subcritical water surface profile is computed starting from a known downstream
boundary condition.

During the subcritical calculations, all locations where the program
defaults to critical depth are flagged for further analysis.

A supercritical profile calculation is started from the upstream end with a user
specified upstream boundary condition.

If the boundary condition is supercritical and has a greater specific
force than the previously computed subcritical water surface, then it is assumed to
control, and the program will begin calculating a supercritical profile from this
section.

If the subcritical answer has a greater specific force, then the program begins
searching downstream to find a location where the program defaulted to critical
depth in the subcritical run, upon which the program uses it as a boundary condition
to begin a supercritical profile calculation.

Optional Capabilities (rev. 8/05) 14
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The program then goes to the next downstream location that has a critical depth
answer and continues the process.

If the supercritical answer has a greater specific force, the program
continues making supercritical calculations in the downstream direction and
comparing the specific forces

15
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Calculation Scheme

6. A supercritical profile in the downstream direction is calculated un il it
reaches a cross section that has valid subcritical and supercritlcal
answers. calculates the specific force 0 both computed water surface
elevalions and selects the one with the greater speciilc force.

7 If the supercritlcal answer has a greater specific force the program
continues making supercritical calculations in the downstream direction
and comparing the specific forces

8 When the program reaches a cross section whose subcritlcal answer has a
greater specific force than the supercritlcal answer. the program assumes
that a hydraulic jump occurred between that section and the prevIous cross
section

9 The program then goes to the next downstream tocallon that has a critical
depth answer and continues the process.

A supercritical profile in the downstream direction is calculated until it
reaches a cross section that has valid subcritical and supercritical answers,
calculates the specific force of both computed water surface elevations and selects
the one with the greater specific force.

When the program reaches a cross section whose subcritical answer
has a greater specific force than the supercritical answer, the program assumes that
a hydraulic jump occurred between that section and the previous cross section.

••••••••••••••••••••••••••••••••••••••••••••



Calculation Scheme
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ModelL 9 Stream Junctions

• General

• Possible Junction Conditions

• Momentum Method

General

Possible Junction Conditions

Momentum Method

Optional Capabilities (rev. 8/05)
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Modeling Stream Junctions
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• Stream junctions can be modeled in two different ways within
HEC-RAS.

• Energy Method

• Default method.

• Standard step backwater and/or forewater calculations
through the junction.

• Does not account for the angle of any of the tributary flows.

• Because most streams are highly subcritical flow. the
influence of the tributary flow angle is often insignificant.

1R

Stream junctions can be modeled in two different ways within HEC-RAS.

Energy Method

The default method is an energy based solution.

The energy method solves for water surfaces across the junction by performing
standard step backwater and forewater calculations through the junction.

The energy method does not account for the angle of any of the tributary flows.

Because most streams are highly subcritical flow, the influence of the tributary flow
angle is often insignificant.

Optional Capabilities (rev. 8/05) 18



If the angle of the tributary plays an important role in influencing the water surface
around the junction, then the user should switch to the alternative method available
in HEC-RAS, which is a momentum ba~ed method,

The momentum based method is a one dimensional formulation of the momentum
equation, but the angles of the tributaries are used to evaluate the forces associated
with the tributary flows.

••.'••••••••••••••••••••••••••••••••••••••,.
••

Modeling Stream Junctions

Momentum Method

• If the angle of the tributary
plays an important role in
influencing the water surface
around the junction,

• 1-D form of the momentum
equation, angles of the tribs
are used to evaluate the forces
associated with the trib flows,

Momentum Method

Optional Capabilities (rev. 8/05)
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Possible Junction Conditions
WEST
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• There are six possible flow conditions that HEC-RAS can handle
at a junction

• Subcritical flow - flow combining

• Subcritical flow - flow split

• Supercritical flow - flow combining

• Supercritical flow - flow split

• Mixed flow regime - flow combining

• Mixed flow regime - flow split

• The most common situations are the subcritical flow cases (1)
and (2).

There are six possible flow conditions that HEC-RAS can handle at a junction

Subcritical flow - flow combining

Subcritical flow - flow split

Supercritical flow - flow combining

Supercritical flow - flow split

Mixed flow regime - flow combining

Mixed flow regime - flow split

The most common situations are the subcritical flow cases (1) and (2).

Optional Capabilities (rev. 8/05) 20



Carefuil Angles
may be different
between low and
high flow events.

Required Data

Optional Capabilities (rev. 8/05) 21
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WESTMomentum Calculation at
Junctions

• Required Data

• User must supply the angle for any reach with flow lines that
are not parallel to the mainstem's flow lines.

To use the momentum based method, the user must supply the angle for any reach
with flow lines that are not parallel to the main stem's flow lines.

••••••••••••••••••••••••••••••••••••••••••••



Momentum Calculation at
Junctions
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• "Combining" Junctions

• Angles for both reaches 1 (81) and 2
(e2) should be entered .

• Each angle is taken from a line that is
perpendicular to cross section 3.0 of
reach 3 (the mainstem.)

• For subcriticai flow, the water surface is
computed up to section 3.0 of reach 3 by
normal standard step backwater
calculations.

• If the momentum equation is selected, the
program solves for the water surfaces at
sections 4.0 and 0.0 by performing a
momentum balance across the junction.

;. ...

22

Combining Junctions

An example of a flow combining junction is shown in Figure 3.

In this example, angles for both reaches 1 (8 1) and 2 (82) should be entered.

Each angle is taken from a line that is perpendicular to cross section 3.0 of reach 3
(the main stem.)

For subcritical flow, the water surface is computed up to section 3.0 of reach 3 by
normal standard step backwater calculations.

If the momentum equation is selected, the program solves for the water surfaces at
sections 4.0 and 0.0 by performing a momentum balance across the junction

Optional Capabilities (rev. 8/05) 22
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For subcritical flow, the water surface elevation is known at sections 2.0 and 3.0,
and the water surface elevation at section 4.0 can be found .

,.

.... ,
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• Subcritical Flow at "Split" Junctions

• For subcritical flow, the water
surface elevation is known at
sections 2.0 and 3.0, and the
water surface elevation at section
4.0 can be found.

Momentum Calculation at
Junctions

Subcritical Flow at Split Junctions

•••••••••••••••••••••••••••••••••••••••••••••



Momentum Calculation at
Junctions
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• Supercritical Flow at "Split" Junctions

• For supercritical flow. the water
surface is known al section 4.0 only.
and. therefore, the water surface
elevation at section 3.0 and 2.0 must
be solved simultaneously.

• Mixed Flow

• Mixed flow regime computations for a
flow split are handled in the same
manner as the energy based
solution. except the momentum
equation is used to solve for the
water surface elevations across the
junction,

Supercritical Flow at Split Junctions

For supercritical flow, the water surface is known at section 4.0 only, and, therefore,
the water surface elevation at section 3.0 and 2.0 must be solved simUltaneously.

Mixed Flow

Mixed flow regime computations for a flow split are handled in the same manner as
the energy based solution, except the momentum equation is used to solve for the
water surface elevations across the junction.
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• The steady flow optimization in RAS can distribute the summed
flows across any split reaches based on balancing energy

• The user must specify an initial estimate of the flow in each split

25

25
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Initial condition
flow:: 100 cfs

1000cfs
(upstream
boundary
condition)

Steady Flow Optimization

Initial eondltlU
flow = 300 cIs

The steady flow optimization in RAS will distribute the summed flows across
any split reaches based on balancing energy. For the example in the slide,
RAS will iterate until it obtains a solution to where the energy at the
upstream cross sections of the two split channels are equal, and the
summed flow between the two channels is 1000 cfs (300 cfs + 700 cfs). The
sum of the flows across the split reaches does not need to equal the flows in
the combined upstream or downstream reaches. For example, the upstream
reach in the slide could have 800 cfs, and the downstream read· 1200 cfs.
In this case, RAS will still distribute a total of 1000 cfs between the two split
channels.

.'•••••••••••••••••••••••••••••••••••••••••••



How to Optimize Steady
Flow Distributions
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Select Flow Optimizations from the Options window in the Steady Flow
Analysis Editor. Type a "y" at the junction(s), or other location, where you
wish to optimize flow (HEC). Remember, in a subcritical backwater analysis,
energy is balanced across the two downstream channels at a flow split, and
not at a downstream confluence. In the example in the slide, assuming a
subcritical run, optimization would then need to occur at the Tusseyville
junction and not at the Coburn junction. The Beta Version of RAS allows
optimization for supercritical flow.
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Flow Distribution Calculations

• Default Flow Distribution

• Defining Distribution Locations

• Computations

• Cautions in Using the Flow Distribution Option
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Default Flow Distribution

Defining Distribution Locations

Computations

Cautions in Using the Flow Distribution Option

Optional Capabilities (rev. 8/05)
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Default Flow Distribution
WEST
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• The general cross section output shows the distributions of flow
in three subdivisions of the cross section.

• Additional output showing the distribution of flow for multiple
subdivisions
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• Through the Options menu of the Steady Flow Simulation
window. 1'.. , .~;;,z • ..:.C.!29
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The general cross section output shows the 'istributions of flow in three
subdivisions of the cross section.

Additional output showing the distribution of flow for multiple subdivisions of the left
and right overbanks, as well as the main channel, can be requested by the user
through Options menu of the Steady Flow Simulation window.
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The user can select specific locations or all locations in the model.
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Defining Distribution
Locations
• Specific locations or all

locations in the model.

• Define Slices for left
overbank, main
channel. and right
overbank

• Up to 45 total slices

• Each sub-section must
have at least one slice.

Each flow element (left overbank, main channel, and right overbank) must have at
least one slice.

The number of slices for the flow distribution computations must be defined for the
left overbank, main channel, and the right overbank with up to 45 total slices which
can vary from cross section to cross section.

••••••••••••••••••••••••••••••••••••••••••••



Flow Distribution
Computations
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• The computations for the flow distribution are performed after
Steady Flow computations

• Water surface elevation is computed using the three flow
subdivisions and balancing the energy equation.

• The program computes an area, wetted perimeter, and
hydraulic depth (area over top width) for each user defined
slice.

• Using the originally computed energy slope (Sf), the
conveyance and percentage of discharge are computed for
each of the slices.

30

For further details on how to request and view flow distribution output, see Chapters
7,8, and 9 of the HEC-RAS User's Manual.

The computations for the flow distribution are performed after the program has
calculated a water surface elevation and energy. The flow distribution computations
are performed as follows:

Water surface elevation is computed using the three flow subdivisions
and· balancing the energy equation.

The program computes an area, wetted perimeter, and hydraulic depth
(area over top width) for each user defined slice.

Using the originally computed energy slope (Sf)' the conveyance and
percentage of discharge are computed for each of the slices.
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An average velocity for each slice is computed by taking the same
conveyance as was originally computed.

A ratio of the original total conveyance (from the normal calculations)
divided by the total slice conveyance is determined.

The ratio is applied to each of the slices, in order to achieve the same
conveyance as was originally computed.

31
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WESTFlow Distribution
Computations

• The computed conveyance for each slice are summed.
The sum of the slice-computed conveyances is usually
greater than the original conveyance

• A ratio of the original total conveyance (from the normal
calculations) to the total slice conveyance is determined.

• The ratio is applied to each of the slices. in order to
achieve the same conveyance as was originally computed.

• An average velocity for each slice is computed by taking
the same conveyance as was originally computed.

The computed conveyance for each slice are summed. The sum of
the slice computed conveyance is usually greater than the original
conveyance because the computed conveyance for a given water
surface elevation will increase with each new slice.

•••••••••••••••••••••••••••••••••••••••••••••



Flow Distribution Cross
Section Output Table
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In general, the results of the- flow distribution computations should be used
cautiously.

To achieve such detail, the user would need to use a three-dimensional hydraulic
model, or measure the flow distribution in the field.

The results shown are based upon one-dimensional computations and true velocity
and flow distribution vary vertically as well as horizontally.

33
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Represenratlon of True Veloeiry
Dlstnbutlon

---
H:::C.RAS Veloeit> Distribution

• Multi-Dimensional Reality of Flow

• In general, the results of the flow distribution computations
should be used cautiously.

• The results based on 1-D computations.

• To achieve such detail. the user would need to use a three­
dimensional hydraulic model, or measure the flow
distribution in the field.

Cautions in Using the Flow
Distribution Option

Multi-Dimensional Reality of Flow

••••••••••••••••••••••••••••••••••••••••••••



Cautions in Using the Flow
Distribution Option
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• Use of Flow Distribution Option

• Based on average estimates of the one-dimensional results.

• Results can vary based on the number of slices.

• In general, it is better to use as few slices as possible.

• Better to think of it more as Conveyance Distribution than
Velocity Distribution

Use of Flow Distribution Option

While the results from the flow distribution provided by HEC-RAS are better than the
standard three subdivisions (left overbank, main channel, and right overbank)
provided by the model, the values are still based on average estimates of the one­
dimensional results.

The results obtained from the flow distribution option can vary with the number of
slices used for the computation.

In general, it is better to use as few slices as possible.

The slices that are created are more representative of conveyance slices over
velocity slices.
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The Water quality module uses the QUICKEST-ULTIMATE explicit numerical
scheme to solve the one-dimensional advection-dispersion equation. Individual
sources and sinks as well as computed concentrations are available model output.
The model simulates fate and transport of water temperature, arbitrary conservative
and non-conservative constituents, dissolved nitrogen, dissolved phosphorus,
algae, CBOD, and dissolved oxygen. In order to run the water quality model, a
working, calibrated HEC-RAS unsteady or steady flow model must already be in
place. (HEC)

• One-dimensional advection-dispersion equation

• Fate and transport of:

Water temperature

• Arbitrary conservative and non-conservative constituents

• Dissolved nitrogen

• Dissolved phosphorus

• Algae

• eBOD

• Dissolved oxygen

• Must have a working, calibrated model first

35
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WESTPerforming a Water Quality
Analysis
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Water Quality Data Entry

• Water quality constituents

• Temperature modeling

• Nutrient modeling

~ Requires temperature modeling

• Arbitrary constituent modeling

~ Independent of temperature and nutrient modeling

• Water quality data

• Changes based on modeling technique used

• Boundary conditions

• Initial conditions

• Observed data

WEST
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The model organizes constituents and sources and sinks into three major groups.
Temperature modeling computes heat energy sources and sinks and water
temperature. Nutrient modeling simulates nutrients, dissolved oxygen, CBOO, and
algae. Because most of the rate constants in the nutrient model are temperature
dependent, nutrients may not be modeled unless water temperature is also
simulated. Arbitrary constituents are simple tracers, configured by the user.
Arbitrary constituents are independent of water temperature and nutrients. (HEC)
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• Run steady flow model

• Enter necessary water quaiity
parameters

• Click on the Water Quality . .. ,
Analysis button 'c """'" "'0<
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Water Quality Analysis Window:

1. Select appropriate hydraulic plan

2. Select appropriate water quality data file

3. Select appropriate steady flow profile to be used in the analysis

4. Enter a starting and ending time information (not constrained by hydraulic model
because a steady model is used)

5. Hit the compute button
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Viewing Water Quality
Results
• Water quality spatial plots
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Spatial results along the channel
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• Water time series plots

Viewing Water Quality
Results

Time series of results at a particular location.
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(HEC).
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• Geometric data

• Unsteady flow data
• Boundary and initial conditions

• Hydraulic property tables

• Unsteady f1o~ simulation manager
• Creating an unsteady sin~ulation

• Post-processor

• Additional graphics/tables to view results

• Ovenrie~T

CON SU L1ANTS.INC
\\' W. y,es:consuHants com
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Unsteady Intra Lecture (rev. 7/8/09)2
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• Same geometry for steady and unsteady flow

• Simple dendritic streams to cOlnplex networks
can be modeled

• Same hydraulic structures for steady and
unsteady flo\v

• Capable of modeling a wide variety of hydraulic
structures (e.g., bridges, culverts, levees, etc.)

• Uses the UNET equation solver (Dr. Robert
Barkau)

Relatively fast n1atrix solver

3

A key element in the design and development ofHEC-RAS was to ensure that the
same hydraulic calculation routines were used for both steady and unsteady flow
computations (HEC). HEC reports that the matrix solver is relatively fast when
compared to FLDWAVE and DWOPER (Apr. 2001 course notes). RUNUNET, a
Windows interface, is available to lUn UNET from Windows 95, 98 or NT. See
RAS User's Manual, April 2001, Chapter 10.2 (WEST 05.02.02)
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• Geometry is
ent(;red in the
same "Yay for ~

steady or unsteady 3!i!

flo"T models ...
-=•••

Additional data
-=.,•

may be required ~

nohomish River,
Washington

The same Geometric Data files can essentially be used interchangeably between a
steady flow and unsteady flow model. For example, storage areas can be used in a
steady flow model and will have a constant computed water surface elevation.
However, the user needs to have full understanding of how to construct an unsteady
flow model and the implications of the different modeling methods (e.g., permanent
vs. non-permanent ineffective flow areas) (WEST 05.02.02). Additional data may
also be required (e.g., HTab data) (WEST 07.09.03).
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• Storage areas .
• Storage area ...::u::-

1;
COnlleCtlOnS

~.1=
Inline and lateral

G'.~• t~
!!...:.!!

structures ~..~
• Time or elevation ~.....-=-

~

controlled gates

• Bridges and cuh erts

• Pumps

All of the existing hydraulic analysis features in the previous steady flow versions
ofREC-RAS work within the new unsteady flow computations. The following new
features were added to work with unsteady flow, but they also work in the steady
flow simulation: lateral structures; storage areas (used to model areas of ponded
water); storage area connections (used to exchange water between storage areas, or
between a storage area and a river reach) (REe).

5 Unsteady Intra Lecture (rev. 7/8/09)
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Flow and stage hydrographs

• Data can be entered manually or specified £1' m
a DSS file

The user is required to enter boundary conditions at all of the external boundaries of
the system, as well as any desired internal locations, and set the initial flow and
storage area conditions in the system at the beginning of the simulation period. Flow
and stage data can be entered manually in a quick and efficient manner within the
Unsteady Flow Data Editor. Data can be copied and pasted to and from
spreadsheets such as Microsoft Excel, or interpolated between specified values. The
specifics of each option are discussed in detail in the RAS Useros Guide, January
2001, and covered in a later lecture (WEST 05.02.02).
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• Lateral inflow to a node

• Uniform lateral inflow along a reach

• Ground"rater interflo\v

'. Head specified over time and independent of
river stage

• Time series of gate openings

• Elevation controlled gate

• Navigation dams

• Internal observed internal stage and/or flo\v
hydrograph

Options for external boundary conditions are: stage hydrograph, flow hydrograph,
combined stage and flow hydrograph (e.g., results from a forecast model where
stage is observed until the beginning of the forecast time when flow is simulated),
rating curve, or normal depth. The items in this figure are for internal boundmy
conditions.

7 Unsteady Intra Lecture (rev. 7/8/09)



8

CON S U Ll ANlS,lNC
......w. Wes.tCoosl.:tan1S c:orr:

Unsteady Intra Lecture (rev. 7/8/09)8

• Read in flow and stage at every node from £:

pre, iOtis run (i.e., a "restart" flie)

WEST

• Initial conditions must be established for the
entire system by either:

• Specifying flows for each branch; RAS then
calculates the stages through a steady state
simulation

Initial flows and stages are required to begin the unsteady flow calculations. One
option is to use standard step backwater calculations are used to calculate the initial
stages in the system from the user entered flows. Initial stages are set by the user
for storage areas. In addition, a "restart" file can be used instead (this is often called
a "hotstart" file). From the Unsteady Flow Analysis Editor, select Options, then
Output Options to set the restart file options. Restart files have the extension *.fst
(WEST 05.02.02).
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• Geometric pre-processor

• Processes geolnetric data into a series of
hydraulic property tables

• Unsteady flow sitTIulation

• Perfornted using a modified version of UNET

• Post-processor

• COlnputes detailed hydraulic information



The geometric pre-processor is used to process the geometric data into a series of
hydraulic properties tables, rating curves, and families of rating curves. This is
done in order to speed up the unsteady flow calculations. Instead of calculating
hydraulic vaIiables for each cross section during each iteration, the program
interpolates the hydraulic variables from the tables. The pre-processor must be
executed at least once, but then only needs to be re-executed if something in the
geometric data has changed (REe). The "HTab Param." button in the Geometric
Data Editor shown in this slide is used for editing cross section hydraulic table
parameters. The starting elevation, increment, and number of points are specified in
the cross section HTab Editor. There is a similar button in the Bridge/Culvert Data
Editor. Structures and gates could have an endless number of curves based on the
variation of upstream and downstream head as well as various gate openings.
Therefore structure and gated structure hydraulic tables are not determined in the
geometric pre-processor. See the next slide for discussion on the hydraulic table
parameters and plots (WEST 06.07.02).
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re-proces or

10

For unsteady flow, geometry is pre­
processed into tables ("HTab Param."
button) and rating curves

• Cross sections are proces ed into tables of
area, conveyance, and storage

• BridO'es and culverts are processed into a
family of rating curves for each structure

• Structure and gated structure data are not
detennined prior to the simulation

• Geometric pre-proc ssor result can be
viewed in graphs and tables

--

~.
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Cross sections are processed into tables of elevation versus hydraulic properties of
areas, conveyances, and storage, Each table contains a minimum of 21 points (a
zero point at the invert and 20 computed values), The user is required to set an
interval to be used for spacing the points in the cross section tables. The interval
can be the same for all cross sections or it can vary from cross section to cross
section. This interval is very important, in that it will define the limits of the table
that is built for each cross section. On one hand, the interval must be large enough
to encompass the full range of stages that may be incuned during the unsteady flow
simulations. On the other hand, if the interval is too large, the tables will not have
enough detail to accurately depict changes in area, conveyance, and storage with
respect to elevation (REe).

II Unsteady Intra Lecture (rev. 7/8/09)
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Clicking the "Table" tab will show the hydraulic property table data (WEST
06.07.02).
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Hydraulic structures, such as bridges and culverts, are convelted into families of
rating curves that describe the structure as a function of tailwater, flow, and
headwater. The user can set several parameters that can be used in defining the
curves (HEe).
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• Geometric Data Editor

• Create geometry and add tructures

• Unsteady Flo'w Editor

• Specify boundary and initial condition

• Unsteady Flow Analysis Editor

• Create a plan

WEST

C ON$U II A NT S,I N C
\..wo·.. \veslconsullants,com

14



U $ e
Editor

n WEST

CON S Ll l TAN T S, INC
W\W,' westconSLlltants,com

Geomeu;, Fik Beaver C, . bt..:Jge

Uns,Mdl' Flow Fil-; IJmlead:-.oIl-""'-d-.-I.-.-S-,,....,,-.-,E-"""'----

'CO(l~

f2~

- ._---
IU",,'obIe ,51-",11

SI",IJr.g i ,-ne
Enang l.me

ComP\Jl"',oo Sewr..g-
[""';"""''''dnlt>lvo] ..~-::::; HydiO(l'''llh Ou;put Inlt>lv"; '1 HOOI ..:.1

- Ct::mP<Aalrool"velOUlpYl Det".IffiOUlp<Jllnle,v<!l 2H';;:,.:.:J
DSS Outpu~ Fl'lename- lo\C.our.:.e:;\Ao/_Pvl\S'..200505Act..._worr..shopS_R "::

~ M....u Flow Reaulle hee menu ''01'1101\11101. Flow O<>tJorn; .. .'1

PrGg(eIm 10 Fa.on
;:;; Georneb}' Preproceswl
-:. Unste~d:v FlOw SII'OtAatjOll

-;. Pod Proce~St:l:

1. Define a Plan
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programs to run
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settings

,.-------

5. Press the Compute

button

Once all of the geometric and unsteady flow data have been entered, the user can
begin performing the unsteady flow calculations. To run the simulation, go to the
HEC~RAS main window and select Unsteady Flow Analysis from the Run menu (a
tool button is also available). The unsteady flow computations within HEC~RAS
are performed by a modified version of the UNET (Unsteady NETwork model)
program, developed by Dr. Robert Barkau (Barkau, 1992). The unsteady flow
simulation is actually a three step process. First, a program reads data from a HEC~
DSS file and convel1s it into the user specified computation interval. Next, the
UNET program runs. UNET reads the hydraulic properties tables computed by the
geometric pre-processor, as well as the boundary conditions and flow data. The
program (UNET) then performs the unsteady flow calculations. The final step takes
the results from the UNET unsteady flow run and writes them to a HEC-DSS file
(REC).

Barkau, R.L. (1992). UNET, one-dimensional unsteadyflow through afull network
olopen channels, computer program, St. Louis, MO.
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Additional simulation options include unsteady encroachments, dam (inline
structure) breach, levee (lateral structure) breach, and mixed flow options. These
options are discussed in a later lecture (WEST 12.19.03).

These options are all accessed from the Unsteady Flow Analysis Editor, under
Options (WEST 05.02.02). Default locations for stage and flow output
hydrographs are the upstream and downsh-eam ends of every reach and at bounding
sections of structures (e.g., bridges and structures). Flow roughness change factors
are set in calibration (April200l course notes).
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pti

• Flow roughness change factors

Seasonal roughness change factors

Additional output options

• Write restart file

• Debugging level output flie

Calculation options and tolerances

• Stage and flow output locations

• Flow distribution locations
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This editor is used to set a number of options and tolerances for unsteady flow
modeling, which are discussed in Chapter 8 of the RAS User's Manual, as well as in
detail in later lectures. Briefly, theta is a stability factor, which can be set to 1 (most
stable, least accurate) for initial simulations and then preferably lowered towards
0.6 (least stable, most accurate) for final sin1Ulations. Computation tolerances are
set in this editor (you may want to temporarily increase the tolerance values if you
are having trouble successfully completing a simulation, and then return to the
lower values once the stability issues have been corrected) as well as factors
affecting structure and spillway computations (WEST 06.07.02). Structure decay
exponents are used to stabilize highly submerged stlUctures and should range
between 1 and 3 (personal communication with HEC on 05.30.02).

Convert Energy Method Bridges to Cross Sections with Lids: This option is
used to convert bridges to normal cross sections instead of being processed as a
family of rating curves. If you have a bridge in which you are using the energy
solution method for high and low flow solutions, there is no need to process this as a
family of rating curves. Instead, you can have the progran1 treat the two internal
bridge cross sections as any other normal cross section. If you turn this option on,
the program will create a separate table of elevation versus area and conveyance for
each of the two internal bridge sections (HEC).
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• H) droO'raph output
inten al defines the

spacing of points 011 the

hydrograph

• Detailed output interval
defines the time steps
when animating

The computation time interval must be equal to or less than the time step manually
entered at the boundary condition. For example, the computation interval must be
15 minutes or less, if flow data at an upstream boundary are entered at 15 minute
intervals. If this rule is broken, the warning message "Boundary condition interval
is less than the computation interval" appears in the Unsteady Flow Analysis Editor
CREe).
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• Used to compute detailed hydraulic information

for a set of user-specified time lines :ld n
overall maximuHl watLr surface profile

• COlnputed stages and flovvs are passed to the
steady flo'w program for the cOlnputation of
detailed hydraulic results

The post-processor is used to compute detailed hydraulic infoffi1ation for a set of
user specified time lines dming the unsteady flow simulation period. In general, the
UNET program only computes stage and flow hydrographs at user specified
locations. If the post-processor is not run, then the user will only be able to
view the stage and flow hydrographs and no other output from HEC-RAS. By
running the post-processor, the user will have all of the available plots and tables for
unsteady flow that HEC-RAS nOlmally produces for steady flow. When the post­
processor runs, the program reads from HEC-DSS the maximum water surface
profile (stages and flows) and the instantaneous profiles. These computed stages
and flow are sent to the HEC-RAS steady flow computation program S ET.
Because the stages are already computed, the SNET program does not need to
calculate a stage, but it does calculate all of the hydraulic variables that are
normally computed. This consists of over two hundred hydraulic variables that are
computed at each cross section for each flow and stage (HEC).
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• All of the output vie,ving options that were
available for steady flow computations are
available for unsteady flo"7 (e.g., cross section,
profile, and 3-D plots and tables).

Additional ways to view unsteady results:

• Stage and flo" hydrograph
• Time series tables

• Animation of cross section, profl1e, and 3-D
graphics
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The stage and flow hydrograph button allows the user to plot flow hydrographs,
stage hydrographs, or both simultaneously. Additionally, if the user has observed
hydrograph data, those data can also be plotted at the same time, The plot can be
printed or copied to the Windows clipboard for use in other software programs
CREC).

21 Unsteady Intra Lecture (rev. 7/8/09)



CONSULTANTS,INC
\"NW ,.. es.:consultants CCJlT;

Unsteady Intra Lecture (rev. 7/8/09)22

~rS

T-'"IIY"I'g,

WEST

"". "''/'0.';, y" PtO'FteN- ... Ot, S-'lOgF "Obs,=tQ'll "", U,."'Rl?1St:tg

Sloqr- qON TeDIt:' i ~e.:I"q ~I'V'(I I
-- --r s-;;,~-r FI"'"
u~'e I~ INSl-VA_

22L..- ....I

By simply pressing the "Table" tab from the Flow and Stage Hydrographs plot, the
user will get a table containing the data in a time series format. These data can be
printed or copied to the Windows clipboard for use in other software programs
CHEC).
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The HEC-RAS software has the ability to animate the cross section, profile, and 3-D
graphics. Vv'hen the user selects the "Animate" button, HEC-RAS steps through the
computed results in a timed sequence (HEC). The Animation Control Editor
(accessed under Options from cross section, profile, or 3-D plots or by selecting the
"Animate" button) allows the user to control the speed of the animation by clicking
on the" ... " button and then selecting the delay (WEST 06.07.02).
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The output from an unsteady flow run are stage hydrographs. flow hydrographs. and
basic stage profiles. These hydrographs and profiles are stored in DSS. For more
detailed output you must run the post-processor. The post-processor reads the
hydrograph and profile information in the DSS file and creates detailed output data
for the maximum stage computed and for a series of snap shots in tinle based on the
selected "Detailed Output Interval" (REC).
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The log file is a text file, and can be viewed with any text file viewer such as
Notepad. DSS files are in a special binmy fom1at that requires a program
specifically designed to work with it (e.g., HEC-RAS, HEC-DSSVue). The output
files from the post-processor are in the same format as the output files from the
steady flow computation engine and require RAS in order to be viewed (REC).

WEST

CONSULTANTS INC

v.ww we.stcemsl!.tanlS com

Profile & eros. section table.

Profile plot,. & animation

Cros: section plot. c' :lJumation

Unsteady Output Lecture (re\'. 7/8/09)

I~ tag'c & flo~' hvdro~aphs

3

I - I

Ompul ~
File .....................

/~

DSS FiJe
.................

Read Results

~

'nstead~ Flo\\' COrJlplIwtion. (C. TET)

Reads and reformat' the bOllndan conditions data

.
Write Hydrographs

~ 7r------'-v,..:-..--------------------,

~eaay Sirn latiofl Flo.

Geometric
pre-processor

c

Unstead,' flow

simulation

Post-proccs or

••••••••••••••••••••••••••••••••••••••••••••



Locat~on· for
Hy'drograp .S

• Default locations
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• Upstream and downstream ends of all reaches

• Upstrean1 and downstream of internal
boundaries (e.g., bridges and structures)

• User selected locations

• Additional locations can be specified by the user

• Set through "Options" in the Unsteady Flow
Analysis Editor

• Can be created at a maXilTIUm of 500 locations

Stage and flow hydrographs are written by the unsteady computation engine at some
default locations, but the user has the option to request hydrographs at desired
locations (REC) ,
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The Stage and Flow Hydrographs window is opened from the main RAS window.
Stage and Flow Hydrographs can be selected from under the View menu.
Alternatively, the button highlighted in the slide can be pressed to open the window.
Data can be viewed graphically or in tabular form by selecting the desired tab. By
default, both stage and flow are plotted. When there are both stage and flow on the
plot, a second Y axis is displayed (HEC). Only simulated and observed stage and
flow, at one particular cross section at a time, can be viewed in the Stage and Flow
Hydrographs window. Other "types" of hydrographs (from Type on the menu bar)
can be selected (see the next slide) (WEST 05.02.02).
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Hydrographs at various other "types" of locations can be viewed once the Stage and
Flow Hydrograph window is opened (e.g., cross sections, bridges/culverts, inline
structures, etc.). Again, only one structure can be viewed at a time (WEST
05.02.02).
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• 'ariablc sho\\n:

• Stage at the upstream

(headwater) and

downstream (tailwater)
bounding cross section

• Flow at the c!o\-vnstream

cross sectIon

I Brid!!.eiGul,cn ,

T\X
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Stage plotted at the upstream and downstream cross sections of the blidge or
culvert. Flow is plotted only at the downstream end of bridge or culveli (HEC).
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• Variables shown:

• tage (headv..ater)

• tage (tailwater)

• Flo\y tOtal (tailwater)

• Flow in gate
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• Stage in storao-e area

• -et inflow to storage

area = L Qin - L Qout

Qin
\

Variables shown:

The only flow information saved for a storage area is stage and the net inflow. The
net inflow is the sum of all flows into a storage area (flows leaving are considered
negative). For information about the individual links to a storage area, go to the
storage area connection or lateral structure specific output (REe).
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HW

• Variables shoViTn:

• Stage (head\vater)

• Stage (taihvater)

• Flow

i2

The output for a storage area connection consists of two stage hydrographs and a
flow hydrograph (HEC).
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The DSS Viewer in HEC-RAS can also be used to look at the same data shown in
the Stage and Flow Hydrographs window. It is a little more laborious to fInd the
desired paths, but in the DSS Viewer users have more options for comparisons. In
the plot above, the inflow and outflow hydrographs for a long reach are compared
(HEe). This is a good way to simultaneously compare hydrographs at two or more
different locations (WEST 05.02.02). To get to the DSS Viewer, select View and
then DSS Data from the main RAS window. Alternatively, the user can just press
the "DSS" button on the main toolbar.
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• H. drologic Engineering Center' - Data
Storage SystelTl

• Database that stores tinle series data such as
stage and flo\, hydrographs

• Used with many BEe progranls as a data
source and storage for results

• Often used as data storage between
applications
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The DSS Viewer can be opened by clicking the "DSS" button (the last button on the
right) on the main RAS window or by selecting the menu option DSS Data under
View.

e.
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• Data are organized in a catalog of "paths"

• Paths have 6 parts (A-F)

• Part A - River basin or project nalTIe

• Part B - Location or gage identifier

• Part C - Data variable (e.g., FLOW', STAGE)

• Part D - Start for block of data

• Part E - Tilue interval (e.g., lDAY, 3HOUR,
5MIN)

• Part F - Additional descriptor (e.g., "SIM" or
"PLAN1")

The slide lists the typical uses for the six part names in DSS. In HEC-RAS, the F
part is assig ,~d the short plan ID from an unsteady simulation (WEST 06.07.02).
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Select the DSS file using the browse button. Highlight the desired path and press
the "Select Highlighted DSS Pathname(s)" button. The selected path then appears
in the lower window. The button in the lower left says "Plot/Tabulate Selected
Pathname(s)"; this option plots and tabulates the data. When viewing time series
data the specific time window can be entered or left blank (this option will plot all
of the data in a path). Select paths from the available list using standard Windows
extended selection keys (i.e., using the Shift key to select a range, Ctrl key to pick
individually, or Ctrl + A to select all). Plot the selected paths with the button on the
lower left. A new window will open with the data plotted in it (HEC).
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The path selection filter is used to nan-ow the list of paths displayed. This can
greatly speed the search for a particular path or a certain subset of paths. The list
filter is located on the first white line in the DSS Viewer labeled "Filter". To set a
filter: click the mouse pointer in one of the filter boxes and a combination drop
down list box will appear in the grid cell. The drop down list will contain a list of
all the enn-ies in this column. Select an entry in the drop down list or type some
characters in. If the DSS file contained only STAGE and FLOW records, then the C
Part filter list would contain only those two options. In the above example, the C
Part is filtered to "STAGE", and only the DSS paths in the file that have "STAGE"
as the first 5 characters are in the filtered list CREe).
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The DSS Plot window has two tabs, one for a graphical plot view am: the other for a
tabular view. All of the paths that were selected are in a drop down list labeled
"Path". When the window first opens, the "Path" list box contains the text "(All
Paths)". This will plot the all the selected paths in one plot. Alternatively, the user
could select one path from the list and plot one at a time. The plot options are
similar to the other plot options in R-A..S. The plot can be copied to the Windows
clipboard or printed, The table can be copied to the Windows clipboard and
transfened to an input table in RAS or to another program altogether (REe).

••••••••••••••••••••••••••••••••••••••••••••
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• Export to DSS:

• \X ater surface profiles

• Rating curve

• Storage outflow information

• Both steady and unsteady results can be
J ~

exported

• To export, select "File" and then "Export to
HEC-DSS" from the main RAS window

Data can be exported from HEC-RAS to HEC-DSS, the types of data that can be
exp011er are: water surface profiles. rating curves, and storage outflow information.
The export function gets data £i'om either a steady flow output file or from an
unsteady flow post-processor file. In general, when mnrllng unsteady flow
computations, the profiles and rating curves will already':'::: in a DSS file, but tills
utility is a good way of getting the fanlily of rating curves at an internal boundary
condition and the storage outflow data into DSS (HEC).
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21 Unsteady Output Lecture (rev. 7/8/09)

Press the "Export Profile Data" button to export the profiles to the DSS file (HEC).

The first step in exporting any data to DSS is to select or name the DSS file. The
file can be a new or an existing file. If the file already exists, the paths and data will
be appended to the file. If the file already exists, any data with matching pathnames
would be overwritten by the new data. The output options for profiles are water
surface profiles (for plotting purposes the channel invert gets written as well) and
flow profiles. Select the profiles and reaches to export with the "Profiles" and
"Reaches" buttons. Select the river station staI1ing position. There are 6
possibilities (similar choices for metric):

1. in feet sta!1ing at 0

2. in feet sta!1ing at lowest river station (assuming river station is in feet)

3. in feet starting at lowest river station (assuming river station is in miles)

4. in miles starting at 0

5. in miles starting at lowest river station (assuming river station is in feet)

6. in miles starting at lowest liver station (assuming liver station is in miles)

••••••••••••••••••••••••••••••••••••••••••••
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Rating curves (stage versus flow) can be exported by selecting the second tab. All
that is required to export rating curves is a list of the cross section locations. The
left portion of the window allows users to select reaches and then select the river
stations of that reach. The button with an arrow would tl ·1 be used to transfer the
highlighted river stations to the selected list box on the right In the above window,
3 cross sections and 1 lateral structure are in the selected list When the rating
curves for bridges and culverts are exponed, a family of rating curves is expOlied to
the DSS file. The family of rating curves is a set of upstream stage verses flow
curves for a variety of tailwater elevations (REC). Results from interpolated cross
sections can also be expOlted (April 2001 course notes). The default is to export
stage vs. flow in the order in which they occUlTed in the simulation. The "SOli
flows in rating curves" box can be checked to write to DSS results sOlied in order of
increasing flow (WEST 06.07.02).
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Unsteady Output Lecture (rev. 7/8/09)

Storage outflow information consists of a table of the computed volume of water
between a specified range of cross sections for a given flow. This infOlmation can
be used for hydrologic routing in a hydrology model such as HEC-HMS or REC-l.
The range of cross sections. can span reaches but must start and end on the same
river. The starting and ending river stations are entered into the cells in a row of the
table. The cells of the table will change to a drop-down list box with the available
options listed. For example, if a cell in the first column is selected, the list box will
have all the rivers in the system, but if cell in the second column is selected, only
the reaches in the river entered in the first column will be present in the drop down
list. The DSS patlmame made to store the data is based on the downstream cross
section location. The A part of the pathname is the combination of the river and
reach names, the B p3l1 is the downstream river station, and the F p3l1 is the plan
short rD. For the example above the following DSS pathname would be added:
/FALL RIVER UPSTREAM REACH/9.6/FLOW-YOLUME/I/l 00 YR EVENT/
CREC).

••••••••••••••••••••••••••••••••••••••••••••
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The unsteady flow computation engine can write detailed output to a text log file.
The log file contains a detailed information about the progression of computations
and can be of assistance in fmding errors that cause the unsteady flow program to
crash. The log file c,: 1 easily get into the hundreds of megabytes in size. If your
simulation is crashing a long way into it, consider creating a restan file before
things go unstable. Then restart the simulation nearer the point where it crashes.
This output option is turned on from the Options menu on the Unsteady Flow
Analysis Editor. Select Output Options and a dialog will appear (right) with an
option fo turn on the detailed output. When this option is on, the unsteady flow
computation engine will write a text file that can be accessed from the options menu
by selecting View Computation Log File (HEC).
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This is the *.BCO file from UNET. SEC ID (e.g., 1s6.000) are identified by reach
number (e.g., 1), followed by an's' and then the RS (e.g., 6.000). This is a good
place to look for the word "warning". This is discussed in more detail in the
debugging and stability lecture (WEST 05.02.02).
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• Can be run after the unsteady sinl.ulation is
completed

Provides profiles far the Inaximum stage and at

regular intervals

• All regular graphics and tables can be used ta

view the post pracess results

• Generates data for animation
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The cross section plots, profiles, and 3-D plots can be animated. Under the Options
menu of the profile plot, select Animate and the animation bar will be displayed.
Select the button with an arrow to the light for an animation. The animation will
affect all graphics loaded, so if a cross section and profile plot are opened, the water
surface will be animated in both windows CREC).
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Profile summary tables are used to show a limited number of hydraulic variables for
several cross sections (HEC). The "Max WS" is the maximum water surface from
the simulation period and can be the data from various time steps at different cross
sections (\VEST 09.23.03).
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tailed output tables show hydraulic information at a single location, for a single
profile (HEC).
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The geometric pre-processor is used to process the geometric data into a series of
hydraulic property tables and rating curves. This is done in order to speed up the
unsteady flow calculations. Instead of calculating hydraulic variables for each cross
section during each iteration, the program interpolates the hydraulic variables from
the tables. The pre-processor must be executed at least once, but then only needs to
be re-executed if something in the geometric data has changed (HEC).
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Cross sections are processed into tables of elevation versus hydraulic properties of
areas, conveyances, and storage. Each table 'ontains a minimum of 21 points (a
zero point at the invert and 20 computed values). The user is required to set an
interval to be used for spacing the points in the cross section tables. The interval
can be the same for all cross sections or it can vary from cross section to cross
section. This interval is very important, in that it will define the limits of the table
that is built for each cross section. On one hand, the interval must be large enough
to encompass the full range of stages that may be incuned dw-ing the unsteady flow
simulations. On the other hand, if the interval is too large, the tables will not have
enough detail to accw-ately depict changes in area, conveyance, and storage with
respect to elevation. Viewing the graphical output is a good diagnostic tool for
examining cross section geometry. The output is located under the View menu, or
the shaded button in the figw-e. The relationship of area, storage, and conveyance
should be examined for abrupt changes with elevation. Any abrupt changes should
be reviewed to determine the overall significance within that paliicular model.
Clicking on the "Table" tab will show the tailwater information in tabular form.
Detailed output is also available for each computed increment. Detailed output can
be examined to detemune a specific elevation or station where a problem is
occurring (REC). A "Warning! Extrapolated above the top of the propeliy table"
will appear in the Computation Log file if the water sw-face elevation is computed
above the highest elevation of the hydraulic table (WEST 06.07.02).
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The Geometric Data Editor is shown in the above figure. From this editor, select the button labeled
HTab Paramo to view and edit the cross section table parameters. As shown in the figure, the table
contains three columns in which the user can enter infom1ation: starting elevation; increment: and
number of points, The first time the user opens this editor all of the columns are automatically filled.
The starting elevation columns are automatically filled to an elevation one foot higher than the
invert, however, the user can change these values to whatever they want. The second and third
columns are used for the table increment and the number of points. These two variables will
describe the extent to which the table encompasses the cross section data. A default value will be set
for the increment and the number of points. Nonnally the increment will be set to one foot, and the
number of points will be set to a value that will allow the table to extend to the top of the cross
section. If this combination would end up with less than 20 points. then the number of points is set to
20 and the increment is reduced to get the table to the top of the cross section. The user can set these
values individually for each cross section, or they can highlight a series of cross sections and use the
Set Values button to enter the value for all of the highlighted sections. Other options are available to
multiply highlighted fields by a factor or add a constant to all of them. Additionally, cut, copy. and
paste buttons are available for manipulating the data (HEC). Default Parameters (English):
Starting elevation = 0.5' above minimum cross-section ground point; Increment = a function of the
vertical (elevation) range of geometry points, up to l' maximum. Number of Points = number of
points required to span the vertical (elevation) range of geometry points for the detennined
increment, a minimum of 20 and a maximum of 100. To revert back to default values, delete data
from all columns (WEST 05.17.02)

5
Unsteady Additional Data

LecUlre (re\'. 1/2/07)



CON~UltAN1:; INC

W\\W "'t's:cor~I:">lUScom

WEST

Unsteady Additional Data
Lecture (rev. 1/2/07)

E>.C

200

J l' Increment
,-- .J

I( Startlng Elev.• 3.S'

t

t~ortr

IOC· 150

6

Diamond

9

\
:!5 t

I

I
30 Points ' 20

1
\

15:1 --______.
j --.r
• t101
)

Sj
o.:-.----·~-----~

o

"'~GO=--_. .::.3 :1.5

Increment values should be set small enough so that the HTAB values adequately
reflect the channel geometry.
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HEC-RAS uses Manning's equation to calculate conveyance. Imbedded in this
equation are relationships for channel depth, channel area, and wetted perimeter. In
this example, Manning's equation sees an enonnous increase in wetted perimeter for
a minute increase in water depth. The conveyance answer found hom this
calculation is dramatically different from the conveyance answer found at the
previous calcu~ation just below the flat teJTace on the left overbank (HEC). Smooth
transitions are desired in all of the hydraulic property tables. Abrupt changes can
occur when the overbank ground slope becomes relatively flat, causing a sudden
change in conveyance. A work around is to set a horizontal change in en' value at
this grade break. Note, however, that the Manning's en' value does not need to
change. Separate conveyance calculations are made for each overbank, the channel,
as well as for any sections with changes in Manning's 'n' (this is discussed in Chap.
2 of the Hydraulic Reference Manual) (WEST 05.17.02).
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To account for this situation, a subdivision made by inserting another Manning's 'n'
value could be added at the point of discontinuity. The value does not need to be
different, as long as the subdivision is present, RAS will calculate separate
conveyances for the geometry CREC). The sudden change in conveyance is
removed by adding the horizontal change in Manning's 'n . (WEST 05.17.02).
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• For ineffective flow areas:
• 'Water is not actively being conveyed
• Velocity is close to zero in the downstream direction

• Unsteady flow models account for:

• StOrage
• Conveyance

• When the water surface i below the (non-permanent)
ineffective flow area elevation:

• Ineffective area =storage

• When the \vater surface is above the (non-permanent)
ineffective flow area elevation:

• Ineffective area =active conveyance

This option allows the user to define areas of the cross section that will contain
water that is not actively being conveye (ineffective flow). Ineffective flow areas
are often used to describe portions of a cross section in which water will pond, but
the velocity of that water, in the downstream direction, is close to zero. This water
is included in the storage calculations and other wetted cross section parameters, but
it is not included as part of the active flow area. In unsteady flow modeling it is
important to account for channel storage as well as conveyance. In steady flow
modeling, storage is not simulated, and portions of the cross section are typically
blocked off with ineffective areas. It may be useful to think of storage-only portions
of a cross section as having extremely high n-values, which effectively nullifies the
conveyance, When the water surface surpasses the trigger elevation, the ineffective
flow area will either begin to convey flow or remain ineffective depending upon its
type (pemlanent on non-permanent). The concepts ofpelmanent and non-pennanent
ineffective flow areas are addressed in the next set of slides (HEC).

9
Unsteady Additional Data

Lecture (re\'. 1/2/07)



For non-permanent ineffective flow areas, once the water surface is higher than the
trigger elevation, the entire ineffective flow area becomes effective (as shown in the
slide). Water is assumed to be able to move freely in that area based on the
roughness, wetted perimeter, and area of each subdivision. The left and right
overbanks are no longer considered storage but are now active flow areas (REC).
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Storage goes to zero while conveyance increases dramatically, when non-pennanent
ineffective areas are overtopped (WEST 05.17.02).
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For permanent ineffective flow areas, when the water surface elevation surpasses
the trigger elevation, the area below the nigger elevation remains ineffective. Water
above the nigger elevation is assumed to convey flow (REC).
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Set the normal ineffective flow area locations by selecting Ineffective Flow Areas
ul1der the Options menu of the Cross Section Data Editor. In the ineffective flow
area window, select the radio button labeled "Noffi1al". Notice the box labeled
"Permanent", check this box if the ineffective flow area never conveys flow. The
"multiple block" ineffective flow area option allows for the establishment of
blocked ineffective flow areas. Multiple blocked ineffective flow areas are useful
for bridge geometry with slopes or multiple openings. Blocked ineffective flow
areas require the user to enter an elevation, a left station, and a right station for each
ineffective block. Up to ten blocked ineffective flow areas can be entered at each
cross section. Notice the column labeled "Pem1anent (yin)"; change this column to
"y" for pennanent ineffective flow areas (HEC).
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The default in HEC-RAS is to set ineffective flow areas to non-permanent. To
change a set of river stations from non-p· rmanent to permanent, select Set
Ineffective Areas to Permanent Mode under the Tools menu located in the
Geometric Data Editor. Then select the proper river, reach, and river stations. This
is especially useful after using the Graphical Cross Section Editor because there is
no option in the editor to change between non-permanent and permanent (HEC).
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When examining geometry, the user must consider where water may leave the main
channel and how it will behave once out of the main channel. Knowing these
factors gives the user a general idea of how to conectly model the situation within
the framework ofHEC-RAS. As seen in the figure, there is water in the right
overbank. Because RAS is a one-dimensional model, the water surface elevation
will be the same for the entire cross section, The user must determine if water can
physically enter the right overbank at this cross section by examining upstream and
downstream cross sections, If water will enter the right overbank then the user must
determine how to model this area (HEC).
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The figure above represents the previous cross section with the right overbank
modeled as non-permanent ineffective flow. As seen in the figure, the storage in the
cross section increases until reaching the trigger elevation where the ineffective
flow area is turned off. By turning off the ineffective flow area the storage in the
cross section returns to zero and the area of the cross section increases. If the water
level could possibly reach the u"igger elevation then this is probably not the proper
way to model this cross section. The change in volume of storage, and the change
in area of the cross section, is too significant to model with a non-permanent
ineffective flow area CREe).
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The figure above represents the previous cross section with the right overbank
modeled as pem1anent ineffective flow. As seen on the figure, the storage in the
cross sec60n increases until reaching the top of the ineffective flow area where it
remains constant. If the water level could possibly reach the trigger elevation, while
remaining relatively stationary, then this is probably a better representation
compared to a non-pelmanent ineffective flow area. If it is determined that water
will not enter the right overbank, then the area should be modeled with a levee.
When the levee is established, no water can go to the right of the right levee station
until the levee elevation is exceeded. If the levee elevation is exceeded there will be
an extremely large increase in conveyance with elevation for this geometry. This
would not be the proper way to model the cross section if the levee is overtopped
(REe). If the levee is overtopped then the user should consider adding a storage
area (discussed in a later lecture). Using a combination oflevee with a pelmanent
ineffective area (i.e., representing the storage available when the levee is
overtopped) might create model instabilities by suddenly creating a large volume
available for storage. Also note, if using a levee with a permanent ineffective area,
the storage volume would be a function of the right bank geometry defined at this
cross section and the distance to the upstream and downstream cross section (WEST
05.17.02).
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Cr ating a storage area may be appropriate
when storage volume is important

• Terminate the cross section at the beginning of

the storage area

• Add a lateral structure and storage area

If the cross sectional geometry denotes a significant change in storage or
conveyance when a levee is overtopped then this cross section should be altered.
The cross section should be terminated at the levee and the area that was deleted
should be modeled as a storage area. Abrupt and significant changes in storage and
conveyance should be avoided because they can cause instabilities in the unsteady
flow model (REC). The right overbank should be removed so that the storage in the
area is not double counted. A blocked obstruction set to elevation above the
maximum water surface elevation should not be used to remove the area since this
will add wetted perimeter once the bank (levee) elevation is exceeded (WEST
05.17.02).
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A pilot channel cuts a rectangular notch into the bottom of the cross section.
Generally this notch is not very wide (often 1 foot is used), but it provides depth to
the cross section at low flows (typically make it 5 to 10 feet deep). Additionally, the
use of a pilot channel can smooth-out in-egularities in the channel bottom. This also
helps the stability of the model solution (particularly at very low flow). The pilot
channel area and conveyance are "bon-owed" from the lower portion of the main
channel, such that the total area and conveyance p;operties of the cross section
relate to the original cross section at higher flows. Once the depth of the flow gets
higher, the area and conveyance of the pilot channel are ignored (RAS User's
Manual, Vel'. 3, Jan 2001, Chapter 6). Pilot channels can be added from the Tools
drop down menu in the Geometric Data Editor. See the UNET Manual for how the
pilot channel area is "bolTowed" from the main channel (WEST 05.17.02).
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The user selects a river, reach, and range of river stations to apply the pilot channel
to. On the lower left hand side of the Pilot Channels Editor are utilities to enter the
pilot channel information. The user enters the pilot channel width an the
Manning's 'n' value (should be equal to or higher than the main channel 'n' value).
The user can either enter an elevation for the invert of the pilot channel and project
it on a slope over the range of cross sections, or they can enter an upstream and a
downstream invert elevation and have the program use linear inter-;)olation for the
cross sections in between. A list of the final pilot channel values for each of the
cross sections is shown in the table on the lower right hand side of the editor. The
user can modify the table directly and change any value on a cross section by cross
section basis. The profile plot on the editor will display the invert elevation of the
pilot channel so you can compare it to the actual channel invert. Once you have
finished adding the pilot channel information, press the OK button, and then save
the geometric data (RAS User's Manual, Ver. 3, Jan 2001, Chapter 6).
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(HEC).

References: HEC-RAS River Analysis System, User:S Manual, Chapter 8,
Perfonning an Unsteady Flow Analysis, January 2001 (HEC).
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Once all of the geometric data are entered, the modeler can then enter any unsteady
flow data that are required. To bring up the Unsteady Flow Data Editor, select
Unsteady Flow Data from the Edit menu on the HEC-RAS main window. The
Unsteady Flow Data Editor should appear as shown above. The user is required to
enter boundary conditions at all of the external boundaries of the system, as well as
any desired internal locations, and set the initial flow and storage area conditions in
the system at the beginning of the simulation period. Boundary conditions are
entered by first selecting the "Boundary Conditions" tab from the Unsteady Flow
Data Editor. River, Reach, and River Station locations of the external bounds of the
system will automatically be entered into the table. Boundary conditions are
entered by first selecting a cell in the table for a particular location, then selecting
the boundar) condition type that is desired at that location. ot all boundary
condition types are available for use at all locations. The program will
automatically gray-out the boundary condition types that are not relevant when the
user higWights a particular location in the table. Users can also add locations for
entering internal boundary conditions. To add an additional boundary condition
location. select the desired River, Reach, and River Station, then press the "Add a
Boundary Condition Location" button (HEC).

:? Unsteady Boundary Lecture (rev. 7/9/09)
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• 111.£10",,8 not at external boundaries

• Initial conditions required

• Used for computations at the start of the
simulation

• Optionally adding obsenTed data

The Unsteady Flow Editor.defines: external boundary type and data, optional
internal boundary data, and initial conditions for the start of the simulation (WEST
05.10.02).
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• Upstream options

• Stage hydrograph

1& Flow hydrograph

Ii Stagel flow hydrograph

-Downstream options
• Stage hydrograph

• Flow hydrograph

• Stage/flo\\' hydrograph

• Rating curve

• N armal depth

The upstream boundary can be:

• Stage hydrograph - e.g., gage data on the stream or tidal cycle

• Flow hydrograph - e.g., gage data converted to flow

• Stage and Flow hydrograph - e.g., combined observed stage and forecasted flow

The downstream boundary condition can also be:

• Rating curve - e.g., rating at a gauged location or steady-flow rating

• Normal depth - e.g., average slope of stream to estimate energy slope

The program will automatically gray-out the boundary condition types that are not
relevant (BEC).
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Stage hydrographs are most commonly used downstream boundaries. Data for
stage hydrographs are entered in an identical way to that for flow hydrographs
(WEST 02.10.02).
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• Manual table entry

• Select tin"1e interval

• Select tart date/ tin1.e

Type flow data or
copy and paste

• Interpolate option

A flow hydrograph can be used as either an upstream boundary or downstream
boundary condition, but is most commonly used as an upstream boundary condition.
When the flow hydrograph button is pressed, the window shown above will appear.
As shown, the user can either read the data from a REC-DSS (REC Data Storage
System) file, or they can enter the hydrograph ordinates into a table (REC).

Two other options at the bottom of this editor are "Min Flow" and "Multiplier".
Both of these options apply to user entered hydrographs or hydrographs
read from HEC-DSS. The "Min Flow" option allows the user to specify a
minimum flow to be used in the hydrograph. This option is very useful when
too low of a flow is causing instability problems. Rather than edit the user
entered hydrograph or the DSS file (depending upon where the hydrograph
is coming from), the user can enter a single value, and all values below this
magnitude will be changed to that value. The "Multiplier" option allows the
user to multiply every ordinate of the hydrograph by a user specified factor.
This factor will be applied to the user-entered hydrograph or a hydrograph
read from HEC-DSS. (HEC).
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If the user selects the option to read the data from DSS, they must press the "Select
DSS File and Path" button. When this button is pressed, a DSS file and pathname
selection screen will appear as shown. The user first selects the desired DSS file by
using the browser button at the top. Once a DSS file is selected, a list of all of the
DSS pathnames within that file will show up in the table. The user can use the
pathname filters to reduce the number of pathnames shown in the table. The last
step is to select the desired DSS patlmame and to close the window CREe).
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The user also has the option of entering a flow hydrograph directly into a table, as
shown above. The fIrst step is to enter a "Data Time Interval". Currently the
program only supports regular interval time series data. A list of allowable time
intervals is shown in the drop down window of the data interval list box. To enter
data into the table, the user is required to select either "Use Simulation Time" or
"Fixed Start Time". If the user selects "Use Simulation Time", then the entered
hydrograph will always start at the beginning of the simulation time window. The
simulation st3liing date and time are shown next to this box, but is grayed out. If
the user selects "Fixed Start Time" then the hydrograph is entered st3liing at a user
specified time and date. Once a starting date and time are selected, the user can
then begin entering the data. The "Simulation Time" column will always start with
00:00 homs. For example, if 00: 15 was entered as the fIxed start time, the "Date"
column would read 09Feb1999 0015, but the "Simulation Time" column would read
00:00. Fixed stan times should be entered in military time fOlmat, e.g., "0015" to
start at 15 minutes into a new day. Entering just "15" will result in a stmi time of
1500 homs (HEC). The "Plot Data" button can be used to view either the manually
entered data or the specifIed DSS flle (WEST 05.10.02).
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An additional option listed on the flow hydrograph boundary condition is to make
this boundary a "Critical Boundary Condition." When you select this option, the
program will monitor the inflow hydrograph to see if a change in flow rate from one
time step to the next is exceeded. If the change in flow rate does exceed the user
entered maximum, the program will automatically cut the time step in half until the
change in flow rate does not exceed the user specified maximum. Large changes in
flow can cause instabilities. The use of this feature can help to keep the solution of
the program stable (HEe).
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Entering time-series data into a DSS file is an alternative to entering time-series
data directly into the simulation. By entering the data into the file, it is available for
use in other sinmlations. While DSS has DOS programs to accomplish data entry,
this is the easiest Windows method at this time. The function is a DSS Viewer
Utility. The Write Time Series Data to DSS window provides for data entry of all
the required pathname and header information. Then the data can be entered
directly into the table. Or, if the data are available in a spreadsheet or similar table,
the data can be copied and pasted into the input table (HEC). From the main RAS
project definition window, click the "DSS button", then "Utilities", and "Time
Series Import". Specify the DSS file to write to, the required SS data (example
path name formatting: "/A_PART/B_PART/FLOW/OlAPR1969 '1 HOURJOBS/,,),
and the data values. Then click "Export Time Series to DSS". A pop-up window
will appear to let the User know that the data was successfully written to DSS
(WEST 02.10.02).

••••••••••••••••••••••••••••••••••••••••••••
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• USGS (http://water.usgs.gov)

• Stage and flow hydrographs

• Other federal, state, county, or local agencies

• Computed synthetic floods

• Rainfall-runoff models (e.g., HEC-HMS)

• Peak discharge with assumed time distribution

l'

Unsteady-flow modeling provides a dynamic solution for stage and flow throughout
the river network. The primary boundary data are time-series flow, typically for a
flood event. VVhere do you get that flow data? For most program users, the
simulation will route an upstream flow hydrograph, using a downstream rating
curve or normal depth. The upstream hydrograph can be:

• Historic, like those obtained from the u.s. Geological Survey

• Synthetic, often, prior studies have computed and published synthetic floods like
the Corps' Standard Project (SPF) or the Probable Maximum Flood (PMF).

• Modeling, using rainfall-lUnoff models like the Corps' Hydrologic Modeling
System (HEC-HMS).

• Peak Discharge, and a time to peak estimate, can be used to provide a clUde
hydrograph using the HEC-RAS interpolation routine (Triangle hydrograph). If a
Unit Hydrograph is available, that distribution can be used to develop a flow
hydrograph (HEC).

USGS provides data online at intervals as short as 15 minutes for recent storm
events. Other specific agencies that may have data for your study area include: U.S.
Bureau of Reclamation, Department of Ecology, Water Management and Irrigation
Districts (WEST 11.19.03)

11 Unsteady Boundary Lecture (rev. 7/9/09)
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• Purpose:

12
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Stage and Flow Hydrograph: The stage and flow hydrograph op60n can be used
together as either an upstream or downstream boundary condition. The upstream
stage and flow hvdro!lraph is a mixed boundary condition wh~re the stage
hydrograph is inserted as the upstream boundary until the stage hydrograph runs out
of data; at this point the program automatically switches to using the flow
hydrograph as the boundary condition. The end of the stage data is identified by the
REC-DSS missing data code of "-901.0". This type of boundary condition is
primarily used for forecast models where the stage is observed data up to the time of
forecast, and the flow data is a forecasted hydrograph (REe).

••••••••••••••••••••••••••••••••••••••••••••
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Rating Curve: The rating curve option can be used as a downstream boundary
condition. The user can either read the rating curve from HEC-DSS or enter it by
hand into the editor. The downstream rating curve is a single valued relationship,
and does not reflect a loop in the rating. which may occur during an event This
assumption may cause errors in the "looped" part of the rating curve. The enol'S
become a problem for streams with mild gradients where the slope of the water
surface is not steep enough to dampen the errors over a relatively short distance.
When using a rating curve, make sure that the rating curve is a sufficient distance
downstream of the study area, such that any enol'S introduced by the rating CW\1e do
not affect the study reach CREC).

13 Unsteady Boundary Lecture (rev. 7/9/09)
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Normal Depth: The normal depth option can only be used as a downstream
boundary condition for an open-ended reach. This option uses Manning's equation
to estimate a stage for each computed flow. To use this method, the User is required
to enter a friction slope for the reach in the vicinity of the boundary condition. The
slope of the water surface is often a good estimate of the friction slope. As
recommended with the rating curve option, when applying this type of boundary
condition, you should place it far enough downstream so that any elTors it produces
will not affect the results at the study reach (REC). The User might use the local
bed slope, or a slope estimated from a USGS quad, if the slope of the friction or
water surface are not known (WEST 06.07.02).

WEST

• Enter friction
(energy) slope

• ProO'ram use
Manning's
equation to
compute stage

• Provides serni­
dvnatnic

01

do" nstream
boundary

Cence

IOO()(I.·--Fnc!i.ofl Slop~

I
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• Types:
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• Navigation dams
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• Rules
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The Unsteady Flow Data Editor automatically has the external boundaries defined,
based on the geometric data model. The user can add internal boundary locations to
defme additional lateral flow. Also, when weirs with gates are added, the gate
operation will be defined as an internal boundary (REe).

15 Unsteady Boundary Lecture (rev. 7/9/09)
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Select:

River
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Select the River, Reach and River Station where the data will be added. Then press
Add a Boundary Condition Location. The location is added to the boundary
condition table. Lateral Inflow Hydrograph: This intemal boundary condition
allows the user to bring in flow at a specific point along the stream. Uniform
Lateral Inflow Hydrograph: This internal boundary condition allows the user to
bring in a flow hydrograph and distribute it uniformly along the river reach between
two specified cross sections. Groundwater Interflow: This option allows the
user to identify a reach that will exchange water with a groundwater reservoir
CREC).

16 Unsteady Boundary Lecture (rev. 7/9/09)
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• Flo'w added at a

specific cross section
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external boundaries

Lateral Inflow Hydrograph: This internal boundary condition allows the user to
bring in flow at a specific point along the stream. The user attaches this boundary
condition to the river station of the cross section just upstream of where the lateral
inflow will come in. The actual change in flow will not show up until the next cross
section downstream from this inflow hydrograph. The user can either read the
hydrograph from DSS or enter it by hand (HEC).

17 Unsteady Boundary Lecture (rev. 7/9/09)



18 Unsteady Boundary Lecture (rev. 7/9/09)

Uniform Lateral Inflow Hydrograph: This internal boundary condition allows
the user to bring in a flow hydrograph and distribute it uniformly along the river
reach between two specified cross sections. The hydrograph for this boundary
condition type can be either read from DSS, or entered into a table (HEC).
Specifying inflow distributed uniformly between two adjacent XSECs is identical to
specifying a lateral inflow (at the upstream of the two XSECs). The distribution of
the uniform flow between multiple cross-sections is proportional to the reach length.
Uniform lateral flow cannot span multiple river reaches (WEST 06.17.02).
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Groundwater lnterflow: This option allows the user to identify a reach that will
exchange water with a specified groundwater reservoir head. The head in the
groundwater reservoir is assumed to be independent of the interflow from the river,
and must be entered manually or read from DSS. The groundwater exchange is
similar to a unifOlm lateral inflow in that the user enters an upstream and a
downstream river station, in which the direction of flow is a function of the head
difference. The computed flow is proportional to the head difference between the
river and the groundwater reservoir. The computation of the exchange uses Darcy's
equation. The user is required to enter Darcy's groundwater loss coefficient
(hydraulic conductivity), as well as a time series of heads for the groundwater
aquifer. The groundwater aquifer is assumed to be very large such that the
interchange of water with the river has no impact on groundwater stage (HEC) ,

19 Unsteady Boundary Lecture (rev. 7/9/09)
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Darcy (1856) applied the principles of fluid flow to the flow of water in a permeable
media. Darcy's Law states that the velocity of flow equals the product of a
coefficient times the hydraulic gradient. The flow equals the velocity time· the
effective area = gross area times porosity of the media. (Hydrology for Engineers,
by Linsley, Kohlel~ Paulhus)

• In RAS, the slope is computed as the difference between the water surface
elevation at the cross section and the specified groundwater stage (head), divided by
the user specified distance.

• The area is length times the flow width.

• The length is the channel length for the reach element (between upstream and
downstream River Stations).

• The flow width depends on the groundwater level.

If the groundwater level is below the invert of the channel, the flow is down
from the channel and the width is the average top width.

If the groundwater level is above the invelt, the width is the overbank width
plus the channel depth, estimated by the average channel water elevation
minus the groundwater elevation (HEC).

20 Unsteady Boundary Lecture (rev. 7/9/09)
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Time Series of Gate Openings. This option all ws the user to enter a time series of
gate openings for an inline gated spillway, lateral gated spillway, or a spillway
connecting two storage areas. Elevation Controlled Gate. Define the opening and
closing of gates based on the elevation of the water smface elevation upstream from the
structure (HEC). Gates, and setting the internal boundary condition data, are covered in
more detail in the inline and lateral weir lecture (WEST 02.] 0.02). Navigation Dams.
An internal boundary for optimizing gate control to maintain water smface elevations in
reservoirs, Rules. This option allows the user to control gate operations based on a set
of rules defined by the user. Can control gates by a number of different variables
including stages, flows, time, etc.

21 Unsteady Boundary Lecture (rev. 7/9/09)
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22 Unsteady Boundary Lecture (rev. 7/9/09)

Initial Conditions: In addition to the boundary conditions, the user must establish
the iilltial conditions of the system at the beginning of the unsteady flow simulation.
Initial conditions consist of flow and stage information at each of the cross sections,
as well as elevations for any storage areas defined in the system. Select the "Initial
Conditions" tab to bring up the data editor, shown above. There are two options for
establishing the iilltial conditions. The first option is to enter flow data for each
reach and have the program perform a steady flow backwater run to compute the
corresponding stages at each cross section. This option also requires the user to
enter a starting elevation for any storage areas in the system. Thjs is the most
common method for establishing initial conditions. Typically the initial hydrograph
stage or flow value is entered when tills first option is used. A second method is to
read a file of stages and flows written from a previous run, willch is called a
"restart" file. Tills is often used when running a long simulation that must be
divided into shoner peliods. The output from the first period is used as the iilltial
conditions for the next period and so on. However, RAS uses a dynamic allocation
procedure to overcome the time-dimension limit (HEC).

••••••••••••••••.'•••••••••••••••••••••••••••
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In most applications, the initial condition is a steady-flow water surface profile
throughout the river system. If a constant flow is defmed for each liver reach, that
flow should represent a condition when flows are fairly stable, i.e., a period prior to
the start of the flood. The initial value should be the starting flow in the inflow
hydrograph. You do not want a large change in flow between the initial flow and
the first inflow value. The flows in the river system should be consistent. For a
complex river nenvork, resolve the flow distlibution using steady-flow analysis.
The new option for optimizing the flow distribution could be used to help develop a
consistent flow set CREC).

The Restart file can be saved from a simulation and used to resume another
simulation. This option may be used when the software is having stability problems
at the beginning of a run. Run the model with all the inflow hydrographs set to a
constant flow, and set the downstream boundaries to a high tailwater condition. Run
the model with decreasing tailwater down to a normal stage over time. Once the
tailwater is at a reasonable value for the constant flow, those conditions can be
written out to a restmi file. and then used as the starting conditions CREC). The
User specified initial condition values. and not the data in the boundary condition
files, are used to determine the stage and flow in the warm-up period of an unsteady
flow simulation. Therefore, it is important that these value match or are at least
close to the first boundary condition values in order to maintain model stability
(WEST 05.10.02).

23 Unsteady Boundary Lecture (rev. 7/9/09)
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Observed data can be added to the unsteady flow data set. First select the model
location where the observed data would apply. Select River, Reach, and River
Station and press "Add selected location to table". The location will appear in the
table below. Several locations can be selected. The second step is the selection of
DSS records to read the observed data. The lower half of the windo'w has the
standard DSS file and record selection features. Filters can be selected for
pathname parts to facilitate record selection. A DSS Record should be selected for
each location selected. Remember the time window set for the simulation will be
used to extract the observed data, so be sure there is observed data for the time
window. Observed data can be compared to simulated results for calibration. The
observed data must be in DSS, and paths are associated with cross sections with the
"Observe Data L'1 DSS" dialog. After the connections have been set, the observed
flow anclJor stage data will automatically be plotted with the simulated flow and/or
stage data on the "Flow and Stage Plotter". Observed stages will also appear on the
profile and cross section plots CREC).

24 Unsteady Boundary Lecture (rev. 7/9/09)
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• Steps for creating a stable model 2
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feasible for complex river systems, so HEC­
RAS uses a finite difference scheme

• Finite difference solutions are approximate
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• An unstable numerical model is one for which

certain types of numerical errors gro 7 to an

extent ,"There the solution begins to oscillate, or

the errors become so large that the
computations can not continue
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• Cross section spacing

• Computation time step

• Theta vveighting factor

• Solution tolerances and number of iterations

• Structure and spillwa/ stability factors

• Structure and spillvvay exponential decay
factors
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Samuels, P.G. (1989). "Backwater lengths in rivers", Proceedings -- Institution of Civil
Engineers, Part 2, Research and Theory, 87, 571-582.

Other references that discuss cross-section spacing:

Davidian, 1. (1984). "Computation of water-surface profiles in open channels." USGS
Techniques of Water-Resources Investigations, B,.>ok 3, Chapter A15.
http://water.usgs.gov/pubs/twri/twri3-a15/

Thompson, D.B., and Rogers, T.D. (1993). "Water surface profile computations - how many
sections do I need?" Proc. ASCE Conference on Hydraulic Engineering, San Francisco, CA,
July 25-30, 791-796.

USACE. (1986). "Accuracy of computed water surface profiles." Hydrologic Engineering
Center, RD 26, Davis, CA.
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Where: !.I.X is the cross section spacing distance;
o is the bankfull depth (m); and
So is the bed slope

8

8 Unsteady Stability Lecture (rev. 1/2/07)



••••••••••••••••••••••••••••••••••••••••••••

WEST

-
CON S U II ANT S. INC

\'I\'IW.westconsullants.coTTl

fur < cT,.
20

Where: .0>X is the cross section spacing distance;
c is the wave celerity; and
Tr is minimum rise time of the hydrograph (sec.)

9
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• Bed slope plays an important role in cross
section spacing

• Steeper slopes require n1.ore cross ections

Streanls flo",ring at high velocities may require
cross sections on the order of 100 feet or less

• Larger unifornl rivers 'with flat slopes may only
require cross sections on the order of 1000 ft or
more

Ie

10 Unsteady Stability Lecture (rev. 1/2/07)
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• Use the HEC-RAS cross section interpolation

Make a new plan and run the model

• Compare the before and after

• If no significant difference, then OK!

COf<JSUllAN S.INC
YNI\'. westconsultants cc

WESTo
?.

SpacLng - Ho
av

Cro
u
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• Stability and accuracy can usually be achieved by
selecting a tilue step that satisfies the Courant
Condition:

!J.t
C,. =V" - ::; 1.0

!J..,\
v=Iv +(:'w - I

6.x

V

Where:

sections

v'" = The flood wave speed
\' =Averacre velocin' of the f10\~

c =wave ~:lerin- =- 10]-1 .
. \Ie."

6.x = Distance between cross

Llt = cornputational time step

• HO'wever, you may be able to run with l?rger time steps
• Courant Condition is for explicit models
• RAS unsteady is an implicit model

12

Where: Vw = The flood wave speed, which is nonnally greater than the average velocity

V = Average velocity of the flow

c = wave celerity

6.x = Distance between cross sections

6t = computational time step

Hd = Hydraulic Depth, area/top width

g = gravitational acceleration

12 Unsteady Stability Lecture (re\'. 1/2/07)
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13 Unsteady Stability Lecture (rev. 1/2/07)

vw = Flood Wave Speed

Hd = Hydraulic Depth, area/topwidth

Q = flow rate

A= Flow ar a

g = gravitational acceleration

An approximate flood "vave V 3 V
velocity can be calculated as: W 2

Flood wave velocity:

For large rivers, the flood
wave veloci ty is calculated
more accurately by:

Wave celerity:

Where:

••••••••••••••••••••••••••••••••••••••••••••
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• For meditun to large rivers the Courant condition
Inay yield time steps that are too restrictive

• A larger time step could be used and still ll1.aintain

accuracy and stability

• A practical tin1.e step is = ~ t < T,.
20

T, :;;; tim.e to rise of t.he
t100dwRve

• However, you "rill probably need to use a smaller
time step when you have lateral
structures / spill\\Tays and hydraulic connections
bet,veen storage areas and the river system

A generalmle of thumb is to use a computational interval that is equal to or less than the time of
rise of the floodwave divided by 24 (RAS User's Manual, Vel'. 3, January 2001)

14 Unsteady Stability Lecture (rev. 1/2/07)



6 < M < 40
Typically, M is taken to be 20 (see previous slide)

Where: L'lt is the computational time step;
Tr is minimum rise time of the hydrograph (sec.);
p' is 3.97 (3.13 for SI units);
n is the Manning friction coefficient;
q is the peak flow per unit width; and
So is the bed slope

15
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0.6 to 1.0

• 0.6 = most accurate

• 1.0 = mOST stable

• The default in RAS is 1.0
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finite difference
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Larger values of theta increase numerical diffusion, but, by how much? Experience has shown
that for short period waves that rapidly rise. theta of 1.0 can produce significant errors.
However, these errors can be reduced by using smaller time steps. When choosing theta, one
must balance accuracy and computational robustness. Larger values of theta produce a solution
that is more robust, less prone to blowing up. Smaller values of theta, while more accurate, tend
to cause oscillations in the solution, which are amplified if there are large numbers of internal
boundary conditions CHEe).

16 Unsteady Stability Lecture (rev. 1/2/07)
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Smaller rolerance =
potentially running to the
maximunl nUlTlber of
iterations eery time step

•

• Two solution tolerance can be
edi ted by the user:

WEST

• Wiater surface calculation
(default is 0.02 feet)

• StOrage area cleyation
(default is 0.05 feet)

The default value should be
good for most river systems ­
change them if you are sure!!!

• Larger tolerances =
potentiall: Jess accuracy and
reduction in the stability of
the olution

•••••••••••••'.••••••••••••••••••••••••••••••
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• Derivatives are e tin1.ated

• Equations solved

• Computation nodes
checked for numerical
error

• R.-\S will continue to

iterate jf the error .is
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tOlerances

eThe default number of
iterations is 20

eMore iterations generally
linprove the solution

• Especially true for lateral
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.MaxllnUll1 nunlbcr of warn1 up
time steps

• RA COlnputes results for a
constant inflow before the
simulation be6rlls

• Creates a more stable
solution at the beginning of
the simulation

.\\larm Up time step

• A spt:cific tiOlt: step for the
\varm up period

Time licing

• Time steps can be
automaricaUy changed [or
very steep hydrographs

• Used with the "Time Step
Adjusrment Options' in the
Un tcad,' Flo\\' EditOr

Maximum number of warm-up time steps: Before the dynamic simulation. the program runs
a series of time steps with constant inflows. This is called a wann up period. This is done in
order to smooth the profile before allowing the inflow hydrographs to progress. This helps to
make a more stable solution at the beginning of the simulation. The default number of warm up
time steps is set to 20. This value ranges from 0 to 40. Time step during warm up period:
During the wann up period described in the previously, it is sometimes necessary to use a
smaller time step than what will be used during the unsteady flow calculations. The initial
conditions from the backwater analysis uses a flow distribution in the reaches which is often
different than that computed by unsteady flow. TI1is can cause some instabilities at the
beginning of the simulation. The use of a smaller time step dwing the warm up period helps to
get through these instabilities, The default is to leave this field blank, which means to use a
time step that is the same as for the unsteady flow simulation period. Minimum time step for
time slicing: The program has an option to interpolate between time steps when it fmds a very
steep rise in an inflow hydrograph, or a rapid change in stage at any cross section. This option
allows the user to set a minimum time step to use during interpolati')n. This prevents the
program from using to small of a time step during time slicing. Maximum number of time
slices: This option defmes the maximum number of interpolated time steps that the program
can use during time slicing. as desclibed in the previous paragraph (RAS User's Manual, Vel'. 3,
January 2001, p. 8-23).

••••••••••••••••••••••••••••••••••••••••••••
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eLateral and Inline StruCnlres can
often be a source of instabiljty in the
solution

eDuring each time step, tb<: flow
over a slrucrurc/sp.illway is as ull"led
to be constant

• 3.0 =\casl accurate =more.: stable 20

Structure flow stability factor: This factor is used to increase the stability of the numerical
solution in and around a structure. The factor varies from 1.0 to 3.0. As the value is increased,
the solution is more stable but less accurate. A value of 1.0 is the most accurate. but is
susceptible to oscillation in the computed structure flow. (RAS User's Manual, Ver. 3.0,
January 2001, p. 8-24)

20 Unsteady Stability Lecture (rev. 1/2/07)



When you have a structure or spillway connecting two storage areas, or a storage area and a
reach, oscillations can occur when the structure or spillway becomes higWy submerged. The
program must always have flow going one way or the other when the water surface is above the
structure/spillway. When a stmcture/spillway is higWy submerged, the amount of flow can vary
greatly with mall changes in stage ~1 one side or the other. This is due to the fact that the
submergence curves, which are used 0 reduce the flow as it becomes more submerged, are very
steep in the range of 95 to 100 percent submergence. The net effect of this is that you can get
oscillations in the flow and stage hydrograph when you get to very high submergence levels.
The program will calculate a flow in one direction at one time step, that flow may increase the
stage on the receiving side of the structure, so the next time step it sends flow in the other
direction. This type of oscillation is ok if it is small in magnitude. However, if the oscillations
grow, they can cause the program to go unstable (March 2002 Course Lecture otes).
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Steep curve in discharge

reduction (m 95"/u w 100%
submer"encc ratio)

FJol;\' in RAS mUSl be greater
than zero Over " subrrlel'ged
structure

Range =1.0 to 3.0

1.0 =no effect

•

•

•

• 3.0 =greatest dampening
•

-For highly submerged tructures

-Oscillation. from large flO'y
change are caused by the
combination of:

- The decay faerors dampen the flow
ae 0 . the structure

••••••••••••••••••••••••••••••••••••••••••••
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To reduce the oscillations, the user can increase the Structure/Spillway Submergence Factor.
This factor can vary from 1.0 to 3.0. A factor of 1.0 leaves the submergence criteria in its
original form. Using a factor greater than one causes the program to use larger submergence
factors earlier, and makes the submergence curve less steep at high degrees of submergence. A
plot of the submergence curves for various factors is shown in the figure above (HEC March
2002 Lecture Notes). The theory from the "normal" curve (for a factor of 1) is based on
"Hydraulics of Bridge Waterways" (Bradley, 1978) as discussed in Chapter 5, Modeling
Bridges, of the RAS Technical Reference. Using a factor other than 1 can improve stability but
diverges from the original theory (WEST 06.10.02).
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Too large of a time step: When the solution scheme solves the unsteady flow equations, derivatives are
calculated with respect to distance and time. If the changes in hydraulic properties at a given cross section are
changing rapidly with respect to time, the program will go unstable. The solution to this problem is to decrease the
time step. Not en 'ugh cross sections: When cross sections are spaced far apart, and the changes in hydraulic
properties are great, the solution can become unstable. Model goes to critical depth: If the program goes down to
critical depth at a cross section, the changes in area, depth, and velocity are very high. This sharp increase in the
water surface slope will often cause the program to overestimate the depth at the next cross section upstream, and
possible underestimate the depth at the next cross section downstream (or even the one that went to critical depth
the previous time step). One temporary solution to this problem is to increase the Manning's n value in the area
where the program is first going to critical depth. This will force the solution to a subcritical answer and allow it to
continue with the run. (For Beta Version 3.1: The default solution method for unsteady flow routing within BEe­
RAS is generally for subcritcal flow. The software does have an option to run in a mixed flow regime mode.
However, this option should not be used unless you truly believe you have a mixed flow regime river system). Bad
downstream boundary condition: If the user entered downstream boundary condition causes abrupt jumps in the
water surface, or water surface elevations that are too low (approaching or going below critical depth), this can
cause oscillations in the solution that may lead to it going unstable and stopping. Examples of this are rating curves
with not enough points or just simply stages that are too low; and norn1al depth boundaries where the user has
entered too steep of a slope. Bad cross section properties: All of the cross sections get converted to tables of
hydraulic properties (elevation versus area, conveyance. and storage). If the curves that represent these hydraulic
properties have abrupt changes with small changes in elevation, this can also lead to instability problems. This
situation is commonly caused by: levees being overtopped with large areas behind them (since the model is one
dimensional, it assumes that the water surface is the same all the way across the entire cross section); and
ineffective flow areas with large amounts of storage areas that are turned on at one elevation. and then tum off at a
slightly higher elevation (this makes the entire area now used as active conveyance area). There are many possible
solutions to these problems, but the basic solution is to not allow the hydraulic properties of a cross section to
change so abruptly. If you have a levee with are large amount of area behind it, model the area behind the levee
separately from the eros section. This can be done with either a storage area or another routing reach. whichever
is most hydraulically correct for the flow going over the levee or if the levee breaches. With large ineffective flow
areas, the possible solutions are to model them as being pennanently on, or to put very high Manning's n values in
the ineffective zones (BEe March 2002 Lecture otes).

• Abrupt changes in do\:\rnstream boundary
condition
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s

• Too large of a time step

• Not enough cross sections

• Model goes to critical depth

• Use the mixed flo-w feature

• Ill-defined rating curve

• Steep lope for normal depth

• Abrupt changes in cross section properties

• Revise levee or ineffective flo~r definition

••••••••••••••••••••••••••••••••••••••••••••



Common Sta i ity
robl ms {Contjnue ,D

WEST

CON S U l TAN T S. INC
\WNI weslconsullan corn

• III defined hydraulic properties tables

• Eleyation not high enough

• Not enough definition

• Abrupt transitions in bridge/culvert family of
ratina curveso

• Wide and flat lateral structures/spill'ways

• Too much flO'w overtopping flo,v in a time step.

• Gated spilhvays opening/closing too quickly

• Large influx of ",rater to a shallo,,! depth channel

Cross section property tables that do not go high enough: The program creates tables of elevation versus area, conveyance, and storage area for
each of the cross sections. These tables are used during the unsteady flow solution to make the calculations much faster. By default, tile program
will create tables iliat extend up to the highest point in the cross section, however the user can override this and specify their own table properties
(increment and number of points). If during the solution tile water surface goes above the highest elevation in the table. the program simply
extrapolates the hydraulic properties from the last two pomts in tbe table. This can lead to bad water sW'face elevations 01' even instabilities in the
solution. Not enough definition in cross section property tables: The counter problem to the previous paragraph is wben tbe cross section
properties in a given table are spread too far apart, and do not adequately define the changes in the hydraulic properties. Because the program uses
straight-line interpolation between tbe points, tJtis can lead to inaccW'ate solutions or even instabilities. To reduce this problem, we have increased
tile allowable number of points in the tables to 100. Bad Bridge/Culvert Family of rating curves: The program creatcs a family of rating cW'ves to

define all the possible headwater. tail water, and tlow combinations that can occur at a particular structure. The user can control how many submerged
curves get calculated (default = 40), how many points in each curve (default = 10), and the properties used to define the limits of the curves
(maximwn headwater, maximum tail water, maximum flow, and maximum head difference). By default, the software will take the curves up to an
elevation equal to'the highest point in the cross section just upstream of the structure. This may lead to curves that are too spread out and go up to a
flow rate that is way beyond anything realistic for that structure. These type of problems can be reduced by putting in specific table limits for
maximum headwater, tailwater, flow, and head difference. Wide and flat Lateral structures/Spillways: during the computations there will be a
point at which for one time step no flow is going over the lateral structure, and then the very next time step there is. If the water surface is rising
rapidly, and the structure is wide and flat, the first time the water surface goes above the structure could result in a very large flow being computed
(i.e. it does not take a large depth above the strucrure to produce are large flow if it is very wide and flat). This can result in a great decrease in stage
from the main river, which in tum causes the solution to oscillate and possible go unstable. This is also a common problem when having large 'flat
structw'es between storage areas. The solution to this problem is to use smaller computational tinle steps, and/or structure/spillway stability factors.
Opening gated spiJJways to quickly: When you have a gated structure in the system. and you open it quickly, if the flow coming out of that
structure is a significant percentage of the flow in the receiving body of water, then the resulting stage. area and velocity will increase very quickly.
ThiS abrupt change in the hydraulic properties can lead to instabilities in the solution. To solve tilis problem you should use smaller computational
lime steps, or open the gate a littler slower, or both ifnecessary. Vel'." shallow depths of water: When staJting a simulation it is very common to
staJt the system at low flows. If you have some cross sections that are fairly wide, the depth will be velY small. As flow begins to come into the
river, the water surface will change quickly. The leading edge of tile flood wave will have a very steep slope. Sometimes this steep slope will cause
the solution to reduce the depth even brUler downstreaJlJ of the rise in the watcr surface, possible even producing a negati ve depth. This is do to the
fact that the steep slope gets projected LO the next cross section downstTeam when nying to solve for its water sUlface. The best solution to this
problem is to use what is called a pilO1 channeL A pilot channel is a small slot at the bonom of the cross section, which gives the cross section"
greater depili, without adding much flow area. This allows the program to compute shallow depths on the leading edge of the flood wave without
going unstable. Another solution to this problem is to use a larger base flow at the beginmng of the simulation (HEe March 2002 Lecture Notes).

24 Unsteady Stability Lecture (rev. 1/2/07)
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• How do you know you have a stability problem?

• Program completely blovv up during run

• Program goes to maximum number of iterations
for several time steps in a ro"

.. This does not always indicate stability problems

• Progratll has oscillations in the cOlllputed stage

and/or flo"r hydrographs

••••••••••••••••••••••••••••••••••••••••••••

25

WEST

25

Unsteady Stability Lecture (rev. 1/2/07)



;,defltifyin.
Probllem's

WEST

CON S U l TAN T S. INC
W\Wl we~lcon:;uhant':t.com

• Note the simulation tinle when the program
either bIe,v up or first started to oscillate

• Turn on the "Detailed Output for Debugging"
option and re-fun the program

• VieV\T the text file that contains the detailed log
output of the COluputations

• Locate the siluuIation output at the simulation
time V\Then the solution first started to go bad

• Find the river station locations that did not
meet the solution tolerances

• Check the data in this general area

26
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As shown in above, the section at the bottom half of this editor is used for controlling the
Detailed Log Output. Three check boxes are listed. The first box can be used to tum on an
echo of the hydrograph input to the model. This can be used to ensure that the model is
receiving the correct flow data. The seco d check box can be used to tum on an echo of the
computed hydrographs that will be written to the HEC-DSS. This is a good option for checking
what was computed. However, if the user has selected to have hydrographs computed at many
locations, this could end up taking a lot of file and disk space. The third check box is used to
control the detailed output of results from the unsteady flow simulation. Selecting this options
will cause the software to write detailed information on a time-step-by-time-step basis. This
option is useful when the unsteady flow simulation becomes unstable or will not converge on a
solution. Checking this box turns on the detailed output for every time step. The user has the
option to limit this output to a specific time window during the unsteady flow simulation.
Limiting the log output is accomplished by entering a starting date and time and an ending date
and time CHEC March 2002 Lecture Notes).
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Viewing Detailed Log Output: After the user has turned on the detailed log output option, re­
run the unsteady flow simulation. The user can then view the detailed log output by selecting
View Computational Log File from the Options menu of the Unsteady flow simulation
window. When this option is selected, the detailed log output file will be loaded into the default
text file viewer for your machine (nOlmally the NotePad.exe program, unless you have changed
this option within HEC-RAS) (HEC March 2002 Lecture Notes).
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= River station with the larges error in the calculated stage. River Stationing is by a code: reach numher+ "S,· + river stationing
(example: IS5.000 = reach I, river station 5.000)

= Computed water surfac,' elevation at that river station

= The "Numerical Error" in the computed stage at that location

= River station with the largest elTor in the calculation of Dow

= Computed flow

= The "Nwnerical Error" in the computed flow at the listed river station

= Nwnber code for a storage area.

= Computed elevation of the storage area

= The "Numerical Error" in the computed storage area elevation.

The key to the column headers is presented below:

Iter = Iteration Nwnber

The program lists the computed initial conditions from a backwater calculation for each of the river/reaches. They are listed in the order they
were computed during the backwater analysis which is downstream to upstreatn.

Station

ELEV

DZ

SUltion

Q

DQ

Cell #

Zsa

Dzsa

••••••••••••••••••••••••••••••••••••••••••••



( ..w.... ,. i ,'''.1: ".af· • ·<;;r',':,.:

WEST

CON S U II ANI S. , N C
"/','oV. \>vesIG005ullant"Sco ,

So:; v ...... f r - • .: "'•.

.,

r .. ••
''''jl,.J, f, V""

• ••• '•• .1 9t.:n·f _~(;~
J' -,.. t ,or ..
.". ,,':;<,;:;J:;.. c .... #!> ~ .

':.I.('t('~" e4)~:· rM
",. ".JV':~ ::'!',. C- :~'. C
~. ~ 4,;,' !\ ... .4". r,.,
~. ~ ..~.;. 1:", ......
I..' I~,.",t"

• •••• J~ t'",~"'(' :"t;""
• I.' .j(. e~..vl'- """f
C/. I,; ..... ~ :';~(!. o( 'r~ ~

v.~ ",;;'~"J <l!'~VW :-·'!t·

;~: -­
;\,1:
• 0 .•• ~

~f'!'" "
.:~ -:~
'0 •,
;." :.­

:\1'.C"' ..,
L .~_

'<T •
..1- ~_., ,
".T ~.

<"10 ~.

~- ,.
· "· ..

.1 ~_· ..
.,;~ ('I •

,1 I 4 ...
"!.1 , ...

-',,'

...:'

. "C.
;'".:,

i. II.
6.(;.iH''1 '1"1;
i. ~·c.\dt-" ':"';","

~ :..~~_. ~~~:- ~ ':"~:;-

......,; '9
'_ .t.:.t:

. t. r () .~rr) " .. r" ... ' (
J.. '.':' :1., •.

''":'1.'
..U:·.... ••
"'t:t-.J>.'
:.!~. tI

.. ,
1.. •• "

jl. ,"r
1 9~

:"'J .. ~:
• 9 ,.
j'="'·I,".::.(....

~ ..

,.

~ ....
\.,..

.~. ,.,

,..... :IOti ~ ," -lfL 14tt', .N, f
If'CI'< •.• W 2:....:: ...

I.;.t.fj!'. "·-H' 14'~ olCl:)V<t t!"f' ':1" c; .. ~f1'·ni1l·-l, \.:>1".' .'!.
t .. ' 1i • .1 ~.ln' ~. _. .

,;. t_ ~.,

p. ..~..... ...~,

f1,,~"C" ... ri:e·"*'• .;r.,.,.
!'l .... ~ 'i! \

.. til' 1M (rr-t"
6-t'tV... • <:rllo(
V~.I.ff"· ~r.·"·

llt;>·J..... • ~," ,
[..... vr··· ,:·,..1

1 1 ~:"~: ?~;~;I

1 t~ ~~:,,~. ~: ~~I

30
..!......_----~

If the program goes to the maximum number of iterations, it will choose the iteration that had
the minimum amount of enol', and then go to the next time step.

Note: do a search for the word "\Varning" to quickly get to the area of potential problems.
CREC)
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• Use steps suggested for creating a stable model
• Verify that HTab values are not exceeded
• Consider adding a pilot channel for reache with low flo\v

Problem 'with lateral structures?
• Initially raise structure elevation above the Inaxin1um peak

stalYe
~

• Lower de rations until the root of the problem is identified

• ProblelTIS v.rith bridges?
• Verify smooth transitions in the rating curve tables

• Temporarily change default minimum structure flo\.y and
maximum lo\\' cord ele ations to help identify the problem

• You ma) have to start \vith a "flooded" s.:sten1, then
lowering the stage to the initial conditions for your
lTIodeling scenario

••••••••••••••••••••••••••••••••••••••••••••
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• umerical sensitivity:

COil1putation time step

.. Do results change significantly \J\ith a smaller
value?

• Theta
.. Reduce towards 0.6

• Structure / spillway stability factors

.. Reduce towards 1.0

• Structure/spill'way exponential decay factors

.. Reduce towards 1.0

32

Computational Time Step - The user should try a smaller time step to see if the results change
significantly. If the results do change significantly, then the original time step is probably too
large to solve the problem accmately. Theta Weighting Factor - The default value for this
factor is 1.0, which provides the greatest amount of stability for the solution, but may reduce the
accuracy. After the user has a working model, this factor should be reduced towards 0.6 to see
if the results change. If the results do change, then the new value should be used, as long as the
model stays stable. Be aware that using a value of 0.6 gives the greatest accuracy in the
solution of the equations, but it may open the solution up to stability problems.
Structure/Spillway Stability Factors - If you are using these factors to maintain stability, try

to reduce them to the lowest value you can and still maintain stability. The default value is 1.0,
which is no stability damping. Structure/Spillway Submergence Exponents - In general
these parameters will not affect the answers significantly, they only provide greater stability
when a spillway/structure as at a very high submergence. Try reducing them towards 1.0
(which is no factor) to see if the model will remain stable. (HEC)
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• Physical paralneter sensitivit) :
Manning's n values
~ +10%

Cross section spacing
~ T est by interpolating

Cro s section storage
~ Adjust ineffective flow areas

• Structure/spilhvay coefficients
~ Lateral structures / spillway coefficients can have a

great impact

Bridge/ culvert parameters
~ onnaUy only effect the locally computed stages,

unless it i. a flat area in which the bridge cau es
great backv.'ater

••••••••••••••••••••••••••••••••••••••••••••
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1. Starr simple

• Create the main stem reach

fling at
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• Leave out structures (e.g.,
bridges, lateral structures, etc.)

• Run in unsteadv mode "vith a
constant inflow hydrograph

• Not running?

~ Check your initial flow
distribution

~ ~t\re E T ab values exceeded?
Add stelkdy

flow to
boufldary

nydrog.raph
if flecessary

Using the initial unsteady flow value as for your steady flow will not only help to create an
initial stable model, but it also will assist in determining the initial flow values. Iterate on initial
stage values if trouble exists solving for the initial solution - compare to the computed initial
values in the results table or log files.
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• Fix HTab, ineffective flow area, or structure (Teometry
problems

• Ensure the tTIodeJ run successfuUy after each structure
35

is added

May need to run the model with a ranae of '(steady"

unsteady flow file , or a gradual linearly increasing

hydrograph, to identify problem location

Svstematically include structures
J •

• Side channels, tributaries, etc.

Include the unsteady flow data

• Fix HTab, ineffective flow, or o-eometry problem

Are there in tabiJiries in vour boundary condition data?. .
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or re !tin t
ad I (Continued)

Add in anv additional reaches

3.

2.

4.
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a ded in HEC..RAS 4.1.
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This lecture was initially written by Brian WaWin, Ph.D., P.E., D.\VRE of \VEST
Consultants, Inc. in September, 2010. Further contributions have been made to this
lecture by the staff of WEST Consultants.
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Yersion 3.0.1 (released larch 2001)
• .nsteau) Oow
• Lateral sU"uClLlrc~ (e.g.. Ie' ces)

Version 3.1 (released ;ovemher 2002)
• 1Jnstead~ encroach men!

'HYigHtion danls

• Structurcs
~ Pump slations
~ Dam break/level' breach

Version 3.1.1 (released M:lY 2003), Version 3.1.2. (April 2004) and 'crsiron
3.1.3 (released Ma\' 2005)

Bug fixe'
Version 4.0.0 (beta released December 2006)

ScdimcOltrallsport
• Sediment Impacl Anal~ sis Icthods (SIAM)

• Tempermure modeling
Pressurized pipe Om\"

•

•

•

•

••••••••••••••••••••••••••••••••••••••••••••



Re ease History

• Version 4.0.0 (released Ivlarch 2008)

• Channel desi:,rn/mod.ification 1001~

• Added gale t"pes

- o\"erfJo\\ gates \\) closc-d or open top

• liser defined rules for cuntrolling gale operations

• Added lateral SlruCltlrC funclionalil\'

• Geo-referencing lools

• Addi.lional graphical outputs

• ShOrtCul keys [() graphics

• Pump slation override rules

• Hager's lateral wcir equation

• Csers manual ,mel help 5\'stem

• Version 4.1.0 (released January 2010)

WEST
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-Channel Design/Mod tools - Available in the tools menu of the Geometric Data Editor. Allows user
to make trapezoidal cuts in existing geometry or create new geometry.

-New Gate types - Overflow gates with open or closed top, also allows user to define a curve to
represent the gate.

-Gate Operation Rules - The user can define current flows, water surfaces, and stages at and near
structures and the time of day and time of year.

-Lateral structure functionality - The user can set flow to be distributed across multiple cross­
sections along a lateral weir and can set spacing between cross sections on the weir.

-Geo-referencing - Found in the GIS tools menu. Allows the user to edit x and y coordinates in table
format.

-Graphical outputs - For sediment transport. SIAM analyses, and water quality computations. Also
allows the user to view unsteady flow output at the computation interval level.

-Shortcut keys - In graphic window hold "shift" to pan and "ctr!" for a measuring tool.

-Pump station. The user can tum pumps on and off based on time of day and target flows and stages.
Rules can also be set to override pumps max and min flow capacity.

-Hagar' equation - Weir discharge coefficient is computed automatically based on physical and
hydraulic propel1ies.

-Users Manual - Completely updated for version 4.0 including new chapters. New help system uses
manuals PDF file.

3 New Features Lecture (rev. 7/8/09)
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• . pdated text and graphics

• Greatly e:>"'Panded

• User' Manual

• Hydraulic Reference Manual

• Applications Guide

• Accessible via the "Help"

item.
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Bug Fixes

• 50 bug fixes in 4.1

• 60 bug fIXes in 4.0 beta
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Problem 'with unsteady flow v.rith steep slope and

shallow flow.

Energy method navY an option.
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• Normal combining jLillction

• All cross-sections bounding junction are given same
,vater surface elevation

• Normal split flow junction

• \X/ater surface elevations are based on the computed
values upstream of junction

• Problen~s

• Cross-sections need to be close to junction

• Dependent on slope

7 New Features Lecture (rev. 7/8/09)
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WEST

• Medium to steep stream

• Long spacing bet\vecn cross-section and junction

• Energy balance acros the junction

Useful

New Energy Balance Method

• \X/ater surfaces elevation are not forced to be the
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·HydrQ~log.ic

Reaches
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• Steep, shallow reaches seern
to often cause problems

• Hydrologic Routing Reach
• Modified PuIs Hydrologic

routing technique
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• Use hydrologic routing techniques instead of
unsteady flo\/i' equations

• Modified PuIs routing

• Ignored in steady-state m.odels

••••••••••••••••••••••••••••••••••••••••••••

Hy ro oie outing
-eaches
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WESTN~ Un$teady Fl:, :41ti an·
Boundary Condo :~ans Ed"tar

... I. ,_" ..
• Editors modified to be

more flexible

• Attach Inore than one
inflO'\v hydrograph to a
storage area

• Changes
• Be' ndary conditions

tab

• How boundary

conditions locations

are established

-=-- - I
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Contra i' n i saQ
for Un-steady FI w

Generally not used in
unsteady flow

• MomenturD eguarj.on solves

for losses

• Sometimes not adequate

• Can use contraction /
expansion loss coefficients

to better describe forces

• Loss converted to a force

and added to nlomentunl

equation

12
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• 1\1inor losses due to bends,
junctions, etc.

• Loss coefficient K . \

• Steady flow

• :Minor los added to the

eneq,~' equanon

• Unste~ldy flow

• Minor loss converted to

forced and added to

momentum equation
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EL 120
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• River reaches

WEST

• O\,y can be applied to storage areas

• Groundwater can enter storage area

• Surface water can leave storage area

• Darcy's equation

• Groundwater Interflow

••••••••••••••••••••••••••••••••••••••••••••



W ter rty lVI'oae
hancements
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• on-uniform channel geOlnetry

• Steep drop

• Can lead to discontinuity and instabilities

• Dispersion coefficients

• Individual v,'ater quality cell

• Each time step

• Function of velocity and channel geometry

15 New Features Lecture (rev. 7/8/09)



16 New Features Lecture (rev. 7/8/09)

• upports reverse flow

• Constant teluperature option

• Overrides energy budget

• Still need to enter all parameters needed for
eneroy budO'er

b_ b

COUSQlIAf.JI:'.INC
'1.~JW(!"5:cansJJ'l.arr.5tltXT'

WESTode· "ng
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ancem ts
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• Calibration parameters for transport equations

• Wong and Parker correction to the MPM
equation

• Pass through nodes

• 100% of sediment that enters nodes passe
through

• TO aggradation or degradation

17 New Features Lecture (rev. 7/8/09)
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• Settling depth parameter
can be edited by grain size

Fractions were previously
hard 'wired

• Could result in unrealistic
settle depths
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M· _nniJng"sn Vatue
C·ompositing
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• The user can change the Compositing Slope
Criteria.

.-;~...e a-tlC.~"lf'4hH1t''''''''·$r'lV~·

Comoo"-<l9 SIo:>o 0 ..... .,- H 1 V

• Or a nser can choose not to autOInatically
composite the I\1anni11.g's 11. values in a channel.

19 New Features Lecture (rev. 7/8/09)
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Runt"rme Messag sVie
File

CG3
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Runtime Ca,mputational
Options
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• During computations, disregard:

• Lateral Structures

• Storage Area Connections

• Breaches

• Pump Stations

• Great way to isolate problem

areas.

In the Runtime Computational Options, you have the option to "disregard" Lateral
Structures, Storage Area Connections, Breaches, and Pumps in the
computations. Let's say you turn offlateral structures, rerun your model and it runs
fine.

Then you know that there is a problem with one or more of your lateral
structures. Simple diagnosing tool-but very effective.
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• Short Cut Keys

• Shift key - graphic windo ~

~ Mouse pointer changes ro "hand" for panning
mode

• Control key - graphic window

~ Changes to measuring tOol

.. Can create line or polygon

.. 'when released displays x, y distance uave1ed, slope
of line or bounding box

,. x and y coordinates sent to clipbomd

New Features Lecture (rev. 7/8/09)
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S pper

RAS Mapper
allows the user to
take steady and
unsteady flo\-"
resuIts and map
the floodplains
directly in the
HEC-RAS
enVlron.nJent

.-
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RAS Mapper

• With the terrain mode] in
floating poim grid format
(* .flt) the user can create
a floodplain and
associated depth layers.

• GIS is still required to
create a g-eometr:-' file,
but the user is no longer
required to go through
the PostRAS procedure
in GeoRAS

25
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OpenMI (short for Open Model Integration Environment) is a data and model
integration framework. The primary objective is to take otherwise independent data
and computing systems, for example a database storing rainfall time series, a
rainfall-runoff model, and a river hydraulics model, and provide a standard means
for describing how time series are communicated between the systems. OpenMI
was developed by RaromIT, which consists of a number European environmental
software companies and university researchers. Software companies like DRI are
working to make their models "OpenMI-compliant", thereby allowing
environmental modelers the ability to couple different DRI models into modeling
frameworks.

• Enhance RAS Mapper capabilities

• Cut n10dels inside Geometric Editor

COtl$UI'ANTS INC
Y,">/oW "''e'SXonsu:tan:.,. .oom

WEST

CG7

ext?a~s

• Integrate RAS and MODFLO\x

.OpenMI

• Automated roughne s calibration

• Spreading n'lodel

• Currently using FLO-2D

• 'Write own code in the future

••••••••••••••••••••••••••••••••••••••••••••



WEST

......". HEC-RAS, River
CON 5UL1,..N TS,INC.

www,westconsultants.com

Analysis System
By WEST Consultants, Inc.

Basic Input

Data Requirements

Note: This lecture is based upon Chapter 3 of
This document is property of WEST
Consultants, Inc., and is not to be

the HEC-RAS Hydraulic Reference Manual duplicated without prior consent.
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Overview

• General

• Geometric Data

• Ground Points

• Additional Data

• Optional Cross-section Data

• Junctions

• Steady Flow Data

WEST

~,
CONSULTANTS,INC.

WNW.weslconsultanls,com
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Geometric data are required

HEC-RAS can perform both steady and unsteady flow computations

Only steady flow will be discussed in this section
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• Overview: This lecture describes the basic data requirements for
performing the one-dimensional flow calculations within HEC-RAS

• Main objective of HEC-RAS: Compute water surface elevations at all
locations of interest for given flow values

• Data needed for computations:
1. Geometric data
2. Flow data

• HEC-RAS can perform both steady and unsteady flow computations;
however, only steady flow is discussed in this class

WEST

CONIULfANTI,INC.

WNW,westcofllultants.com
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General

Overview: This lecture describes the basic data requirements for performing
the one-dimensional flow calculations within HEC-RAS

Main objective of HEC-RAS: Compute water surface elevations at all locations
of interest for given flow values

Data needed for computations:

Geometric data

Flow data

Basic Input (rev. 4/04)
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Geometric Data

• Discussed in this lecture:

• The River System Schematic

• Cross Section Geometry

• Optional Cross Section Properties

• Reach Lengths

• Energy Loss Coefficients

• Stream Junction Data

WEST.,
CONSUtTANT$,INC.

WNW,westconsultants.com

• Hydraulic structure data (bridges, culverts, etc.), which are also
considered geometric data, will be described in later lectures

Discussed in this lecture:

The River System Schematic

Cross Section Geometry

Optional Cross Section Properties

Reach Lengths

Energy Loss Coefficients

Stream Junction Data

Hydraulic structure data (bridges, culverts, etc.), which are also considered
geometric data, will be described in later lectures

Basic Input (rev. 4/04) 4



General

The river system schematic is required for any geometric data set and must be
developed before any other geometric data can be entered.

The schematic defines how the various river reaches are connected and
establishes a naming convention for referencing all the other data.

The river system schematic is developed by drawing and connecting the
various reaches of the system within the geometric data editor.

You can interact with the river schematic by zooming in and out, adding
background pictures, etc.

• The river system schematic must be developed before any other
data can be entered

• Defines how the river reaches are connected and establishes a
naming convention for all the other data

• Developed by drawing and connecting the reaches of the
system within the geometric data editor

• You can interact with the schematic by using the viewing options
available

• Includes zooming in/out, displaying river stationing,
background pictures, etc.

CO N'U L lA NTL INC.

WNW.Westconsultants.com

WEST
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The River System Schematic

Basic Input (rev. 4/04)
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The River System Schematic
WEST
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www.westconsultants.com

River System and Reach Identifier and Location

•
•

•

•
•
•

A river can be comprised of one or more
reaches.

Each river and reach is given a unique
identifier

Other data (e.g., cross sections, bridges) are
referenced to a specific reach

• Each cross section is assigned to a "river"
and "reach" identifier:
River ="Fall River"
Reach = "Upstream"
River station = "9.9"

Reaches are drawn upstream to downstream
and assumed to be the positive flow direction

Start or end at open ends of the river system or
where two or more reaches join or split

Reaches must have at least two points; the
start and the end. Typically drawn with several
points that follow the thalweg

River System and Reach Identifier and Location

Each river and reach on the schematic is given a unique identifier

Examples: River
"Fall River"
"Fall River"

"Butte Cr"

Other data (e.g., cross-sections, bridges) are referenced to a specific reach of the schematic

For example, each cross section is assigned to a "river" and "reach" identifier:

River = "Fall River"

Reach ="Upstream"

River station = "9.9"

Reaches are drawn upstream to downstream which is assumed to be the positive flow direction

A river can be comprised of one or more reaches.

"Upstream"
"Downstream"

"Butte Cr"

Reaches start or end at open ends of the river system being modeled or at loc ations where two or more streams join
together or split apart

Reaches are drawn as multi-segmented lines and must have at least two points, defining the start and end of the
reach.

They are typically drawn with several points that follow the main channel alignment (thalweg).

Basic Input (rev. 4/04) 6



Adding Tributaries into an Existing Reach

• A tributary is defined as a segment of the river entering or leaving a
main stem and contains cross sections

• Locations where water enters or leaves a mainstem, but is not
modeled, is defined as local inflows or outflows

• To add a tributary to the middle of an existing reach, draw the new
reach and connect it graphically to the existing reach at the location of
the new junction

• Enter a River and Reach identifier for the new reach at the prompt

• Verify if you want to "Split" the existing reach into two reaches

• If "yes", enter a Reach identifier for the lower portion of the
existing reach and a Junction name for the new stream junction

WEST

CON'ULTANT&.INC.

lNW'N.westconsultants.com
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The River System Schematic

Adding Tributaries into an Existing Reach

In these lectures, a tributary (or distributary) is defined as a segment of the
river entering or leaving a main stem and contains cross sections

Locations where water enters or leaves a mainstem, but is not modeled, will
be defined as local inflows or outflows

To add a tributary (or distributary) to the middle of an existing reach, draw the
new reach and connect it graphically to the existing reach at the location of the
new junction

The User is then prompted to enter a River and Reach identifier for the new
reach

The User then verifies if they want to "Split" the existing reach into two reaches

If "yes", then the User is prompted to enter a Reach identifier for the
lower portion of the existing reach and a Junction name for the newly
formed stream junction

Basic Input (rev. 4/04)
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The River System Schematic
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•
• The connection of reaches are

considered junctions.

• Junctions should not be
established with a single reach
flowing into another single
reach. These two reaches
should be combined and
defined as one reach.

Junctions

Junctions

The connection of reaches are considered junctions.

Junctions should not be established with a single reach flowing into another
single reach. These two reaches should be combined and defined as one
reach.

An example river system schematic

Basic Input (rev. 4/04) 8



Arrows are automatically drawn on the schematic in the assumed positive flow
direction

Junctions are automatically formed as reaches are connected

A "network" model is where river reaches split apart and then comes back
together, forming looped systems

WEST
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WNW.westconsuhants.com
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The River System Schematic

• Arrows are automatically drawn .d.QJ29

on the schematic in the
assumed positive flow direction
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Optimization of Steady Flow
Distributions

WEST
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• HEC-RAS has the capability to optimizing flow splits in steady
flow mode at:

• Lateral structures (levees)

• Hydraulic connections

• Storage areas

• Stream junctions

• In the "Steady Flow Analysis" window, click "Options" on the tool
bar menu, and then "Split Flow Optimizations"

10

HEC-RAS has the capability to optimizing flow splits in steady flow mode at:

Lateral structures (levees)

Hydraulic connections

Storage areas

Stream junctions

In the "Steady Flow Analysis" window, click "Options" on the tool bar
menu, and then "Split Flow Optimizations"

Basic Input (rev. 4/04) 10



The River Station identifier may correspond to stationing along the channel, in
river miles, feet, or any fictitious numbering system.

The numbering system must be consistent; i.e., the program assumes that
higher numbers are upstream and lower ones are downstream within a reach.

Geometry for the analysis of flow in natural streams is specified in terms
of ground surface profiles (cross sections) and the measured distances
between them (reach lengths).

WEST
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Ground Points

• Layout and Numbering of
Cross Sections

• Geometry includes
cross sections, cross
section parameters, and
reach lengths.

• River station identifier is
stationing along the
channel, in river miles,
feet, or any fictitious
numbering system.

• Highest river station is
the most upstream
section and the lowest is
the most downstream
section.

Layout and Numbering of Cross Sections

Ground Points

Basic Input (rev. 4/04)
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Ground Points
WEST

~,

CONSULTANTl.INC.
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• Data Entry
• A cross section is described by entering station/elevation (X-Y data) from

left to right, with respect to looking downstream.
• Left side of the stream has the lowest station numbers and the right side

has the highest.
• The left and right bank stations must be specified.
• Up to 500 data points may be used to in each cross section.
• Cross section data can have negative stationing values.

12

Data Entry

The cross section is described by entering the station and elevation (X-Y data)
from left to right, with respect to looking in the downstream direction.

The program considers the left side of the stream to have the lowest station
numbers and the right side to have the highest.

The left and right bank stations separating the main channel from the overbank
areas must be specified on the cross section data editor.

Up to 500 data points may be used to describe each cross section and more
than one point can have the same stationing value.

There is a cross section point filter option to reduce the number of points in the
X-V data.

Basic Input (rev. 4/04) 12



Extension of Geometry End Points

The program adds additional wetted perimeter for any water that comes into
contact with the extended walls.

r
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• Extension of End Points

• End points of a
cross section that
are below the
computed WSEL
are automatically
extended vertically.

• The program adds
additional wetted
perimeter for any
water that comes
into contact with
the extended
vertical walls.

Ground Points

End points of a cross section that are too low (below the computed water
surface elevation) will automatically be extended vertically.

A note indicating that the cross section had to be extended will show up in the
output for that section.

Basic Input (rev. 4/04)
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Additional Geometric Data

• Other data that are required for each cross section consist of:

• downstream reach lengths;
• roughness coefficients;
• contraction and expansion coefficients.

WEST
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Other Geometric Data

14

Other data that are required for each cross section consist of: downstream
reach lengths; roughness coefficients; and contraction and expansion
coefficients.

These data will be discussed in detail later.

Basic Input (rev. 4/04) 14
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• Often, these three lengths will be of similar value,

Specify a discharge-weighted reach length based on the discharges in the
main channel and left and right overbank segments of the reach

• There are conditions where they may differ significantly, such as
at river bends, or where the channel meanders and the
overbanks are straight

CO NIULlANTJ" INC.

VNNJ.westconsultant5.com
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Reach Lengths

• The measured distances between cross sections are referred to
as reach lengths

• The reach lengths for the left overbank, right overbank and
channel are specified on the cross section data editor

• Channel reach lengths are typically measured along the thalweg

• Overbank reach lengths should be measured along the
anticipated path of the center of mass of the overbank flow

The measured distances between cross sections are referred to as reach
lengths

The reach lengths for the left overbank, right overbank and channel are
specified on the cross section data editor

Channel reach lengths are typically measured along the thalweg (deepest part
of the channel)

Overbank reach lengths should be measured along the anticipated path of the
center of mass of the overbank flow

Often, these three lengths will be of similar value,

There are conditions where they may differ significantly, such as at river
bends, or where the channel meanders and the overbanks are straight (DRAW
EXAMPLE)

Basic Input (rev. 4/04)
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Energy Loss Coefficients
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Several types of loss coefficients are utilized by the program to
evaluate energy losses:

• Manning's n values for friction loss

• Contraction and expansion coefficients to evaluate
transition (shock) losses

• Bridge and culvert loss coefficients to evaluate losses
related to (covered in later lecture):

~ Weir shape

~ Pier configuration

~ Pressure flow

~ Entrance and exit conditions

16

Several types of loss coefficients are utilized by the program to evaluate
energy losses:

Manning's n values for friction loss

Contraction and expansion coefficients to evaluate transition (shock)
losses

Bridge and culvert loss coefficients to evaluate losses related to:

Weir shape

Pier configuration

Pressure flow

Entrance and exit conditions

Basic Input (rev. 4/04) 16
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In general, these references provide color photos with tables of calibrated n values for a range of flows

• Selection of an appropriate value for Manning's n is very significant to the
accuracy of the computed water surface profiles

Manning's n

Selection of an appropriate value for Manning's n is very significant to the accuracy of the computed
water surface profiles

WEST
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Vegetation

Obstructions

Channel irregularities

Scour and deposition

17

Manning's n

• The value of Manning's n is highly variable and depends on a number of
factors including:

Surface roughness

Channel alignment

Size and shape of the channel Stage and discharge Temperature

Suspended material and bedload Seasonal change

• References for Manning's n values (some with color photos and calibrated n
values for a range of flows)

• Chow's book: "Open-Channel Hydraulics" [Chow, 1959]

• Fasken, 1963

• Barnes, 1987
• Hicks and Mason, 1991

The value of Manning's n is highly variable and depends on a number of factors including:
Surface roughness Channel irregularities Vegetation
Channel alignment Scour and deposition Obstructions
Size and shape of the channel Stage and discharge Temperature
Suspended material and bedload Seasonal change

References that show Manning's n values for typical channels (HANDOUT REFERENCES)
Chow's book: "Open-Channel Hydraulics" [Chow, 1959)
Fasken, 1963
Barnes, 1987
Hicks and Mason, 1991

Basic Input (rev. 4/04)

••.'•••••••••••••••••••••••••••••••••••••••••



Contraction and Expansion
Coefficients
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• Contraction or expansion of flow due to changes between cross sections is a
cause of energy loss

• The loss is computed by applying the C/E coefficients between cross sections.
This is defined on the cross section data editor as part of the upstream cross
section.

• Small change: Contraction and expansion =0.1/0.3, respectively

• Abrupt change: Contraction and expansion = 0.3/0.5, respectively (e.g.,
bridges)

• Very abrupt change: Contraction and expansion =0.6/0.8, respectively
(e.g., culverts)

• These values may be changed at any cross section

• Maximum value is 1.0

18

Contraction and Expansion Coefficients

Contraction or expansion of flow due to changes between two cross-sections is a common
cause of energy losses within a reach

The loss is computed from the contraction and expansion coefficients specified on the cross
section data editor

The coefficients are applied between cross sections and are specified as part of the data for
the upstream cross section

Small change: Contraction and expansion = 0.1/0.3, respectively

Abrupt change: Contraction and expansion =0.3/0.5, respectively

E.g., Bridges

More abrupt change: Contraction and expansion = 0.6/0.8, respectively

E.g., Culverts

Maximum value for the contraction and expansion coefficient =1.0

These values may be changed at any cross section

Basic Input (rev. 4/04) 18



A series of program options are available to restrict flow to the effective flow areas of cross
sections. All of these capabilities are available from the "Qptions" menu of the Cross Section
Data editor.
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• A series of program options are available to restrict flow to the effective
flow areas of cross sections. These capabilities are available from the
"Options" menu of the Cross Section Data editor.

• Ineffective Flow areas

• Levees
• Blocked Obstructions

Optional Cross Section
Properties

Basic Input (rev. 4/04)

••.'•••••••••••••••••••••••••••••••••••••••••



Ineffective Flow Areas
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• Ineffective Flow - Defines areas of the cross section that will
contain water but are not being conveyed.

• Typically represents portions of a cross section where water will
pond, but the velocity in the downstream direction is close to
zero.

• Ineffective flow areas are included in the storage calculations
(unsteady flow), but are not included in the active flow area.

• No additional wetted perimeter is added to the active flow area.

20

Ineffective Flow Areas

This option allows the user to define areas of the cross section that will contain
water that is not actively being conveyed (ineffective flow).

Ineffective flow areas are often used to describe portions of a cross section in
which water will pond, but the velocity of that water in the downstream
direction is close to zero.

This water is included in the storage calculations and other wetted cross
section parameters, but it is not included as part of the active flow area.

When using ineffective flow areas, no additional wetted perimeter is added to
the active flow area.

An example of an ineffective flow area is shown in the next Figure. The cross­
hatched area on the left of the plot represents what is considered to be the
ineffective flow area.

Basic Input (rev. 4/04) 20



Two alternatives are available for setting ineffective flow areas.

Permanent ineffective flow areas can be set to remain ineffective regardless of the WSEL.

Once the water surface goes above the elevation of the blocked ineffective flow area, the
blocked area is no longer considered ineffective.
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Ineffective Flow Areas

• Two types of ineffective ftow areas:

• Normal Ineffective Areas ­
Define a left and/or right
station and elevation.

• Blocked Ineffective Areas ­
Define up to 10 blocked
ineffective areas by entering
an elevation, left station, and
right station for each block.

• If WSEL is below ineffective
elevations, areas outside the
defined stations are ineffective.

• If WSEL exceeds ineffective
elevations, that area is no longer
considered ineffective.

• Permanent ineffective flow areas
can be set that remain ineffective
regardless of WSEL.

The first option allows the user to define a left station and elevation and a right station and
elevation (normal ineffective areas).

When this option is used, and if the water surface is below the ineffective elevations, the areas
to the left of the left station and to the right of the right station are considered ineffective.

Once the water surface goes above either of the established elevations, then that specific area
is no longer considered ineffective.

The second option allows for up to 10 blocked ineffective flow areas. Blocked ineffective flow
areas require the user to enter an elevation, a left station, and a right station for each
ineffective block.

Basic Input (rev, 4/04)
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Ineffective Flow Areas
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Shows blocked ineffective flow areas.
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Additional wetted perimeter is included when water comes into contact with the levee wall.

When levees are established, no water can go to the left of the left levee station or to the right
of the right levee station until either of the levee elevations are exceeded.

Levees

This option allows the user to establish a left and/or right levee station and elevation on any
cross section.
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Levees

• Define a left and/or right
levee station and elevation

• A "vertical wall" is placed at
that station up to the
defined elevation

• Water cannot go outside
the levee station until the
levee elevation is
exceeded.

• Additional wetted
perimeter is included
when water comes into
contact with the levee wall.

Basic Input (rev. 4/04)
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Levees
WEST

CO N 'U II ANtI.,INC.

WNW.Westconsuttants.com

~
i EG 100-;

IV....'S 100 'If

j~

I LE~~ :

[ aanl-.. Sla :--

• When levee elevation is
exceeded, flow can
access the entire cross
section

• Wetted perimeter is still
added for BOTH sides
of the levee wall
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The user may want to add levees into a data set in order to see what effect a levee will have
on the water surface. A simple way to do this is to set a levee station and elevation that is
above the existing ground.

If a levee elevation is placed above the existing geometry of the cross section, then a vertical
wall is placed at that station up to the established levee height.

Additional wetted perimeter is included for BOTH sides of the levee wall when the levee
elevation is exceeded.
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Blocked Obstructions

This option does not prevent water from going outside of the obstruction.

Blocked obstructions decrease flow area and add wetted perimeter when the
water comes in contact with the obstruction,

This option allows the user to define areas of the cross section that will be
permanently blocked out.

CONSU LfA NTS,INC.
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WEST
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Blocked Obstructions

25

• Multiple blocked obstructions

• Can define areas of a cross section to be permanently blocked.

• Blocked obstructions decrease flow area and add wetted
perimeter.

• Does not prevent water from going outside or around the
obstruction.

• Two alternatives are available for entering blocked obstructions.

• Normal blocked obstructions

Two alternatives are available for entering blocked obstructions: normal and
multiple blocks,

Basic Input (rev. 4/04)
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Normal Blocked Obstructions
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The first option allows the user to define a left station and elevation and a right
station and elevation (normal blocked areas).

When this option is used, the area to the left of the left station and to the right
of the right station will be completely blocked out.
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Water can still flow around and between the blocks.

Wetted perimeter is added anywhere the water comes in contact with the
blocks.

With this option, the user enters a left station, a right station, and an elevation
for each of the blocks.
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• Can enter up to 20
individual blocks

• Enter a left station.
right station, and an
elevation for each
block

• Flow is only blocked
between the defined
stations

The second option, for blocked obstructions, allows the user to enter up to 20
individual blocks (Multiple Blocks),
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Stream Junction Data
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• General Definition

• Stream junctions are locations
where two or more streams
come together or split apart.

• Junction data consists of:

~ Reach lengths across the
junction

~ Tributary angles (if the
momentum method is
selected).

• Cross sections that bound a
junction should be placed as
close together as possible

General Definition

JUDction

Reach 2 Reach J

28

Stream junctions are defined as locations where two or more streams come
together or split apart.

Junction data consists of reach lengths across the junction and tributary
angles (only if the momentum equation is selected).

In general, the cross sections that bound a junction should be placed as close
together as possible

An example of this is shown in the figure to the right
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• Reach lengths across a junction are entered in the Junction Data editor,
This allows for a separate length across the junction for each flow split to
be accommodated,

• Two lengths would be entered from the previous figure:

• Length from most dIs cross section in Reach 1 to most u/s cross section in
Reach 2

• Length from most dIs cross section in Reach 1 to most u/s cross section in
Reach 3

In the previous example, two lengths would be entered

These lengths should represent the average distance that the water will
travel from the most downstream cross section in Reach 1 to the most
upstream cross section of Reach 2 and Reach 3

29
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Stream Junction Data

Reach Lengths Across Junctions

Reach lengths across the junction are entered in the Junction Data editor.
This allows for a separate length across the junction for each flow split reach
to be accommodated.

Using downstream reach lengths, for the last cross section in Reach 1 from
the previous Figure, would not adequately describe the lengths across the
junction

It is therefore necessary to describe lengths across junctions in the Junction
Data editor

Basic Input (rev. 4/04)
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Junction Modeling Methods
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• A junction can be modeled by the energy equation or the
momentum equation.

• Energy Method
~ The energy equation does not take into account the angle of

any tributary entering or exiting the main stream.

~ In most cases, the energy loss due to the tributary flow angle
is insignificant, and using the energy method is adequate.

• Momentum Method
~ There are situations where the angle of the tributary can

cause significant energy losses and the momentum method is
a more appropriate selection.

~ When the momentum method is selected, an angle for all
tributaries of the main stem must be entered.

~ A detailed description of junction calculations can be found in
Chapter 4 of the Hydraulic Reference Manual.

30

In HEC-RAS, a junction can be modeled by either the energy equation or the momentum
equation.

Energy Method
The energy equation does not take into account the angle of any tributary
coming in or leaving the main stream, while the momentum equation does.

and
In most cases, the energy loss due to the tributary flow angle is insignificant,
using the energy equation to model the junction is more than adequate.

Momentum Method
There are situations where the angle of the tributary can cause significant
energy losses. In these situations, it would be more appropriate to use
the momentum approach.

When the momentum approach is selected, an angle for all tributaries of the
main stem must be entered.

A detailed description of how junction calculations are made can be found
in Chapter 4 of the Hydraulic Reference Manual.
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Steady flow data are required in order to perform a steady water surface
profile calculation. Steady flow data consist of:

Discharge Information

Flow Regime

31
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Steady Flow Data

• Steady flow data are
required in order to
perform a steady
water surface profile
calculation and
consist of:

• Flow Regime'

• Boundary
Conditions

• Discharge
Information

Boundary Conditions

Basic Input (rev. 4/04)
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• Flow regime (subcritical,
supercritical, or mixed) is specified
on the Steady Flow Analysis
window

• Profile computations begin at the
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• Mixed flow

• WSEL is not constrained

• calculations begin at both dis
and uls ends

32

The flow regime (subcritical, supercritical, or mixed flow regime) is specified on
the Steady Flow Analysis window of the user interface

Profile computations begin at a cross section with known or assumed starting
conditions and proceed upstream for subcritical flow or downstream for
supercritical flow

Subcritical profiles computed by the program are constrained to critical depth
or above, and supercritical profiles are constrained to critical depth or below

In cases where the flow regime will pass from subcritical to supercritical, or
vice versa, the program should be run in a mixed flow regime mode
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General

A starting water surface is necessary in order for the program to begin the calculations

If a mixed flow regime calculation is going to be made, then boundary conditions must be
entered at all ends of the river system

CONSULtANtS,INC.
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• General

Boundary Conditions

• Boundary Condition Requirements by Flow Regime

• Subcritical flow - downstream boundary conditions required

• Supercritical flow - upstream boundary conditions required

• Mixed flow - upstream and downstream boundary conditions
required

• Necessary to establish the starting water surface at the ends of
the river system (upstream and downstream) to begin
calculations

Boundary conditions are necessary to establish the starting water surface at the ends of the
river system (upstream and downstream)

In a subcritical flow regime, boundary conditions are only necessary at the downstream ends
of the river system

If a supercritical flow regime is going to be calculated, boundary conditions are only necessary
at the upstream ends of the river system

Basic Input (rev. 4/04)
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Entering Boundary Condition
Data

WEST

"CONSU L' ANTS, INC.
WWW,westconsultanls,ccm

• The boundary conditions editor lists each reach with an
upstream and a downstream boundary condition.

• Junctions are internal boundary conditions and are automatically
listed in the table.

• The user is required to enter the necessary external boundary
conditions.

34

Entering Boundary Condition Data

The boundary conditions editor contains a table listing every reach.

Each reach has an upstream and a downstream boundary condition.

Connections to junctions are considered internal boundary conditions. Internal boundary
conditions are automatically listed in the table, based on how the river system was defined in
the geometric data editor.

The user is required to enter the necessary external boundary conditions. There are four types
of boundary conditions available to the user:
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For this boundary condition, the user must enter a known water surface
elevation for each of the profiles to be computed.

When this type of boundary condition is selected, the user is not required to
enter any further information

The program will calculate critical depth for each of the profiles and use that as
the boundary condition

WEST
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~ User must enter a known water
surface elevation for each profile

~ User is not required to enter any
further information. The program will
calculate critical depth for each profile
and use that as the boundary condition

• Known Water Surface Elevations

• Critical Depth

Boundary Condition Types

• Four types of boundary conditions are
available:

1. Known Water Surface Elevations

2. Critical Depth

Basic Input (rev. 4/04)
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Boundary Condition Types
(cont'd)
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• Normal Depth

~ User is required to enter an energy
slope to be used to calculate normal
depth for each profile

~ In general, the energy slope can be
approximated by using the average
bed slope or the average water
surface slope near the boundary
condition

• Rating Curve

~ User is required to enter an elevation
versus flow rating curve and the
starting elevation is interpolated from
the rating curve for each profile

3. Normal Depth

36

For this type of boundary condition, the user is required to enter an energy
slope that will be used in calculating normal depth (Manning's equation) at that
location

A normal depth will be calculated for each profile based on the user-entered
slope

In general, the energy slope can be approximated by using the average slope
of the channel or the average slope of the water surface in the vicinity of the
cross section

4. Rating Curve

When this type of boundary condition is selected, a popup window appears
allowing the user to enter an elevation versus flow rating curve

For each profile, the starting elevation is interpolated from the rating curve
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Guidelines for Estimating Starting WSEL

If it is important to have accurate answers at cross sections near the boundary condition,
additional cross sections should be added.

Using an estimated water surface can often incorporate an error in the water surface profile in
the vicinity of the boundary condition.

Locations ofAdditional Cross Sections by Flow Regime
If a subcritical profile is being computed, then additional cross sections need
be added below the downstream boundaries.

WEST
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If a supercritical profile is being computed, then additional cross sections
be added upstream of the relevant upstream boundaries.

If a mixed flow regime profile is being computed, then cross sections should
added upstream and downstream of all the relevant boundaries.

Guidelines for Estimating
Starting WSEL

37

• Using an estimated water surface can incorporate an error in the
water surface profile in the vicinity of the boundary condition.

• If it is important to have accurate answers at cross sections near
the boundary condition, additional cross sections should be
added.

• Locations of Additional Cross Sections by Flow Regime

• Subcritical- add cross sections downstream of the study reach.

• Supercritical- add cross sections upstream of the study reach.

• Mixed flow - add cross sections upstream and downstream of the
study reach.

only

should

be
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Boundary Conditions
WEST
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CONSULTANTS, INC.
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• Check for Sufficiency of Additional Cross Sections

• A sensitivity test should be run to test whether the added
cross sections are sufficient for a particular boundary
condition.

• Try several different boundary conditions for a single profile.

• If the water surface profile converges by the time the
computations reach the study area cross sections, the
boundary condition is not affecting answers in the study
area.

• Initial suggestion: Add four cross sections, each spaced
approximately five active channel widths apart.

38

Check for Sufficiency ofAdditional Cross Sections

In order to test whether the added cross sections are sufficient for a particular
boundary condition, the User should try several different starting elevations at
the boundary condition, for the same discharge.

If the water surface profile converges to the same answer,
by the time the computations get to the cross sections that
are in the study area, then enough sections have been
added, and the boundary condition is not affecting the answers in

the study area.

A suggested initial number of cross sections is four and
spaced approximately 5 active channel widths (distance
between left and right bank stations) apart.
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The changes in water surface and energy can be set for a specific
profile in a multiple profile model

Four options can be selected: Additional EG, Change in EG, Known
WS, and Change in WS

Other Options of the Steady Flow Data Menu

Multiply selected discharge values by a user specified amount to increase or
decrease the values one at a time or globally

Set specific changes in the water surface and energy between any two cross
sections in the model:
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• The changes in water surface and energy can be set for a specific
profile in a multiple profile model

• Four options can be selected:

~ Additional EG

~ Change in EG

~ Known WS

~ Change in WS

Other Options of the Steady
Flow Data Menu
• Multiply selected discharge values by a user specified amount to

increase or decrease the values one at a time or globally

• Set specific changes in the water surface and energy between any two
cross sections in the model:

Basic Input (rev. 4/04)
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Other Options of the Steady
Flow Data Menu (cont'd)

WEST
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• Additional EG option allows the User to add an additional energy loss between
two cross sections

• The program will use the specified energy loss in the energy balance
equation in addition to the normal losses

• Change in EG option allows the User to set a specific amount of energy loss
between two cross sections

• The program adds the specified energy loss to the energy of the
downstream section and computes a corresponding water surface.

• Known WS option allows the User to set a water surface at a specific cross
section for a specific profile

• The program will use the known water surface elevation for any cross
section where a known WSEL has been entered

• Change in WS option allows the User to force a specific change in the water
surface elevation between two cross sections

• The program adds the specified change in water surface to the
downstream cross section and computes a corresponding energy

40

The Additional EG option allows the User to add additional energy loss between two cross
sections

This energy loss will be used in the energy balance equation in addition to the normal
friction and contraction and expansion losses

Change in EG option allows the User to set a specific amount of energy loss between two
cross sections

When this option is used, the program does not perform an energy balance, it adds the
specified energy loss to the energy of the downstream section and computes a
corresponding water surface.

Known WS option allows the User to set a water surface at a specific cross section for a
specific profile

During the computations, the program will not compute a water surface elevation for
any cross section where a known water surface elevation has been entered, but
instead will use the known water surface elevation and then move to the next section

Change in WS option allows the User to force a specific change in the water surface elevation
between two cross sections

When this option is selected, the program adds the user-specified change in water
surface to the downstream cross section, and then calculates a corresponding energy
to match the new water surface
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The flow rate can be changed at any cross section within a reach

Discharge data are entered from upstream to downstream for each reach

CONaUL'AN'&'INC.
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Discharge Information

• Flow remains constant
until another flow value
is entered within the
same reach

• The flow rate can be
changed at any cross
section

• The flow rate cannot be
changed in the middle
of a bridge, culvert, or
stream junction

• Flow data must be
entered for all profiles

Discharge information is required at each cross section in order to compute
the water surface profile

• Flow data are entered
from upstream to
downstream for each tie ~ !Je<>
reach EI1!~IEdi:N~;eldPld~125COOffolllll ~ AeachB~)'Condhons I ~Otlt" I

At least one flow value must be entered for each reach in the river system

Once a flow value is entered at the upstream end of a reach, it is assumed that
the flow remains constant until another flow value is encountered within the
same reach

Flow data must be entered for the total number of profiles that are to be
computed

The flow rate cannot be changed in the middle of a bridge, culvert, or stream
junction

Basic Input (rev. 4/04)
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Question 1>

Question 2>
Question 3>

Question 4>

Questions>

Question 6>

WORKSHOP SOLUTIONS I

HECMRAS WORKSHOP No.1

DEVELOPING A HYDRAULIC MODEL

What is the default method used for calculating Friction Slope?

Average Conveyance [Steady Flow Analysis window: Options menu,
Friction Slope Method]

What is the Energy Slope at R.K. 2.0 for the 5-year profile?

0.000660 m/m [Cross Section or Profile Output Table]

What is the Top Width at R.K. 1.5 for the I-year profile? 25.66 m [Cross
Section or Profile Output Table]

What are the Total, Left OB (Overbank), Channel, and Right OB Average
Velocities (m/s) at R.K. 2.0 for the 5-year profile?

Total: 0.39 m/s Left OB: 0.36 m/s Channel: 0.59 m/s Right OB: 0.21 m/s

[Cross Section Output Table]

What warning is given at R.K. 2.0 for the 5-year profile? Divided flow
[Cross Section Output Table or Summary ofErrors, Warnings, and Notes]

What would you do to correct this, if anything? Divided flow would be
OK if the water is divided by a high ground level, which looks correct
given the geometry. However, a field inspection and engineering
judgment is required to determine whether the water can really flow in the
overbanks under all profiles. Options are available in the Cross Section
Data Editor to control what areas of the cross section are available for
flow.

What is the Flow Area at R.K. 1.0 for the la-year profile? 29.79 m2

[Profile Output Table]



Question 7> What is the Water Surface Elevation (m) at R.K. 2.0 for each profile?

I-year: 3.96 m S-year: 4.84 m IO-year: 5.48 m

Question 8>
[Profile Output Table}

How close do the cross sections need to be to eliminate the warnings for
more cross sections? A cross section every 100 meters eliminates the
warnings for more cross sections.
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Time to Complete: 50 to 60 minutes

Objective: Learn how to create a new project, enter geometric, hydraulic, and flow data,
create a new plan, run a steady flow analysis, and view results.

( Preface) HEC-RAS Workshops

rev. 2/16/051 of 14

HEC..RAS WORKSHOP No.1

DEVELOPING A HYDRAULIC MODEL

The Warning symbol represents important or critical information, such
as avoiding a potential fatal error in HEC-RAS.

The Note symbol represents useful additional information, such as an
alternate way to perform a function in HEC-RAS.

Also, note that at first when the instructions say to click an icon on the toolbar,
this icon is shown graphically in the left margin, like the example shown to the
left.

Finally, you will be able to test your new HEC-RAS skills by answering questions
near the end of the workshop. Questions are designated by the symbol shown
below.

Welcome to the first HEC-RAS workshop! We have tried to make these
workshops as easy-to-follow and informative as possible. Each workshop is
divided into a number of major steps, with detailed instructions provided for each
step. In addition, the instructions are interspersed with Notes and Warnings,
which provide additional guidance on completing the workshop or on using the
HEC-RAS program in general. The symbols designating Notes and Warnings are
shown below.

After each workshop, your instructor will go over the workshop solutions and
answer any additional questions that you might have.

I ) The Question symbol represents an opportunity to test your
Question 1

• r HEC-RAS knowledge.

WEST

CON S U L TAN T 5, INC.

Geometric
Data Editor
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Intro ) Steps for Workshop No.1

The first HEC-RAS workshop - Developing a Hydraulic Model - is divided into
seven steps:

Step 1. Create a project directory and create a new project

Step 2. Create a new river reach

Step 3. Create a new cross section

Step 4. Create additional cross sections

Step 5. Enter flow data and reach boundary conditions

Step 6. Create a plan

Step 7. Run the steady flow analysis and view results

Step 1 ) Create a Project Directory and Create a New Project

If you haven't already done so, install the workshop files from the CD-ROM to
the C:\ drive, and start the HEC-RAS program. Now you're ready to begin
Workshop No.1!

(a) From the File menu, select New Project.

(b) Browse for and then double-click on
C:\Workshops\Basic_RAS_Workshops\ in the directory window.
Click the Create Folder button. Type Workshop_l for the name of
the project directory.

(c) Type Developing a Hydraulic Model as the title.

(d) Enter WKl_Develop.prj as the project file name, and then click
OK.

If you get the message Title and file name must be
specified, you may have an asterisk (*) in the file name.
Delete the asterisk, and then click OK again.

A message window will appear asking for confirmation of the file name, title,
directory, and units system.

(e) Click OK at the confirmation message.

You will be returned to the HEC-RAS main menu screen.

(f) Enter a suitable description (e.g., Workshop No.1 - Developing a
Hydraulic Model) in the Project Description window.
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Save Project

rev. 2/16/053 of 14

When creating a new river reach, each single click of the
mouse creates a new point on the reach. The points are for
the schematic figure only and do not necessarily
correspond to any cross section locations.

Ifyou accidentally clicked the mouse too many times and
created extra points along the reach, you can remove them
by selecting Remove Points in a Reach or SA from the Edit
menu (a minus symbol and circle is added to the mouse
arrow). Just click on the extra point to remove it. When
finished, turn off the point removal option by selecting

You can also access the Geometric Data editor
by clicking the geometric data icon on the toolbar.

(g) From the Options menu, select Unit system (U.S. Customary/SI).

(i) Click the Save Project icon on the toolbar.

(a) From the Edit menu, select Geometric Data.

(h) Select System International (Metric System), select Set as default
for new projects, and then click OK.

A message window will appear asking you to confirm that you want to set
the project units to S1 (metric). Click Yes.

(b) Click the River Reach icon (located on the top of the screen). Move
the cursor - which will now look like a pencil - to the top left comer
of the window.

(c) Click the left mouse button once and move the pencil to the bottom
right comer of the window.

(d) Double click the left mouse button to complete the reach.

(e) Enter the name of the River as Kern R. System and the reach as
Lower Kern River.

This will bring up the Geometric Data window.

This will bring up a window in which to name the river and reach.

Geometric
Data Editor

( Step 2 ) Create a New River Reach

The next step in developing a hydraulic model is to create a geometric data file.

Workshop No.1
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Remove Points in a Reach or SA a second time. SA refers
to Storage Areas, usually used in unsteady flow modeling.

(f) From the File menu on the Geometric Data editor, select Save
Geometry Data.

(g) Enter Existing Conditions for the title and click OK.

The file name for the Geometry Data file is selected
automatically by HEC-RAS based on the project name.

Step 3 ) Create a New Cross Section

Now that the river and reach have been created, we are going to create three cross
sections. The first will be located at River Kilometer (R.K.) 1.0, the next will be
at R.K. 1.5, and the last will be at R.K. 2.0. The cross section at R.K. 2.0 will be
created by copying and modifying the cross section at R.K. 1.5.

Cross '
Section
~

D
View
Description

(a) Click the Cross Section button on the left side of the window, which
opens the Cross Section Data editor.

(b) From the Options menu, select Add a new Cross Section. For the
River Station, enter 1.0 and click OK.

(c) In the Description box, enter Located 1.0 kilometer above the
confluence with the San Joaquin River.

(d) To see the entire description, click the button with the three dots
located just to the right of the description window.

(e) Click on the button again to close the expanded window.

(f) Enter the following Cross-Section X-Y Coordinates (Station­
Elevation data in meters) in the proper fields:

Stations must be entered in an increasing direction (i.e., the
station for point 2 must be greater than - or equal to - the
station at point 1). The convention for cross section
orientation is from left to right, looking downstream.

Use the Return key to enter data in x-y pairs (i.e., station 1,
elevation 1, station 2, elevation 2, etc.). Use the up/down
arrows on your keyboard to enter data in columns (i. e.,
station 1, station 2, etc., then elevation 1, elevation 2, etc.).
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(h) Enter the following Manning's n Values:

(j) Click Apply Data.

rev. 2/16/05

o
ROB

ROB
0.06

Right Bank
47

5 of 14

o
Channel

41

The downstream reach lengths are equal to zero because
this cross section is located at the downstream end of the
reach. There are no cross sections downstream ofthis one.

Clicking Apply Data puts the values in program memory
and updates any graphs or figures. Notice that the text
color changes from red to black when data is applied.

Left Bank

Station Elevation
1 0 5.5
2 15 4.3
3 37 3.7
4 40 4.0
5 41 4.6
6 43 1.8
7 44 1.2
8 46 2.1
9 47 4.6

10 52 6.1

(g) Enter the following Downstream Reach Lengths (m):

(i) Enter the following Main Channel Bank Stations (m):

(k) From the Plot menu, select Plot Cross Section.

From field inspection and other evaluations, we have determined appropriate
Manning's n values, as well as the location of the main channel bank stations.

Leave the default values for the contraction and expansion coefficients.

Once the cross section data has been entered, it is always a good idea to plot the
cross section and verify the data input.

Workshop No.1
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Your cross section plot should look similar to the following:
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Station (m)

(1) Close the cross section plot, and then close the Cross Section Data
editor.

(m) From the File menu on the Geometric Data editor, select Save
Geometry Data. This saves the geometric data to the computer hard
disk.

( Step 4 ) Create Additional Cross Sections

We now want to add a second cross section, this time at R.K. 1.5.

Cross '
Section
~I

(a) Open the Cross Section Data editor by clicking the Cross Section
Data icon on the left side of the screen.

(b) From the Options menu, select Add a New Cross Section.

(c) Enter 1.5 for the new river station, then click OK or hit Enter.

(d) In the Description box, enter River Kilometer 1.5.

(e) Enter the following Cross-Section X-V Coordinates (Station­
Elevation data in meters) in the proper fields:
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(f) Enter the following Downstream Reach Lengths (m):

(h) Enter the following Main Channel Bank Stations (m).

(g) After deleting the default values, enter the following Manning's n
Values:

rev. 2/16/05
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650
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43
Left Bank

Station Elevation
1 1 6.7
2 18 3.4
3 40 3.0
4 43 4.6
5 44 2.1
6 45 1.8
7 46 3.0
8 47 5.5
9 49 3.7

10 54 6.4

LOB Channel ROB
0.085 0.035 0.055

(i) Click Apply Data.

(j) From the Plot menu, select Plot Cross Section, and verify that plot
looks OK. When finished, close the cross section plot and the cross
section data editor.

(k) From the File menu on the Geometric Data editor, select Save
Geometry Data.

From field inspection and other evaluations, we have determined the location of
the channel bank stations.

Workshop No.1
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We will now add a cross section at River Kilometer 2.0, which is a copy of R.K.
1.5, but is raised by 0.5 meters, with a 10% larger area on the left overbank and a
5% smaller area on the right overbank. The channel area will remain unchanged.

Cross (I)
Section
~

(m)

(n)

Open the Cross Section Data Editor and confirm that you are at
River Station 1.5. If not, scroll through the cross sections using the
arrow buttons next to River Sta.

From the Options menu, select Copy Current Cross Section.

Enter 2.0 for the new river station, and then click OK.

(0) Change the description to River Kilometer 2.0.

(p) Enter the following Downstream Reach Lengths (m):

LOB
400

Channel
500

ROB
700

(q) Enter the following Manning's n Values:

LOB
0.07

Channel
0.04

ROB
0.05

(r) From the Options menu, select Adjust Elevations. Enter 0.5, and
then click OK.

Note that all of the elevations in the Cross Section X-Y Coordinates table have
been adjusted to reflect this change.

(s) From the Options menu, select Adjust Stations and Multiply by a
Factor.

(t) Enter 1.1 (10% increase) for the LOB, 1.0 (no increase) for the
Channel, and 0.95 (5% decrease) for ROB. When finished, click
OK or press Enter.

Note that the stations have been changed in the Cross Section X-Y Coordinates
table.

(u) Click Apply Data on the Cross Section Data Editor.

(v) From the Plot menu, select Plot Cross Section.
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Step 5 ) Enter Flow Data and Reach Boundary Conditions

We want to run three subcritical flow profiles (I-year, 5-year, and la-year
discharges). The I-year profile has a known water surface for the downstream
reach boundary condition. For the 5-year and la-year profiles, normal depth is
used as the boundary condition.

(a) From the Edit menu, select Steady Flow Data.

Finally, we want to check the invert of the reach.

rev. 2/16/059 of 14

You can also access the Steady Flow Data editor
by clicking the steady flow data icon on the toolbar.

(aa) Close the Profile Plot, Cross Section Data editor, and Geometric
Data editor, leaving the main HEC-RAS window.

(y) From the File menu on the Geometric Data editor, select Save
Geometry Data.

(x) Close the cross section plot, and then close the Cross Section Data
editor.

(w) Click the up or down arrows to the right of the River Sta. heading in
the plot screen. Check the relative changes in cross section shape
and other features by scrolling through the plots

The scale for the plot axis may change for each cross
section. To use the same scale for all cross sections, select
Set Persistent Scale from the Options menu. You can
accept the scale definition for any particular cross section
by clicking OK, or edit the scale as you wish to capture
more cross section data within the same scale limits (i. e.
change the y axis minimum to zero in this case.)

(z) Click the Cross Section button to open the Cross Section Data editor.
From the Plot menu, select Plot ProfIle.

(b) Enter 3 in the EnterlEdit Number of ProfIles (25,000 max) box
and press Enter.

(c) From the Options menu, select Edit ProfIle Names. Delete the
default profile names and enter the following names for each of the
three profiles. When finished, click OK:

1(:+)
Steady Flow
Data Editor

Workshop No.1
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Profile # Profile Name
I 1 I-year

2 2 5-year
3 3 10-year

(d) Enter the following flow rates (m3/s) for the three profiles at River
Station 2.0 on the Lower Kern River:

I-year
3

5-year
IS

IO-year
30

(e) Click the Reach Boundary Conditions button.

(f) Select Set boundary for one profile at a time at the top of the
window.

This will add rows for all three profiles. Because we are modeling a subcritical
profile, we need to add boundary condition data in the Downstream column only.

(g) Click on the first cell below the Downstream column heading (the
cell should be highlighted in blue).

(h) Click the Known W.S. button, and then enter 2.7 for the
downstream known water surface elevation (profile: I-year). Click
OK.

(i) Click on the second cell below the Downstream column heading
(the boundary condition for the 5-year profile).

U) Click the Normal Depth button, and then enter 0.003 for the
downstream slope for the normal depth computation (profile: 5­
year). Click OK.

(k) Click on the third cell below the Downstream column heading (the
boundary condition for the 10-year profile).

(1) Click the Normal Depth button, and then enter 0.003 for the
downstream slope for the normal depth computation (profile: 10­
year). Click OK. Click OK again to close the Steady Flow
Boundary Conditions window.

(m) Click Apply Data and from the File menu, select Save Flow Data.

(n) Enter 1, 5, 10 year Qs - Existing Conditions for the title, then click
OK.
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Question 1> What is the default method used for calculating Friction Slope?

( Step 6 ) Create a Plan

(a) Click the Steady Flow Analysis icon on the toolbar.

( Step 7 ) Run the Steady Flow Analysis and View Results

(a) Go to the main HEC-RAS File menu, and Save Project.

rev. 2/16/0511 of 14

This icon is also known as the "running stick man n. You
can also access the Steady Flow Analysis editor by
selecting Steady Flow Analysis fi'om the Run menu.

SNET is the steady flow computation engine used by the
HEC-RAS program.

(b) From the File menu, select New Plan.

(c) Enter Existing, 1,5, and 10 year Qs for the title, then click OK.

(d) Enter Existing for the short plan identifier (short ID) and click OK.

(e) For the flow regime, click Subcritical (it may already be selected).

(f) From the Options menu, select Critical Depth Output Option, and
then select Critical Always Calculated. Click OK.

(g) From the File menu, select Save Plan.

(0) Close the Steady Flow Data window and return to the main HEC­
RAS window.

Hint: Look in the Options menu ofthe Steady Flow Analysis window.

(b) Return to the Steady Flow Analysis window, and click the large
Compute button at the bottom.

The last saved geometry and steady flow data files will be listed. In this project,
we have created only one geometry file and one steady flow file.

A window showing the progress of the computations will be displayed.

Steady Flow
Analysis

Workshop No.1
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Cross
Section

W.S.
Profile Plot

(c) When computations are finished, click the Close button on the
progress window.

(d) Close the Steady Flow Analysis window to return to the main HEC­
RAS window.

Now we're ready to look at output from the run. Graphical, tabular, and text
output can be shown by either selecting an option from the View menu, or by
clicking the appropriate icons on the toolbar. We'll start by looking at the cross
section plots.

(e) Click the Cross Sections icon on the toolbar to open the cross
section graphical output window.

(f) From the Options menu, select Profiles. Click the Select All button
to show all profiles in the plot, and then click OK to confirm.

Ifyou want to view particular profiles, click the Clear All
button, and then double-click on the desired profiles in the
Avail Profiles box (on the left). This will enter the profiles
in the Selected box (on the right). Click OK to confirm.

(g) Scroll through the cross sections using the arrow buttons next to the
River Sta. Look at the water surface elevations for each cross
section. Note the distribution of flow in the left overbank, channel,
and right overbank. We have not restricted the flow from using any
portion of each cross section. When you are finished, close the
Cross Section window.

Next, we'll look at the water surface profile plot.

(h) Click the Water Surface Profiles icon on the toolbar to open the
profile plot window.

(i) If not all three profiles are shown in the plot; select Profiles from the
Options menu. Click the Select All button to show all profiles in the
plot, and then click OK to confirm.

(j) If critical depth is not already shown on the plot, select Variables
from the Options menu. Click on Critical Depth Elevation to select
it. Take at look at the other variables available for plotting, and then
click OK. Note that each cross section has a different critical depth
for each profile. The critical depth for cross sections 1.5 and 2.0 are
affected by flow in the overbanks.

(k) From the Options menu, select Landmarks and then River
Stationing.
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Select the appropriate cross sections and profiles to answer Questions 3, 4, and 5.

(1) When you are finished looking at the profile plot, close the plot
window and return to the main HEC-RAS window.

There are two types of tabular output: cross section and profile tables. First,
we'll look at the cross section table.

The bottom portion of the Cross Section Table lists any applicable errors,
warnings, and notes for the cross section.

rev. 2/16/05

RightOB: __Channel: ---Left OB: ---

(m) Click the Cross Section Table icon on the toolbar.

(n) Using the drop-down arrow next to Profile box, select the 5-year
profile.

(0) Using the drop-down arrow (or up/down arrows) next to River Sta
box, select the 2.0 river station, and then answer Question 2 below.

What is the Energy Slope at R.K. 2.0 for the 5-year profile? _

What is the Top Width at R.K. 1.5 for the I-year profile? _

What are the Average Velocities at R.K. 2.0 for the 5-year profile for
Total, Left OB (Overbank), Channel, and Right OB?

Total: ---

What warning is given at R.K. 2.0 for the 5-year profile?

13 of 14

What would you do to correct this, if anything?

In addition to the cross section and profile plots, there are also general profile
plots (velocity, flow area, etc. versus channel distance), rating curves, and XYZ
perspective plots.

Question 3)

Question 4)

Question 5>

Question 2)

Cross Section
Table

Workshop No.1
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Profile Table

The second type of tabular output is the profile table. While most of the
information is also available in the cross sections table, the profile table allows
data from multiple river stations to be viewed at the same time.

(p) Click the Profile Table icon on the toolbar.

(q) From the Options, select Include Profile Name in Table.

(r) To add more profiles to the table select Options, then Profiles, and
choose the desired profiles.

If you have multiple profiles, you should always include the profile name in the
table. If the project has multiple plans or reaches, these can also be selected from
the Options menu of the Profile Table. Now use the profile table to answer
Questions 6 and 7.

Question 6>
I Question 7>

What is the Flow Area at R.K. 1.0 for the IO-year profile?

What is the Water Surface Elevation (m) at R.K. 2.0 for each profile?

I-year: _ 5-year: _ 10-year: ___

Summary of
Errors, Wamings,
and Notes

The third type of output is the Summary of Errors, Warnings, and Notes text
output. Click the icon for this feature and look at the messages for each profile.
Note that there are many suggestions that more cross sections are needed.

Congratulations! You have completed the first HEC-RAS workshop.

Question 8> Optional Task: Close all output windows. From the main HEC-RAS
menu, copy the project by selecting Save Project As. Give the new
project the title: "Test more cross sections" and a new file name
"TESTINT.PRJ." In the Geometric Data Editor, use the XS
Interpolation Tool to see how close cross sections need to be to eliminate
the warnings for more cross sections (Hint: try every 100 meters).
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Objective: Develop a basic unsteady flow model in HEC-RAS.

Time to Complete: 60 minutes

preface) Advanced HEC-RAS Workshops

Welcome to the first HEC-RAS workshop. We have tried to make these
workshops as easy-to-follow and infonnative as possible. Each workshop is
divided into a number of major steps, with detailed instructions provided for each
step. In addition, the instructions are interspersed with Notes and Warnings,
which provide additional guidance on completing the workshop or on using the
HEC-RAS program in general. The symbols designating Notes and Warnings are
shown below.

rev. 12/19/031-8
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INTRO TO UNSTEADY FLOW MODELING

The Note symbol represents useful additional information, such as an
alternate way to perform a function in HEC-RAS.

The Warning symbol represents important or critical information.

Also, note that when new concepts are introduced in the workshop, and the
instructions say to click an icon on the toolbar, this icon is shown graphically in
the left margin, like the example shown to the left.

Finally, questions are included in the workshops to test your understanding of
HEC-RAS concepts. Questions are designated by the symbol shown below.

I Question 1>The Question symbol represents an opportunity to test your
HEC-RAS knowledge.

After each workshop, your instructor will go over the workshop solutions and
answer any additional questions that you might have.

WEST

CONSULTANTS.INC.

I~I
Geometric
Data Editor

Workshop No.1
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This workshop was originally developed through an extensive effort by the staff
and engineers at the US Army Corps ofEngineers Hydrologic Engineering
Center (HEC), Davis, CA.

Intro ) Introduction

In this workshop you will create a basic unsteady flow model in HEC-RAS.

The stream for this example is a section of Beaver Creek located near Kentwood,
Louisiana. The bridge crossing is located along State Highway 1049, near the
middle of the river reach. However, the bridge will not be used for this workshop.
The field data for this example was obtained from the United States Geological
Survey (USGS) Hydrologic Atlas No. HA-601.

While these data are from an actual study, the model and results ofthis workshop
do not represent current or future conditions of the river and may have been
modifiedfor demonstrative purposes.

Step 1 ) Open Existing RAS Project

Open the project "Unsteady_Intro.prj" with the title "Beaver Creek - Workshop
1" from the C:\workshops\Adv_RAS_Workshops\ directory or from the directory
specified by the Instructor. A project with geometry has already been created for
you. You will need to create the Unsteady Flow Data and an Unsteady Flow Plan
in order to run the model.

Step 2 ) Create an Unsteady Flow File

A flow file must first be created for unsteady flow simulations, just like for RAS
steady flow simulations. Open a new Unsteady Flow file by clicking Edit, and
then Unsteady Flow Data. Save the Unsteady Flow file as Unsteady Flow File
for Beaver Creek.

( Step 3 ) Enter the Upstream Boundary Condition

We will specify a hydrograph at our upstream boundary and manually enter (as
opposed to specifying a DSS file) these data.

(a) The upstream boundary is a flow hydrograph. Click in the first cell
underneath the "Boundary Condition Type" column and in line with
the "RS 5.99" row.

(b) Click the "Flow Hydrograph" button to open the Flow Hydrograph
Editor.
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(c) Select "Enter Table" (the circle may already be filled for you) and
then "Fixed Start Time". Enter a date of "21MayI994" and time of
"2400". Set the "Data Time Value" to 1 hour.

(d) Enter the flow data listed in the table below or copy and paste the
same data from the Excel file "Intra Boundary Condition Data.XLS"
(located in the same directory as the RAS project).

Date Simulation Time (hours) Flow (cfs)
21May19942400 00:00 500.00
22May1994 0100 01:00 730.00
22May1994 0200 02:00 1404.33
22May1994 0300 03:00 2477.03
22Mayl994 0400 04:00 3875.00
22May1994 0500 05:00 5502.97
22May1994 0600 06:00 7250.00
22May1994 0700 07:00 8997.03
22May1994 0800 08:00 10625.00
22May1994 0900 09:00 12022.97
22May19941000 10:00 13095.67
22May19941100 11:00 13770.00
22May1994 1200 12:00 14000.00
22May19941300 13:00 13770.00
22May1994 1400 14:00 13095.67
22May19941500 15:00 12022.97
22May1994 1600 16:00 10625.00
22May19941700 17:00 8997.03
22May19941800 18:00 7250.00
22May19941900 19:00 5502.97
22May19942000 20:00 3875.00
22May19942100 21:00 2477.03
22May19942200 22:00 1404.33
22May19942300 23:00 730.00
22May19942400 24:00 500.00

••••••••••••••••••••••••••••••••••••••••••••
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Table 1. Beaver Creek Upstream Hydrograph
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(e) Click the "Plot Data" button at the bottom of the Flow Hydrograph
Editor to verifY that your data look identical to Figure 1.
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Figure 1. Upstream Boundary Condition Flow Hydrograph Plot

(f) Click the "OK" button when finished to close the Flow Hydrograph
Editor. Keep the Unsteady Flow Data Editor open.

( Step 4 ) Enter the Downstream Boundary Condition

Yau will now enter the downstream boundary, a rating curve, for the Beaver
Creek proj ect.

(a) Click in the second cell underneath the "Boundary Condition Type"
column and in line with the "RS 5.00" row.

(b) Click the "Rating Curve" button to open the Rating Curve Editor.
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(c) Enter the rating curve data in shown in the table below or copy and
paste from the Excel file "Intro Boundary Condition Data.XLS"
(located in the same directory as the RAS project).

••••••••••••••••••••••••••••••••••••••••••••
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Table 2. Beaver Creek Downstream Rating Curve.

Stage (ft) Flow (cfs)
204.14 200
206.09 500
207.26 1000
208.47 2000
209.30 3000
209.83 4000
210.25 5000
210.68 6000
210.99 7000
211.27 8000
211.53 9000
211.78 10000
212.02 11000
212.25 12000
212.47 13000
212.68 14000
213.00 16000
214.00 21000
215.00 26000
216.00 30000
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(d) Click the "Plot Data" button at the bottom of the Flow Hydrograph
Editor to verify that your data look identical to Figure 2.
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Figure 2. Downstream Boundary Condition Rating Curve Plot

(e) Click the "OK" button when finished to close the Rating Curve
Editor. Keep the Unsteady Flow Data Editor open.

( Step 5 ) Enter Initial Flow Data

RAS requires an initial flow at the upstream end of Beaver Creek.

(a) Select the "Initial Conditions" tab on the Unsteady Flow Data Editor.

(b) Click in the first cell underneath the "Initial Flow" column which is in
line with the "RS 5.99" row. Enter a value of 500 cfs which is equal
to the first discharge value in the upstream boundary condition flow
hydrograph.

(c) Save the Unsteady Flow Data and close the Unsteady Flow Data
Editor.
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Step 7 ) Evaluate Results

Use the results from your unsteady flow run to answer the following questions:

( Step 6 ) Create an Unsteady Flow Plan

You now need to create an Unsteady Flow Plan in order to run the simulation.

(g) Click the "Compute" button to run your simulation.

(c) Save the Unsteady Flow Data as "Beaver Creek Intro to Unsteady
Flow" with a short plan identifying of "Intro".

rev. 12/19/037-8

(e) Specify a start day of "2IMay1994" a start time of "2400", an end
day of "22May1994", and an end time of "2400"

(f) Specify Computation Settings of 5 minutes for the "Computation
Interval", and 1 hour for both the "Hydrograph Output Interval" the
and "Detailed Output Interval". Save the Plan.

(a) Open a new Unsteady Flow file by clicking Run and then Unsteady
Flow Analysis.

(b) Select "Beaver Cr. Near Kentwood, Louisiana" as the Geometry File,
and "Unsteady Flow File for Beaver Creek" as the Unsteady Flow
File, if they are not already selected.

(d) Select to run all three programs, "Geometry Preprocessor", "Unsteady
Flow Simulation", and "Post Processor" by clicking in the box to the
left of each label.

What is the peak discharge value at RS 5. O? What was the attenuation and
lag in peak discharge between RS 5.99 and RS 5.0?

Change the "Hydrograph Output Interval" to 5 minutes and view the
results. Now change the "Hydrograph Output Interval" to 6 hours. Do
these changes affect your answer to Question I? Use the DSS feature
(View" DSS Data or the "DSS" button) to explain any differences.

Question 1>

Question 2>

Workshop No.1
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Question 3>

Question 4)

Questions>

I Question 6>

Use the various methods for viewing and animating RAS results (you may
want to slow the animation speed down). How many different ways can

you view animated results?

What are the default hydrograph locations for this project? Add a
hydrograph output location at RS 5.13, change the "Hydrograph Output
Interval" back to 1 hour, and re-run your simulation.

Change the "Computation Interval" to 2 hours and run the simulation.
What occurs? Why?

Change the "Computation Interval" to I hour in your new plan and then
run the simulation. Don't be surprised if you get unrealistic results or the
model does not converge on a solution. View the hydrograph at RS 5.13.
Have the results changed? If so, how and why?
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WORKSHOP SOLUTION

What was the peak discharge value at RS 5.0? What was the attenuation
and lag in peak discharge between RS 5.99 and RS 5.0?

rev. 7/15/0910f7
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This can be detennined in numerous ways. The peak flow can be found
by selecting View from the main RAS window, and then Stage and Flow
Hydrographs. RS 5.0 can be selected from the drop down menu and the
"Table" tab clicked to view results in tabular form (Figure 1). In this table
the peak is 13890.59 cfs, shown occuring on the 22nd of May at noon.
Viewing the hydrograph plot also shows the same peak value (Figure 2).
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Another method is to go to the Detailed Output Table for RS 5.0 and
select the "Max WS" profile. The flow associated with the "Max WS" is
13942.26 cfs but it is not given a date or time (note that the maximum
water surface elevaton may not always correspond with the maximum
flow). The Summay Profile Tables show the "Max WS" value but this
value is higher than any value associated with a time step in the table
(Figure 3).
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Figure 4
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Comparing hydrographs at RS 5.99 and RS 5.0 and determining the
attenuation and lag in the peak discharge, can be determined by using the
DSS feature (View then DSS Data or the "DSS" button). The results
indicate that there is an attenuation of approximately 109.4 cfs and no lag
(when the output interval is set to 1 hour), Time series values can be
revealed by clicking on points on the graph or by switching to the "Table"
tab (Figure 4 and Figure 5). Time series values can also seen by selecting
all "profiles" in the Summary Tables.
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Question 2> Change the "Hydrograph Output Interval" to 5 minutes and view the
results. Do these changes affect your answer to Question J? Consider

using the DSSfeature to explain any differences.

By changing the output interval to 5 minutes the hydrograph is defined by
more points. This affects the reported peak values. The attenuation is
approximately 57.74 cfs and lag approximately 20 minutes for results
generated with the Hydrograph Output Interval set to 5 minutes (Results
from DSS shown in Figure 6). Figure 7 shows the difference in DSS
between setting the output interval at 5 minutes and I hour.
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140 22May1994 11 :35 13904.17 13767.19
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Figure 6
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Animation can be viewed on cross section plots, the profile plots, the X-Y­
Z perspective plot, and the general profile plot (e.g., velocity vs. distance).

rev. 7/15/0950f7

Notes on selecting computation and output intervals: When the user
changed the output intervals, only the time step at which results can be
view is affected. Computed results are independent of the output interval
selected by the user.

Increasing the output interval decreases the computation time (and reduces
the size of the DSS output and animation files); however, we've seen that
this reduces the resolution of the results. For this single reach project the
difference in computation time is probably less than one second
(depending on your computer processing speed) when the output interval
varies between 5 minutes and 1 hour, but this can have a larger effect on
complex projects. Decreasing the "Detailed Output Interval" vs. "Detailed
Hydrograph Output" typically has a greater impact on the computation
time. The output intervals can be chosen to minimize computation time
while still maintaining adequate resolution in the generated results.

Get familiar with the various methods for viewing RAS results and
animating results (you may want to slow the animation speed down). How
many different ways can you view animated results?

Question 3>

Workshop No.1 - Solution
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Question 4> What are the default hydrograph locations for this project?

Hydrographs are generated at the upstream and downstream boundaries,
RS 5.99 and 5.0, by default. Additional hydrograph locations can be
specified from Stage and Flow Output Locations under Options on the
Unsteady Flow Analysis Editor.

I >Create a new plan. Change the "Computation Interval" to 2 hours and
Question 5

r run the simulation. What occurs? Why?

Multiple errors occur:

1) the "Hydrograph Output Interval" (= I hr) is less than the
"Computation Interval" (= 2 hrs), and

2) the "Detailed Output Interval" (=1 hr) is less than the "Computation
Interval" (=2 hrs).

This is one example of checks RAS makes of the input data. The reason
these errors occurred are that the output intervals are not allowed to be less
than the computation interval (i.e., results will not be interpolated between
computed points in time).

tRi;;;lEQ:\e.:g;;:i;;;§''Aay.':8i\:~::::::::::':::::::::::=:=:~::'=.=:::::::::~:'~::::::=::=:~~:~:===:=:::::~::.:::~::=::~:':::::::::::::::'~:~::::~:::::::::::::~:=::::::=:::::::::::::::::::::~::::::::i
, old\l\dv_Workshops_RAS_Proiects_Sept2003\1\dv_RAS_Workshops\l\dv_Workshop_Soln\U nsteadyJntro_Soln. p01
.geom file: o:\Courses\l\dv_RAS
, old\l\dv_Workshops_RAS_Projects_Sept2003\1\dv_RAS_Workshops\l\dv_Workshop_Soln\U nsteadyJntro_Soln.g01
.flow file: o:\Courses\l\dv RAS

old\l\dv_Workshops_RAS_Proiects_Sept2003\1\dv_RAS_Workshops\l\dv_Workshop_Soln\U nsteadyJ ntro_Soln. u01

lThe hydrograph output interval is less than the computation interval.
j The interval for detailed output is less than the computation interval.
J
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. 6>Change the "Computation Interval" to 1 hour in your new plan, and run
QuestIOn the simulation. Have the results changed? Ifso, how and why?

rev. 7/15/09

stege

.
Ground

Legend

legend

EO 22MAY1994 0600

WS 22MAY19940800............. __ ._--
Crl 22MAYl99ll 0800

6000

1500 Flow

1000
~

I...

5000.000

. - 500
/,/

\ ./
V

Plan: Plan 2·15 minute interval 7I8l2OO9

/.'\
/

/

70f7

3000

Main Charnel Dist8I"lCe (ft)

2000

,,
\

f 0: .f

1000

Plan: Plan 2 15min River Beaver Creek Reach: Kentwood RS: 5.13
2000

'---;,..----/

!
! "

!

Beaver Creek· Workshop 1 . Solo

!
!

260

;

f
240

220 ;
I

200

F~e OptIons Help

Reaches ,.~i Profiles. I[]I!J

r Time SeriesIM..imum Time al Ma' IV
~ .• t: 11 Siage 209.10 22May1994 0000
--- 2 Flow 1684.11 22May1994 0100

,of Piol Stage :; Plol Flow,'; Dbs Siage ,of Dbs Flow - Use Rei Stage

Stage F~J Table I Ralina Curve I

't:) I.

J.

19B .500
2400 0100 0200 0300 0400 OSOO OSDO 0700 0800

SI22f1994
Time

The model is unstable when set to compute at 1 hour time steps (tips on
creating a stable model and selecting appropriate time steps are discussed
in later lectures). The first indication is the "Maximum iterations"
computation messages in the Hydraulic Computation window. Evidence
of the instability can be seen in the fluctuating stage and flow (Figure 9
and Figure 10).

File Type Options Help

River ;S;vel C';ek----~~~ r"
Reach: f'K;ntwood ..:J River Sla.: ,~

210

208

20S

I~ 204'"..
I Iii

200

Figure 9

Figure 10

Workshop No.1 - Solution

••••••••••••••••••••••••••••••••••••••••••••



This workshop is divided into seven steps:

Time to Complete: 45 minutes

Objective: Learn how to create a river network by adding tributaries and junctions.

( Step 1 ) Copy and Rename a Previous Project into a Different Directory

For this workshop, we will start with the HEC-RAS project developed in
Workshop No. 1. To ensure that everyone is starting with the same project, you
will be starting with a copy of the Workshop No.1 solution file.

rev. 2/16/051 of 11

HEC..RAS WORKSHOP NO.2

ADDING TRIBUTARIES AND JUNCTIONS

(a) From the File menu, select Open Project.

(b) Go to the C:\Workshops\Basic_RAS_Workshops\Basic_Workshop_Soln\
directory by double-clicking on the appropriate folders on the right
side of the window.

(c) Select the project titled Developing a Hydraulic Model (Solution),
with the file name Wkl_Develop_Soln.prj. Click OK.

WEST

CON S U L TAN T S. INC.

Open Project

Step 1. Copy and rename a previous project into a different directory

Step 2. Create a river network

Step 3. Enter junction data

Step 4. Create cross sections on Upper Kern River

Step 5. Create cross sections on Cyrus Wash

Step 6. Enter steady flow data

Step 7. Run steady flow analysis, view results, and answer questions

( Intro 1Steps for Workshop No.2

In the second workshop, we are going to add Cyrus Wash, a Kern River tributary,
expand the Kern River System by adding the Upper Kern River, and add a
junction where Cyrus Wash and the Upper Kern River join the Lower Kern River.

Workshop No.2
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Now, we want to make a copy of this project to start Workshop No.2.

(d) From the File menu, select Save Project As.

(e) Double-click on C:\Workshops\Basic_RAS_Workshops\ in the
directories window. Click the Create Folder button. Type
Workshop_2 for the name of the project directory.

(f) Type Adding Tributaries and Junctions as the title.

(g) Enter Wk2_AddTribs.prj as the project file name, then click OK.

~ T¥hen you tab over to the File Name entry box, the default
l~ file name extension, .prj, is already present. Don't forget
B>- to delete the *after typing the file name.

You will be returned to the HEC-RAS main menu screen.

(h) Update the description in the Project Description window (e.g.,
Workshop No.2 - Adding Tributaries and Junctions).

(i) Click the Save Project icon on the toolbar.

Save Project

Step 2 ) Create a River Dendritic System

We want to add a new reach - the Upper Kern River - on the Kern River system,
and a new river (Cyrus Wash) with one reach (Lower Cyrus) to create the river
network. The network will also included one junction.

(a) Click the Geometric Data editor icon on the toolbar.

Geometric
Data Editor

If the entire reach is not displayed on the schematic, select
Set Schematic Plot Extents from the View menu. Click the
Set to Computed Extents button, and then click OK to
update the schematic.

Before we draw the new reaches, we need to make room for them on the
schematic by moving the Lower Kern River to the lower right section of the
window.

(b) From the Edit menu of the Geometric Data editor, select Move
Object.

This will add crosshairs to your cursor, which allows you to move points on the
reach, as well as the reach names.

Workshop No.2 2 of 11 rev. 2/16/05



(h) Enter Bear Junct. for the junction name.

Now we're ready to add the Upper Kern River.

rev. 2/16/053 of 11

The HEC-RAS program doesn't allow you to select and
move an entire reach at once. You have to move the reach
by moving its points individually.

(f) Click the left mouse button once, move the pencil to cross section
2.0 on the Lower Kern River, and then double-click the left mouse
button.

(d) From the Edit menu, select Move Object a second time, which will
turn off this option.

(e) Click the River Reach icon. Move the cursor - which will now look
like a pencil- to the top left corner of the window.

(g) For the River name, use the default Kern R. System. For the Reach,
enter Upper Kern River. Click OK.

(c) Move the river reach to the lower right section of the window by
clicking and dragging the points next to R.K. 2.0 and R.K. 1.0, if
necessary. Drag and drop the reach label (Lower Kern River) next to
the new reach location.

While the reach label ("Lower Kern River ') can be moved,
the river label ("Kern R. System') and river direction
arrow can't be moved manually; they move automatically
with the river schematic.

(i) Click the River Reach icon, and then move the cursor to the right of
top center on the schematic drawing of the Kern River System.

(j) Click the left mouse button once, move the pencil to cross section
2.0 on the Lower Kern River, and then double-click the left mouse
button.

This will bring up a window asking for the name of the river and reach (with
default names shown).

You will then be prompted to name the junction connecting the Upper Kern River
to the Lower Kern River.

Next, we will add Cyrus Wash, a Kern River tributary that enters at Bear
Junction.

Workshop No.2
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(k) For the river name, enter Cyrus Wash. For the reach, enter Lower
Cyrus. Click OK.

(1) From the File menu, select Save Geometry Data.

Step 3 ] Enter Junction Data

Now we need to enter additional data for the junction.

(a) Click the Junction button on the left side of the window, which
opens the Junction Data editor.

(b) For the description, enter Confluence of Upper Kern River and
Cyrus Wash with the Lower Kern River.

The program allows junction computations to use the energy or momentum
method. Because Cyrus Wash comes into the Kern River system at a significant
angle, we want to use the momentum method.

(c) Select Momentum for the Computation Mode. Leave the default
Add Friction selected.

(d) For Length (m) across the junction, enter 30 from the Lower Kern
River to each reach. For Tributary Angle (Deg), enter 0 for the angle
from Lower Kern River to Upper Kern River. Enter 45 for the
angle from Lower Kern River to Cyrus Wash - Lower Cyrus. The
completed table is shown below.

Length across Junction Tributary

From: Kern R. System - Lower Kern River Length (m) Angle (Deg)

To: Kern R. System - Upper Kern River 30 0

To: Cyrus Wash - Lower Cyrus 30 45

(e) Click Apply Data, and then click OK.

(f) From the File menu, select Save Geometry Data.

Step 4 ) Create Cross Sections on Upper Kern River

We are going to create two cross sections on the Upper Kern River. First, we will
copy R.K. 2.0 on Lower Kern River to create R.K. 2.03 on the Upper Kern River.

Cross .
Section
~!

Workshop No.2

(a) Open the Cross Section Data editor
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(c) From the Options menu, select Copy Current Cross Section.

(k) From the File menu, select Save Geometry Data.

(g) Enter the following Downstream Reach Lengths (m):

rev. 2/16/05

o
ROB
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o
Channel

The downstream reach lengths for the first cross section in
each reach above the junction are set to zero because reach
lengths across the junction are input in the Junction Data
Editor.

(f) Change the description to River Kilometer 2.03 on Upper Kern
River.

(b) Select Kern R. System for the River, Lower Kern River for the
Reach, and 2.0 for the River Station.

(e) Enter 2.03 for the new river station, then click OK.

(d) Leave Kern R. System as the River. Select Upper Kern River for
the Reach.

~ Make sure that you select Upper Kern River for the Reach.ill IfLower Kern River is mistakenly selected, the new cross
section will be added to the wrong reach.

(h) From the Options menu, select Adjust Stations and Multiply by a
Factor.

(i) Enter 0.8 (20% decrease) for the LOB, 0.8 for the Channel, and 0.8
for the ROB. When finished, click OK or press enter.

(j) On the Cross Section Data editor, click Apply Data.

You will prompted for the River and Reach to which the cross section will be
copied.

You will be returned to the Cross Section Data editor with the Upper Kern River
and R.K. 2.03 showing.

Next, we want to add a cross section at River Kilometer 2.5, which will be a
modified copy ofR.K. 2.03.

Workshop No.2
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Cross
Section
~....r

(I) Return to the Cross Section Data editor and confirm that River Sta.
2.03 on the Upper Kern River is shown.

(m) From the Options menu, select Copy Current Cross Section.

(n) Confinn that Kern R. System is selected as the River, and Upper
Kern River as the Reach.

"-- 6J When copying a cross section to the same reach, the
~ correct River and Reach will already be selected.

(0) Enter 2.5 for the new river station, then click OK.

(p) Change the description to River Kilometer 2.5 on Upper Kern
River.

(q) From the Options menu, select Adjust Elevations. Enter 1.5, and
then click OK.

(r) Enter the following Downstream Reach Lengths (m):

LOB
470

Channel
470

ROB
470

(s) Click Apply Data.

(t) From the Plot menu, select Plot Cross Section and check the new
cross sections. Also from the Plot menu, select Plot Profile to check
that the profile looks correct. When finished, close the plots.

(u) From the File menu, select Save Geometry Data.

Step 5 ) Create Cross Sections on Cyrus Wash

We are also going to create two cross sections on Cyrus Wash, a Kern River
tributary. Both of these cross sections will be on the Lower Cyrus reach.

Cross

~
(a) Open the Cross Section Data editor.

(b) Change the River to Cyrus Wash, and the Reach to Lower Cyrus.

(c) From the Options menu, select Add a New Cross Section.

(d) Enter 0.03 for the new river station, then click OK.
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(h) Enter the following Manning's n Values:

(i) Enter the following Main Channel Bank Stations (m).

(k) From the Options menu, select Copy Current Cross Section.

rev. 2/16/05

0.06
ROB

Right Bank
9.8
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5.5
Left Bank

Station Elevation
1 3.0 5.2
2 5.5 4.3
3 7.3 2.3
4 8.5 2.4
5 9.8 4.6
6 15.2 5.8

(f) Enter the following Cross-Section X-Y Coordinates (Station­
Elevation data in meters):

(e) In the Description box, enter River Kilometer 0.03 on Lower
Cyrus.

I L~B I Cha;nel I__R_~_B_

(g) Enter the following Downstream Reach Lengths (m):

(j) Click Apply Data.

(1) Confirm that Cyrus Wash is selected as the River, and Lower
Cyrus as the Reach.

(m) Enter 0.8 for the new river station, then click OK.

From field inspection and other evaluations, we have determined the location of
the channel bank stations.

The cross section at R.K. 0.8 will be based on a copy of the R.K. 0.03 cross
section.

Workshop No.2
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(n) Change the description to River Kilometer 0.8 on Lower Cyrus.

(0) From the Options menu, select Adjust Elevations. Enter 0.5, then
click OK.

(p) Enter the following Downstream Reach Lengths (m):

LOB Channel ROB
770 770 770

(q) Click Apply Data.

(r) From the Plot menu, select Plot Cross Section and then Plot Profile
to check that the cross sections and profile look correct. When
finished, close the plots and Cross Section Data editor.

(s) From the File menu, select Save Geometry Data.

(t) Close the Geometric Data editor, leaving the mam HEC-RAS
window.

(u) Save the project (click the Save Project icon on the toolbar).

Save Project

Step 6 ) Enter Steady Flow Data

As in Workshop No. I, we want to run three subcritical flow profiles (I-year, 5­
year, and 1O-year discharges).

IHI
Steady Flow
Data Editor

(a) Click the Steady Flow Data editor icon on the toolbar.

(b) Confirm that 3 is shown in the Enter/Edit Number of Profiles
(25,000 max) box.

Discharge values for the Lower Kern River were entered during Workshop No.1,
and will be left unchanged. However, discharges are required at the upstream end
of the Upper Kern River and Lower Cyrus for each profile.

(c) Enter the following flow rates (m3/s):

River Reach RS I-year 5-year IO-year

Kern R. System Lower Kern River 2.0 3 15 30

Kern R. System Upper Kern River 2.5 2 11 24

Cyrus Wash Lower Cyrus 0.8 1 4 6
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Run Steady Flow Analysis, View Results, and Answer Questions

Note that internal boundary conditions are automatically created for the junction.
These boundary conditions cannot be edited by the user.

Because we are running subcritical flow, we only need to specify reach boundary
conditions at the most downstream cross section of the river system, namely R.K.
1.0 on the Lower Kern River. Boundary conditions at this cross section were
previously specified for each of the three profiles, and will be left unchanged.

(d) From the File menu, select Save Flow Data.

rev. 2/16/059 of 11

How does HEC-RAS compute the starting water surface elevations at R.K.
0.03 on Lower Cyrus, and R.K. 2.03 on the Upper Kern River?

Reach River Sta Profile W.S. Elev Top Width
(m) (m)

Upper Kern River 2.5 5-year

Lower Kern River 2.0 . I-year

Lower Cyrus 0.8 5-year

(f) Close the Steady Flow Data window and return to the main HEC­
RAS window. Save the project.

(a) Return to the Steady Flow Analysis window, and click the large
Compute button at the bottom.

(b) When computations are finished, click the Close button on the
progress window.

(e) Click the Reach Boundary Conditions button and examine the
boundary conditions table.

(c) Close the Steady Flow Analysis window to return to the main HEC­
RAS window.

Using the profile and/or cross section output tables, fill out the following
table for water surface elevations and top widths (hint: include profile
name in the profile output table):

Question 1>

Question 2>

Steady Flow
Analysis

( Step 7 )

[IJ

Workshop No.2
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Question 3> At what cross sections, reaches, and profiles does the flow go critical?

W.S.
Profile Plot

Next, we want to look at a profile plot showing both the Kern River System and
Cyrus Wash.

(d) Click the Water Surface Profiles icon on the toolbar to open the
profile plot window.

(e) Click the Reaches ... button below the menu bar. Select only the
Lower Kern River and Upper Kern River reaches.

(f) From the Options menu, select Land Marks and then River
Stationing.

(g) Look at invert and slope of each reach.

(h) Repeat tasks (e) through (g) for the Lower Kern River and Lower
Cyrus.

Question 4)

I Question 5>

Question 6>

Based on the profile plots, would critical depth results be reasonable if
found on Cyrus Wash? Why or why not? _

Based on the profile plots, would critical depth results be reasonable if
found on Upper Kern River? Why or why not? _

Examine the cross sections of Cyrus Wash compared to the computed
water surfaces. What could you do to improve the model?------

If the water surface elevations are difficult to see on the
plot, you may have too many variables showing. From the
Options menu, select Variables. As necessary, turn off
Critical Depth, Energy Grade, or other variables.

Congratulations! You have completed the second HEC-RAS
workshop.

Workshop No.2 100f11 rev. 2/16/05



Optional Task: What is the warning for the I-year profile at the first cross
section upstream of the junction for each reach? What could you do to fix
this? ---------------------

••••••••••••••••••••••••••••••••••••••••••••
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WEST

Question 1>

Question 2>

Question 3>

WORKSHOP SOLUTIONS I

HEC-RAS WORKSHOP No.2

ADDING TRIBUTARIES AND JUNCTIONS

How does HEC-RAS compute the starting water surface elevations at R.K.
0.03 on Lower Cyrus, and R.K. 2.03 on the Upper Kern River?

For subcritical flow - flow combining, backwater calculations are
performed separately across the junction for each of the upstream
reaches. The backwater calculations are applied separately from R.K. 2.0
ofthe Lower Kern River to R.K. 0.03 on Lower Cyrus and to R.K. 2.03 on
the Upper Kern River. The water surface elevations in this case are
determined with the momentum equation [Hydraulic Reference Manual,
pages 4-9 and 4-15}.

Using the profile and/or cross section output tables, fill out the following
table for water surface elevations and top widths.

Reach River Sta Profile W.S. Elev Top Width
(m) (m)

Upper Kern River 2.5 5-year 5.52 22.96

Lower Kern River 2.0 I-year 3.96 28.24

Lower Cyrus 0.8 5-year 5.07 5.04

At what cross sections, reaches, and profiles does the flow go critical?

R.K. 2.5 on the Upper Kern River during the 5-year discharge [Cross
Section or Profile Output Table]

~ You can also find where critical depth is the solution by
(~ opening the Summary of Errors, Warnings, and Notes,
~ and selecting All Rivers and All Profiles.

Although critical depth values may be displayed in an output table, critical
depth is not the solution unless it is equal to the computed water surface
elevation. Also note that the program may default to critical depth
because it can't reach a solution due to an insufficient number of cross



Question 4)

Questions>

Question 6>

Question 7>

sections, errors caused by bad input data, wrong flow regime selected,
and inability to balance the water surface elevation near the top of levees
or ineffective flow areas [User's Manual page 11-8, Hydraulic Reference
Manual page 2-13}.

Based on the profile plots, would critical depth results be reasonable if
found on Cyrus Wash? Why or why not?

Since Lower Kern River has subcritical flow and Cyrus Wash has about
the same slope with a lower discharge and corresponding cross section
size, we would be concerned ifCyrus Wash went critical [Profile Plot}.

Based on the profile plots, would critical depth results be reasonable if
found on Upper Kern River? Why or why not?

Since the Upper Kern River has a significantly steeper slope, it could go
critical if it had very coarse bed material or bedrock [Profile Plot}.

Examine the cross sections of Cyrus Wash compared to the computed
water surfaces. What could you do to improve the model?

The water surface elevation for the 1O-year profile was higher than the left
end point of the cross section for R.S. 0.03. This end should be extended
using available topographic information so that the cross section totally
"contains" the water surface of the highest discharge. Note that a
warning stating that the cross section end points were extended is given in
the Cross Section Output table for R.S. 0.8 [Cross Section Plots, Cross
Section Output Table, and Summary ofErrors, Warnings, and Notes}.

Optional Task: What is the warning for the I-year profile at the first cross
section upstream of the junction for each reach? What could you do to fix
this?

The warning states that the momentum calculations at the junction
produced a lower upstream energy than downstream. The upstream
energy was set to the downstream energy.

To fix this, one could create a new geometry file for the 1-year profile and
run the junction calculations with the energy equation in a separate plan.

Workshop No. 2 20f2 rev. 9/11/01
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The required analyses are:

Plan 2 - Levee geometry with existing conditions steady flow data

Plan 4 - Levee geometry with detention basin steady flow data

Time to Complete: 50 to 60 minutes

rev. 2/17/05lof9

HECMRAS WORKSHOP No.3

CREATING PLANS

Step 1. Copy and rename a previous project into a different directory

Step 2. Enter project conditions (levee) geometric data

Step 3. Enter project conditions (detention basin) steady flow data

Step 4. Combine data files into project plans and run steady flow analysis

Step 5. View results and answer questions

WEST
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Plan 3 - Existing conditions geometry with detention basin steady flow
data

preface) General Information

The project conditions include a proposed levee on the left side of the Lower Kern
River from R.K. 1.0 to R.K. 2.0 and a proposed detention basin upstream of the
Upper Kern River. The levees are intended to contain the river flow from the left
overbank for each profile and the detention basin will reduce the peak discharges
in the river. Since either one or both of these projects may be required, we are
asked to determine the hydraulic effects for various cases.

Plan 1 - Existing (base) conditions, comprised of existing geometry and
existing conditions steady flow data

Objective: Learn how to create and compare unique Plans with different geometric and
hydrologic conditions within the same Project.

( Intro ) Steps for Workshop No.3

The third HEC-RAS workshop - Creating Plans - is divided into five steps:

Workshop No.3
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( Step 1 ) Copy and Rename a Previous Project into a Different Directory

(a) From the File menu, select Open Project.

(b) Browse for and then double-click on
C:\Workshops\Basic_RAS_Workshops\ in the directories window.
Double click on the Basic_Workshop_Solo folder.

(c) Double click on Wk2_AddTribs_Soln.prj to open the file.

An alternate way to open a file is to check to see if it is
listed at the bottom of the File menu. The last 8 projects
that have been worked on in HEC-RAS are shown. You can
click on anyone ofthose files to open them.

(d) From the File menu, select Save Project As.

(e) Double-click on C:\ in the directories window. Click on the Create
Folder button. Type Workshop_3 for the name of the new project
directory. Click the OK button.

(f) Delete the current title and type Creating Plans as the title. Tab
over to File Name window and type Wk3_CreatePlans for the
project file name and click OK.

~ When you tab over to the File Name entry box, the default
l~ file name extension, .prj, is already present. Don't forget
s>- to delete the *after typing the file name.

You will be returned to the HEC-RAS main menu screen.

(g) Delete the current project description and enter a suitable description
(e.g., Workshop No.3 - Creating Plans) in the Project Description
window.

(h) Click the Save Project icon on the toolbar.

Save Project

( Step 2 ) Enter Project Conditions (Levee) Geometric Data

Geometric
Data Editor

(a) Open the Geometric Data editor by clicking the Geometric Data
editor icon on the toolbar.

(b) From the File menu, select Save Geometry Data As. Delete the
current title and type Levee on Lower Kern River. Click OK.

Workshop No.3 20f9 rev. 2/17/05



The bottom of the Cross Section Data editor window should now say "Levee on
Left Side".

(i) Check all the input on the cross section plots.

(e) Click the Apply Data button to bring the new information into
program memory.

rev. 2/17/0530f9

Remember that it is only necessary to provide a title; the
file name is created by the HEC-RAS program in sequential
order (i.e. *.g02, etc.)

Alternately, using.the river system schematic, position the
cursor at R.K. J. 0 of the Lower Kern River and click the
left mouse button (you may need to try this several times by
moving the cursor). When you get a window titled "Kern
R. System Lower Kern River J. 0", click on Edit Cross
Section.

(c) Click the Cross Section button on the left side of the window, which
opens the Cross Section Data editor. Toggle, if necessary, to River:
Kern R. System, Reach: Lower Kern River, River Sta.: 1.0.

(d) From the Options menu, select Levees. Enter 30 for the station and
4.6 for the elevation under the Left window (these are understood by
the program to be in meters) and then click OK.

(f) Plot the cross section to check if the levee was placed properly.
When finished, close the plot to return to the Cross Section Data
editor.

(g) Click the up arrow next to the River Station to bring up R.K. 1.5.
Place a left levee at station 30 m with elevation 4.6 m in the same
manner.

(h) Continuing for R.K. 2.0, place a left levee at station 36 m and
elevation 5.6 m. Click Apply Data.

(j) Close the Cross Section Data editor. Save the geometric data by
selecting Save Geometry Data under the File menu on the
Geometric Data editor.

(k) Close the Geometric Data editor.

Cross

~

Workshop No.3
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Step 3 } Enter Project Conditions (Detention Basin) Steady Flow Data

We need to enter project conditions steady flow data for the three subcritical flow
profiles (I-year, 5-year, and IO-year discharges). The I-year profile has a known
water surface elevation for the downstream boundary condition. The 5-year and
IO-year profiles use normal depth for the downstream boundary condition.

(a) Click the Steady Flow Data editor icon on the toolbar.

Steady Flow
Data Editor

(b) From the File menu, select Save Flow Data As. Delete the current
title and type: 1, 5, and IO-year Qs with Detention Basin. Click
OK.

(c) Enter the following flow rates (m3/s) for the three profiles:

River Reach RS I-year 5-year 10-year

Cyrus Wash Lower Cyrus 0.8 I 4 6

Kern R. System Upper Kern River 2.5 0.3 7 14

Kern R. System Lower Kern River 2.0 1.3 11 20

(d) Click the Reach Boundary Conditions button.

(e) Select Set boundary for one profile at a time at the top of the
window.

This will add rows for all three profiles. Because we are modeling a subcritical
profile, we need to add boundary condition data in the Downstream column only,
and only for the Lower Kern River.

(f) Click on the cell for the Lower Kern River, I-year profile, below
the Downstream column heading (the cell should be highlighted in
blue).

(g) Click the Known W.S. button, and then enter 2.4 for the
downstream known water surface elevation. Click OK.

(h) Click on the cell for the Lower Kern River, 5-year profile, below
the Downstream column heading.

(i) Click the Normal Depth button, and then enter .001 for the slope.
Click OK.

(j) Click on the cell for the Lower Kern River, IO-year profile, below
the Downstream column heading.
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Step 4 ) Combine Data Files into Project Plans and Run Steady Flow
Analysis

(b) From the File menu, select New Plan.

(e) Toggle the Geometry Files to select Levee on Lower Kern River

(i) From the File menu, select Save Plan.

rev. 2/17/0550f9

(c) Enter Plan 2, Levee with Existing Qs, for the title, and then click
OK.

~ If you get the message "Do you want to save existing plan
~ data?", click No.

(a) Open the Steady Flow Analysis window by clicking the Steady
Flow Analysis icon on the toolbar.

From the previous workshop, you already have a Plan with the short ID
Existing. We need to create plans for the other conditions that are to be
analyzed by combining the appropriate geometric and flow data files.

(d) Enter Levee_exQ for the short plan identifier (short ID) and click
OK.

(1) From the File menu, select Save Flow Data. Close the Steady Flow
Data window and return to the main HEC-RAS window.

(k) Click the Normal Depth button, and then enter .001 for the slope.
Click OK. Click OK again to close the Steady Flow Boundary
Conditions window.

(f) Toggle the Steady Flow Files to select 1, 5, 10 yr Q's, Existing
Conditions.

(g) For the flow regime, click Subcritical (it may already be selected).

(h) From the Options menu, select Critical Depth Output Option, then
select Critical Always Calculated.

(j) Hit the large Compute button at the bottom of the Steady Flow
Analysis window to run the plan.

The last saved geometry and steady flow data files will be listed.

Steady Flow
Analysis

Workshop No.3
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(k) When computations are finished, click the Close button on the
computation progress window.

(1) In a similar manner, create, save, and run Plan 3, Existing Geom.
with Detention Qs (short ID: ExGeom_dbQ), and then Plan 4,
Levee with Detention Qs (short ID: Levee_dbQ).

(m) Close the Steady Flow Analysis window, return to the main HEC­
RAS window and select Save Project under the File menu.

( Step 5 ] View Results and Answer Questions

Now we're ready to look at output from the runs.

B (a)

Cross
Section

(b)

(c)

~
(d)

Profile
Table

(e)

(f)

Click the Cross Section icon on the toolbar to open the cross section
graphical output window.

From the Options menu, select ProfLIes. Click the Select All button
to show all profiles in the plot, and then click OK to confinn.

Also from the Options menu, select Plans to make your selection of
Plans to look at.

Note that when you plot the cross sections, it will show the
cross section geometry of the last Plan that you opened in
the Steady Flow Analysis window. You can change the
geometry shown by going to the Geometry Data editor
window that shows the dendritic schematic of the system
and opening the geometry file you want to have displayed.

The plots of the water surface elevations are at the correct
elevation for the last Plan opened, but the lateral limits in
the figure may not be accurate, depending on the geometry
file that is shown.

From the HEC-RAS main screen, under View, select ProfLIe
Summary Table (or use the Profile Table icon as shown in the left
margin.)

From the Options menu, select Include ProfLIe Name in Table.

From the Options menu, select Plans, and then select the appropriate
plans you want to compare to answer Question 1 below. In the same
manner, you can select which ProfLIes and Reaches to display.
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From the output, answer the following questions:

Plan 3 (Detention Basin) vs. Plan I (Existing)? _

Plan 2 (Levee) vs. Plan I (Existing)? _

Plan 3 (Detention Basin) vs. Plan 2 (Levee)? _

rev. 2/17/0570f9

Plan W.S. Elev (m)
1 Existing
2 Levee exQ
3 ExGeom dbQ
4 Levee dbQ

~ Use a positive value to show that the w.s. elevation for the
(?::'\ first plan is greater than the second. For example, ifPlan
~ 2 is 0.05 m higher than Plan 1, then enter +0.05 to show

that the addition of the levee caused the water surface
elevation to increase by 0.05 meters.

For the 5-year flood at R.K. 1.5 on the Lower Kern River, what is the
water surface elevation for each plan?

Using the filled-in table above, what is the difference in the water surface
elevations between the following plans?

Plan 4 (Levee + Detention Basin) vs. Plan 1 (Existing)? _

Plan 4 (Levee + Detention Basin) vs. Plan 2 (Levee) _

Plan 4 (Levee + Detention Basin) vs. Plan 3 (Detention Basin)? _

Question 1>

Workshop No.3
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I Question 2>

I Question 3>

Question 4)

Question 5>

For the lO-year flood at R.K. 1.5 on the Lower Kern River, why is the
water surface elevation for Plan 2 (Levee) higher than for Plan 1

(Existing) even though both use the entire cross section for flow and have
the same discharge?

Would you expect what happened for question 2 to happen if we had used
the normal ineffective flow area option and set the station and elevation of
overtopping at the same point as the levee?

Why or why not?

What is the backwater effect (in meters) of the proposed levee only project
at R.K. 0.8 on Cyrus Wash for the 5-year flood, i.e. Plan 2 (Levee)
versus Plan I (Existing)?

From the answer to question 4, what should we have done to the model to
adequately measure the effects of the project?
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Congratulations! You've completed the Creating Plans HEC-RAS
workshop.

Explain.

Should we have used the same reach boundary conditions as under
existing conditions when the levee was in place for Plan 2?

For the 5-year flood (profile 2) on the Lower Kern River for Plan 2
(Levee), is the lateral extent of the water surface at R.K. 1.0 consistent
with R.K. 1.5?

rev. 2/17/0590f9

Question 6>

Question 7>
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Plan 2 (Levee) = 5.26 m Plan 1 (Existing) = 5.24 m

Plan 4 (Levee + Detention Basin) vs. Plan 3 (Detention Basin)? + 0.15 m

Using the filled-in table above, what is the difference in the water surface
elevations between the following plans?

- 0.08 m

- 0.10 m

+ 0.02 m

+ 0.05 m

+ 0.07 m

HEC-RAS WORKSHOP No.3

CREATING PLANS

Plan Short ill W.S. Elev (m)
1 Existing 4.59
2 Levee exQ 4.61
3 ExGeom dbQ 4.51
4 Levee dbQ 4.66

WORKSHOP SOLUTIONS I

~ Use a positive value to show that the w.s. elevation Jor the
('2:\ first plan is greater than the second. For example, ifPlan
~ 2 is 0.05 m higher than Plan 1, then enter +0.05 to show

that the addition oj the levee caused the water surface
elevation to increase by 0.05 meters.

For the 5-year flood at R.K. 1.5 on the Lower Kern River, what is the
water surface elevation for each plan?

Plan 2 (Levee) vs. Plan 1 (Existing)?

Plan 3 (Detention Basin) vs. Plan 1 (Existing)?

Plan 4 (Levee + Detention Basin) vs. Plan 1 (Existing)?

Plan 3 (Detention Basin) vs. Plan 2 (Levee)?

Plan 4 (Levee + Detention Basin) vs. Plan 2 (Levee)?

For the IO-year flood at R.K. 1.5 on the Lower Kern River, why is the
water surface elevation for Plan 2 (Levee) higher than for Plan 1
(Existing) even though both use the entire cross section for flow and have
the same discharge?

WEST

Question 1>

Question 2>
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Question 3>

Question 4)

Question 5>

Question 6>

Question 7>

Plan 2 still has wetted perimeter of the levee even though it is overtopped
[Cross Section Plot and Profile Output Table].

Would you expect what happened for question 2 to happen if we had used
the normal ineffective flow area option and set the station and elevation of
overtopping at the same point as the levee? Why or why not?

No. If we had used the normal ineffective flow area option to represent
the levee and the levee was overtopped, the water surface would have
been the same as if the levee had never existed, which is the case ofPlan 1
(Existing).

What is the backwater effect (in meters) of the proposed levee only project
at R.K. 0.8 on Cyrus Wash for the 5-year flood in Plan 2 (Levee) versus
Plan I (Existing)?

Plan 2 (Levee) = 5.16 m Plan 1 (Existing) = 5.07 m Increase of0.09 m

[Profile Output Table]

From the answer to question 4, what should we have done to the model to
adequately measure the effects of the project?

We should have added more cross sections to extend the model upstream
ofcross section 0.8 on Cyrus Wash [Cross Section Output Table or Profile
Output Table).

For the 5-year flood (profile 2) on the Lower Kern River for Plan 2
(Levee), is the lateral extent of the water surface at R.K. 1.0 consistent
with R.K. 1.5? Explain.

It is not consistent because the levee is overtopped at R.K. 1.5 but at R.K.
1.0, which is downstream of 1.5, all the water is contained within the
levee. This means that somehow, the water went from the left overbank at
R.K. 1.5 over the levee and into the channel, leaving the left overbank of
R.K. 1.0 dlY. These are not physically based results. We need to adjust
the levee elevations to get consistent results even though the selected
elevations may not be at actual levee elevations. The results show that the
top elevation of the levee at R.K. 1.5 would need to be raised, given the
remainder ofthe input data is correct.

Should we have used the same reach boundary conditions as under
existing conditions when the levee was in place for Plan 2?
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If proper techniques were used to set up the model initially, the answer
would be 'yes. /I The model should be started well downstream of the
project area so that any errors or uncertainty in the boundary conditions
will not affect the evaluation of results at the location of the project. If
proper modeling techniques are followed, the same boundary conditions
should apply for existing and project conditions. Ifthe levees are reducing
the area offlow at the downstream boundary, we would expect to have a
different starting water surface elevation or a different estimate of the
energy slope for the same discharge.
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Time to Complete: 60 minutes

Step 1 ) Stability Problem Number 1

Objective: The goal of this workshop is to give you experience identifying and correcting
stability issues in RAS unsteady flow models.

rev. 07/15/091-7

HEC·RAS WORKSHOP NO.7

TROUBLE SHOOTING

This workshop was originally developed through an extensive effort by the staff
and engineers at the US Army Corps ofEngineers Hydrologic Engineering
Center (HEC), Davis, CA.

When the Profile Plot is first opened the program will default to the maximum
water surface. Unfortunately, when the program goes unstable the maximum

WEST

Load the project file and run the model. Examine the output for instabilities.
Based on the output, geometry, boundary conditions, and initial conditions form a
hypothesis on what is causing the instability. If time permits, revise the model
based on your hypothesis until a stable computation is achieved.

(~ Stepping through a time series animation with the Profile Plot is a good
s>- starting point to view where and when instabilities occurred.

The stream for this example is a section of Beaver Creek located near Kentwood,
Louisiana. A project file (Unsteady_Stabilityl) with the title "Stability Problem
Number I" has been loaded on your workshop computers. The file contains all
the data for this workshop. The geometry for this example includes the bridge
crossing and interpolated cross sections.

Intro ) Introduction

This workshop will help students learn how to trouble shoot stability problems
associated with developing unsteady flow models with HEC-RAS. This
workshop contains four separate stability problems, which are to be solved by the
student. While the data are from actual studies, the models and results of this
workshop do not represent current orfuture conditions of the rivers

CONSULTANTS,INC.
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water surface will usually have erroneous data, skewing the dimensions of the
plot, as seen in Figure 1.

The view needs to be corrected to analyze the instability. Under the Options
menu of the Profile Plot, select Profiles. Next, clear the maximum water surface
profile from the selection window and select the first profile. An example is
shown in Figure 2. Then select Options and Full Plot and this should restore the
view. You can then proceed animating through the time steps for analysis.

File OptiOns l-+elp

Reaches . I~; t Profiles I• .I!J
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Figure 1. Maximum Water Surface Plot for a Simulation with Instabilities
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At what time step and at what location did the program begin to go
unstable?

••••••••••••••••••••••••••••••••••••••••••••

Question 1>

Question 2>

Question 3>

Workshop No.7

What caused the instability?

If you were able to fix the instability, how was this achieved?
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Step 2 ) Stability Problem Number 2

The stream for this example is a section of Beaver Creek located near Kentwood,
Louisiana. A project file (Unsteady_Stability2) with the title "Stability Problem
Number 2" has been loaded on your workshop computers. The file contains all
the data for this workshop. The geometry for this example includes a bridge,
interpolated cross sections, a lateral weir with gates, and a storage area.

Note: The computation interval for this simulation is set to 1 minute.
Determine what is causing the instability without adjusting this
interval.

Load the project file and run the model. Examine the output for instabilities.
Based on the output, geometry, boundary conditions, and initial conditions form a
hypothesis on what is causing the instability. If time permits, revise the model
based on your hypothesis until a stable computation is achieved.

Question 1>

Question 2>

Question 3>

At what time step and at what location did the program begin to go
unstable?

What caused the instability?

If you were able to fix the instability, how was this achieved?
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( Step 3 ) Stability Problem Number 3

Load the project file and run the model. Examine the output for instabilities.
Based on the output, geometry, boundary conditions, and initial conditions form a
hypothesis on what is causing the instability. If time pennits, revise the model
based on your hypothesis until a stable computation is achieved.

The stream for this example is a section of Beaver Creek located near Kentwood,
Louisiana. A project file (Unsteady_Stability3) with the title "Stability Problem
Number 3" has been loaded on your workshop computers. The file contains all
the data for this workshop. The geometry for this example includes the bridge
crossing and interpolated cross sections.

rev. 07/15/095-7

Note: The computation interval for this simulation is set to 1 minute.
Determine what is causing the instability without adjusting this
interval.

At what time step and at what location did the program begin to go
unstable?

What caused the instability?

If you were able to fix the instability, how was this achieved?

Question 1>

Question 2>

Question 3>

Workshop No.7
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( Step 4 ) Stability Problem Number 4

The stream for this example is a section of Brunner River located near Jensen
Town. The reach is a trapezoidal, concrete lined channel. A project file
(Unsteady_Stability4) with the title "Stability Problem Number 4" has been
loaded on your workshop computers. The file contains all the data for this
workshop

Note: The computation interval for this simulation is set to J minute.
.Determine what is causing the instability without adjusting this
interval.

Load the project file and run the model. Examine the output for instabilities.
Based on the output, geometry, boundary conditions, and initial conditions form a
hypothesis on what is causing the instability. If time permits, revise the model
based on your hypothesis until a stable computation is achieved.

Question 1>

Question 2>

Question 3>

At what time step and at what location did the program begin to go
unstable?

What caused the instability?

If you were able to fix the instability, how was this achieved?
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Stability Problem Number 1

rev. 7/15/09

WSEL ERROR
205.10 0.55B
206.25 0.7B8
20B.49 0.914
210.80 1.385
208.86 0.113
20952 3.997
213.26 3.B32
211.02 0.966
219.17 002B

211.74 4.486
219.65 0.036

~i

1of 16

RS: 5.0
Node Type: Cross Section

RS: 5.99
Node Type: C,oss Section

00:00:00 Iteralion: 0

HEC-RAS WORKSHOP No.7

TROUBLE SHOOTING

WORKSHOP SOLUTION

Geomeby Processor'
River: Beave, Cleek
Reach: Kentwood
IB Curve:

Unsteady Flow Simulation
Simulation:

Time: 72.0000 13FEB1999
Writing Hydrograph 57 01 57

Post Pro~ess
River: Beaver Creek
Reach: Kentwood

P,olile: 11FEB19991400

Simulalion: 21/21

C~rTllu't~tj~n Mess~ges

, Finished Processing Geometry

: Maximum itelations of 20 at: RS
: 09FEB1999 01 :00:00 Beaver Creek Kenlwood 5.0
11 OFEB1999 03:00:00 Beave, Creek Kentwood 5.0
! 1OFEB1999 05:00:00 Beaver Creek Kentwood 5.0
i 10FEB1999 07:00:00 8eaver C,eek Kentwood 5.0

! ~ ~:~:~~~~ ~~~~~~ :::~: ~:::~ ~:~::::~ ;~
!10FEB1999120000 BeaverCreek Kentwood 5.0
; 1OFEB199913 00 00 Beaver Creek Kenlwood 5.0
1OFEB199914 00 00 Beaver Creek Kentwood 5.0
iSolulion solver wenl unstable, iteration 19 at10FEB199915:00:00
~ Beaver Creek Kentwood 5.0
!1OFEB1999 16:00:00 Beaver Creek Kentwood 5.0
!Solution solver went unstable, iteration 1B at10FEB1999 17:00:00

At what time step and at what location did the program begin to go
unstable?

The HEC-RAS Hydraulic Computations window indicates that the first
error occurred at RS 5.0 (Figure 1). Since this is near the downstream end
of the reach the instability might be due to the boundary condition. This
particular data set has a rating curve at the downstream boundary. Figure
2 displays a plot of the rating curve. The plot shows a smooth
continuously increasing rating curve. Most likely, the rating curve is not
creating the instability.

i 'Perlorming Unsteady Flow Simulation Version 4.0.0 March 2008

Figure 1

WEST

Question 1>
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Figure 2. Downstream Boundary

Question 2> What caused the instability?

Question 3>

Upon further review of the data, no problems were found with the
geometry or boundary conditions. In the Unsteady Flow Analysis Editor,
the computation interval is set at one hour. This is an extremely large time
interval for the computations. The upstream boundary condition for this
simulation is a rapidly rising flow hydrograph. The one hour interval
cannot capture the rapid change in flow with time and causes the
instability.

Ifyou were able to fix the instability, how was this achieved?

The computation interval was lowered to five minutes and the simulation
was run. As seen in Figure 3, the change produced a stable simulation.
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Figure 3. Maximum Water Surface ProfIle with a Computation
Interval of 5 Minutes.
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Stability Problem Number 2

The simulation was run and a number of errors are listed In the HEC-RAS
Hydraulic Computations window (Figure 4).

~~- _,,!: ,
r.:'?';J'J::: ". );i!J :,w:;ylJ!lllliJJ.:::T l'1?iL~._ .. :'"''':.''t-_ ..•.> 'L jltiJL~1

Geometry Processor
River: Beaver Creek RS: 5.0
Reach: Kentwood Node Type: Cross Section
IB Curve:

Unsteady Flow Simulation
Simulation:

I
Time: 680000 12FEB1999 20:00:00 Iteration: 0
Writing Profiles 100

Post Process ...

I River: Beaver Creek RS: 50
Reach: Kentwood I~ode Type: Cross Section

Profile: 11 FEB1999 0300

Simulation: 29/29

Computation Messages
I ,

Ma,imum iteratiens of 20 at: RS WSEL ERROR .
11FEB1999 01:37:30 Beaver Creek Kentwood 5.37 205.89 0.047 -
11FEB1999 01:38:30 Beaver Creek Kentwood 5.37 205.64 0191
11FEB1999 01:39:00 Beaver Creek Kentwood 5.35 21018 0.311
11FEB1999 01:39:30 Beaver Creek Kentwood 5.37 205.90 0.239
11FEB1999 01:53:00 Beaver Creek Kentwood 5.35 208.22 0.013
11FEB1999 01:53:30 Beaver Creek Kentwood 5.35 208.16 0.010
11FEB1999 01:54:00 Beaver Creek I:entwood 5.35 208.09 0.026
11 FEB1999 01 :54:30 Beaver Creek Kentwood 535 20799 0.037
11FEB1999 01:55:00 Beaver Creek Kentwood 5.35 207.88 0.03B

, 11 FEB1999 01 :55:30 Beaver Creek Kentwood 5.31 208.63 0.042
11FEB1999 01:56:00 Beaver Creek Kentwood 5.31 205.62 0.141
11FEB1999 01:56:30 Beaver Creek Kentwood 5.258 209.58 0.175
11 FEB1999 01 :57:00 Beaver Creek Kentwood 5.35 205.34 0.255
Solution solver went unstable. iteration 17 at11 FEB1999 01 :57:30
Beaver Creek Kentwood 5.242 210.15 0.049
Solution solver went unstable. iteration 4 at llFEB1999 01:5B:00

I Beaver Creek Kentwood 5194 20240 0.675
i 11FEB1999 01:58:30 Beaver Creek Kentwood 5.31 203:42 0.048 yl

If qi:i~~ :]1

Figure 4

Question 1> At what time step and at what location did the program begin to go
unstable?

The Profile Plot was examined and the animation tool was used to
progress through the time steps. By stepping through the simulation, the
animation shows that the program begins to go unstable between
llFEB1999 0100 and llFEB1999 0200 (Figure 5). This corresponds
with the first maximum iteration warning.
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What caused the instability?

The profile plot indicates the problem might be due to the downstream
boundary condition as the instability first appears at the downstream end
when stepping through the profile plot. However, a check of the
downstream rating curve does not reveal any apparent problems. The
abrupt fluctuation in stage at the downstream boundary might also indicate
the problem is due to sudden changes in model. The Time Series of Gate
Openings under the Unsteady Flow Data Editor was then examined. As
can be seen on Figure 6, the gates are rapidly opened (1 minute interval).

Stability Problem Number 2

1'------- Beaver Creek Kentwood --------->1
225 r--'L"".g""ell,"1-----,

195+----~--~---~--~--~
o

220

Main Channel Distance (ft)

215

is
S! 210
~ 1---------1.
ijj

File Cllt<JnS He\:>

_ReaChes LI tI~" ·H:!:]

Question 2>
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Gate Opening Height. Gate #1

Simulation Time (days)

Figure 6. Plot of Gate Opening Time Series

Question 3> Ifyou were able to fix the instability, how was this achieved?

The time series of gate openings was adjusted in the Unsteady Flow Data
Editor. Values between the simulation time of 2300 and 2400 hours were
deleted, and the values entered to have the gate open to 8 feet over I hour
instead of 1 minute (Figure 7). The profile plot now displays realistic
answers and the simulation runs to completion.

River·: Beaver Creek Reach: Kentwood RS: 5.4 Gate #1

<=

:;;;

'"a;

c:
10
OJ·w

I
OJ
c:

~ ·c
11J.

1*
1° 0

I
0.0

Figure 7
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Using the slower gate opening hydrograph, the simulation still has a
number of maximum iteration warnings, but the overall solution is stable
and the results look reasonable. By opening the gates at a slower rate the
rapid change in flow leaving the reach was decreased. This prevented
instabilities in the simulation. The time step could also have been
reduced, but you were asked not to do that for this problem.

••••••••••••••••••••••••••••••••••••••••••••
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Stability Problem Number 3

Examining the animation of the Profile Plot showed that the program crashed at
the beginning of the simulation. The detailed output was examined to detennine
exactly when the instability occurred.

Question I) At what time step and at what location did the program begin to go
unstable?

The HEC-RAS Hydraulic Computations window shows the maximum
iterations warning starting on 1OFEB 1999 at 0116 (Figure 8). These occur
at the beginning of the simulation period and near the downstream end of
the model. The model crashes on 1OFEB 1999 at 0249.

Geometry Processor

River: Beaver Creek

Reach: Kentwood

IB Curve:

Unsteady Flow Simulation

Simulation:

Time: 72.0000 13FEB1999

Writing Hydrograph 57 of 57

Post Process

River: Beaver Creek

Reach: Kentwood

Profile: 12FEB1999 2400

RS: 5.0

Node Type: Cross Sedon

00:00:00 Iteration: 0

RS: 5.99

Node Type: Cross Sedon

Simulation: 38/38

Computation Messages------._._----_..._---_._,,-- --_....- -""_.__._-----_.._-_._----_._._._-,,._.__..... -_.__._---------,

Geometric Preprocessor Version 4.1.0 Jan 201 0

1 Internal Boundary curvets) have been read in and will not be recalculated

Finished Processing Geometry

Perlorming Unsteady Flow Simulation Version 4.1.0 Jan 2010

Meximum iterations of 20 at:

1OFEB1999 01 :16:00 Beaver Cree Kentwood

1OFEB1999 0118:00 Beaver Cree Kentwood

1OFEB1 999 01 :19:00 Beaver Cree Kentwood

1OFEB1999 01 :20:00 Beaver Cree Kentwood

1OFEB1999 01 :21 :00 Beaver Cree Kentwood

1OFEB1999 0122:00 Beaver Cree Kentwood

1OFEB1999 01 :2300 Beaver Cree Kentwood

1OFEB1999 01 :24:00 Beaver Cree Kentwood

1OFEB1999 01 :26:00 Beaver Cree Kentwood

.1 OFEB1999 01 :29:00 BeElver Cree Kentwood

RS

50

50

5.065

5.065

5.016

5.065

5.0

5.016

5.016

5.065

WSEL ERROR

207.06 0010

200.46 0.783

200.01 0039

200.25 0.134

201.92 0.158

205.52 0.096

203.00 0.014

199.93 0.016

199.94 0.013

209.13 0.015

Workshop No.7 - Solution

Figure 8. HEC-RAS Hydraulic Computations 'Vindow
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The profile plot was animated but having detailed output at 2 hour
increments does not reveal the source of the error. The Hydrograph output
Interval and Detailed Output Interval was changed to 5 minutes (and the
simulation duration temporarily shorted to end at 2400 on 1OFEB 1999)
and the profile plots reviewed. As shown in the progression of Figure 9,
Figure 10, and Figure 11, this error begins at the downstream end of the
reach.

Sl.tll_,PretltmUul'IIMf3 P1~11 Unrtu1: .._hsmalhl, ..ltnl 7121·:200!lr-------- at... C'H'tO;f.r"<K:

.......

What caused the instability?

~ j}>...,..~

RuchtI I' t ~!JI!J

Figure 9

Figure 10

Question 2>

Workshop No.7 - Solution

••••••••••••••••••••••••••••••••••••••••••••



~ I .i .

~ ~""" ..-"='

Ru:tws l.t~"'J!]

~IPt.-o:.:, Flt~llu~:O p·Ml l!nl!lI.:l) ~h S'T~:le1 e"el'l ~ F·:(>~-

~------- ...,....,~...'" -----------1

~
.,.~

I
···· .
~" ·~t~l; •• ~1.·:

.:·""t;l.:;;;l:;
<c....-:

I
'j
j

. I //.J" /".-I" /
"". ~

j Af\J / I

.1 V\ (;/

Figure 11

Since the instability is occurring at the cross sections near the downstream
end of the model, the user should examine the downstream boundary
condition. This particular data set has a rating curve at the downstream
boundary. Figure 12 displays a plot of the rating curve.

~.- J:

.[Plot;1 Teble I
River' Beaver Creek Reach: Kentwood RS: 5 0

216

214

l~ 212
.8-

So 210
'"g'

208iii

206

5000 10000 15000

Flow (cfs)

20000 25000 30000

Figure 12. Downstream Boundary Condition

As seen in the plot, there is an area of discontinuity in the rating curve.
This discontinuity causes a large difference in the water surface slopes at
lower flows. The program goes unstable because of large differences in
the derivatives caused by the large differences in the water surface slopes.
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To correct the problem the rating curve was adjusted to produce a smooth,
continuous increase in flow versus stage. Figure 13 displays the adjusted
rating curve that produced a stable simulation.

rev. 7/15/09
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Ifyou were able to fix the instability, how was this achieved?

Figure 13. Adjusted Rating Curve for Stable Simulation

Question 3>
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Stability Problem Number 4

The Profile Plot for this example shows a dramatic change in slope occurring near
River Station 6.99.

Question 1> At what time step and at what location did the program begin to go
unstable?

The HEC-RAS Hydraulic Computations window indicates there are a
number of errors, the first of which start at RS 7.0 (Figure 14) near the
beginning of the simulation time. Examining the animation of the Profile
Plot shows that the water surface elevation and slope change dramatically
over time near this location (Figure 15 ).

12FEB1999 00:00:00

~:' ; .
Geometry Processor

River: Brunner River

Reach: Wolfe Reach

IB Curve:

Unsteady Flow Simulation

Simulation:

Time: 48.0000

Wrrting Profiles 100

Post Process

River: Brunner River

Reach' Wolfe Reach

RS:

Node Type. Cross Section

Iteration 0

RS: 10.0

Node Type. Cross Section

Profile: 11 FEB1999 2400

Simulatron: 50/50

Computation Messages
_.•.... _ _.".

}User has seleded to recompute oil internal bounderies.

IGeometric Preprocessor Version 4.1.0 Jan 2010

IIFinished Processing Geometry

iPerlorming Unsteady Flow Simulation Version 4.1.0 Jan 2010

IMaximum Iterations of 20 at: RS
11 OFEB1999 0l:1 0:00 Brunner Rive Wolfe Reach 70

i1OFEB1999 01 :12:00 Brunner Rive Wolfe Reach 7.0

11 OFEB1999 01 :13:00 Brunner Rive Wolfe Reach 7.0

i1OFEB1999 01 :14:00 Brunner Rive Woile Reach 7.0

11 OFEB1999 01 :15:00 Brunner Rive Wolfe Reach 7.0

i 1OFEB1999 01 :16:00 Brunner Rive Wolfe Reach 6.99

11 OFEB1999 01 :17:00 Brunner Rive Wolfe Reach 699

11 OFEB1999 01 :1800 Brunner Rive Wolfe Reach 7.0

: 1OFEB1999 01 :20:00 Brunner Rive Wolfe Reach 6.99,

Oose

Figure 14

WSEL ERROR

48401 0025

484.01 0.018

48401 0.018

484.01 0.010

484.01 0.010

483.88 0013

48387 0015

484.01 0.010

483.86 0025
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What caused the instability?

Figure 15. Profile Plot

As seen on Figure 15, the water surface profile goes to critical depth
where the slope of the reach changes. The current plan is not set to
account for "mixed mode" (i.e., a combination of sub and super-critical
flows).

Ifyou were able to fix the instability, how was this achieved?

Provided here are three possible solutions for this problem. The first
involves examining the base flow from the input hydrograph. The
simulation with the instability has a base flow and initial condition of 700
cfs (Figure 16). This low flow allows the water surface to pass through
critical depth. One solution is to increase the base flow of 1000 cfs
(Figure 17). The initial condition was also changed to 1000 cfs and the
simulation re-run. This adjustment to the hydrograph and initial
conditions proved a stable simulation.

Question 2>

Question 3>
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File' i
Pa'h ~I----------------

,.- Enter Table Delte lime Interval. 11 Hour o::J
Select/Enler the Data's Starllnc Ttme Refelence

(0' Use Simula',on T,me: Dale. 12110/1999 Time 10000

(" FrxedSlanTime: Date. r- TIme r-
.." .. .... '~" __M"_""

. ~, .. ,
Dale Simulation Time Flow ~

(hours) (cis) .-J
1 09Feb19992400 00:00 1000
2 10Feb1999 0100 01:00 1000.00
3 lOFeb1999 0200 02:00 100000
4 10Feb1999 0300 03.00 1000.00
5 10Feb1999 0400 04:00 1000
6 10Feb1999 0500 05:00 1081.25
7 10Feb1999 0600 06:00 1287.5
8 1OFeb1999 0700 07'00 149375 -=J- ~-- ,~--- --_... -- -- ~---

Tme SteD AdJUstment Ootions r"Cr~jcal" boundalY condltionsl
r Manitol this hydrograph fOl adjustments to computational time step,--

Pial Dala OK Cancel

Figure 17

Additionally, the change in slope could be modeled as an inline structure.
An inline structure was added just downstream of the change in slope at
River Station 6.995. Figure 18 displays the cross section view of the
inline structure. Figure 19 displays the dimensions of the inline structure.
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Figure 18. Plot of Inline Structure

Figure 19. Dimensions of Inline Structure
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A third option would be to use the Mixed Flow Regime feature in the
Unsteady Flow Analysis Editor. A comparison of the three solutions at
1100 hours is shown in Figure 20.

Legend
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